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Speedgoat FPGA Support

1-2

Simulink Real-Time and HDL Coder™ enable you to implement Simulink algorithms
and configure I/0 functionality on Speedgoat field programmable gate array (FPGA)
boards.

For an example that shows the development workflow for FPGA 1/0 boards, see “FPGA
Programming and Configuration” on page 1-5. You do not use these blocks outside of
HDL Coder HDL Workflow Advisor.

To use these blocks, open HDL Coder HDL Workflow Advisor and use it to generate a
Simulink Real-Time interface subsystem. See “FPGA Programming and Configuration”
on page 1-5.

The subsystem mask controls the block parameters. Do not edit the parameters directly.
The FPGA I/0 board block descriptions are for informational purposes only.

Speedgoat I/O FPGA boards are sold as part of Speedgoat target computer systems. See:

www .mathworks.com/products/simul ink-real-time/supported/hardware-
drivers._html.

Simulink Real-Time supports the following Speedgoat (www . speedgoat.com) FPGA I/O
boards.

Speedgoat 10321 The Speedgoat 10321 is a field-
programmable gate array (FPGA) board
that provides 64 bidirectional LVCMOS or
32 bidirectional LVDS (four are input only)
I/0 lines. It also provides two 16-bit 105-
MHz analog input channels. This board
is based on a Xilinx® Virtex-4 chip with
41,472 logic cells.

The Speedgoat 10321 is the base board.
The Speedgoat 10321-5 is the Speedgoat
10321 plus the AXM-A30 high-speed A/D
port subassembly.

Speedgoat 10331 The Speedgoat 10331 is a field-
programmable gate array (FPGA) board


https://www.mathworks.com/products/simulink-real-time/supported/hardware-drivers.html
https://www.mathworks.com/products/simulink-real-time/supported/hardware-drivers.html
http://www.speedgoat.com

Speedgoat FPGA Support

that provides 64 bidirectional LVCMOS or
32 bidirectional LVDS I/O lines. This board

is based on a Xilinx Spartan® 6 chip with
147,333 logic cells.

The Speedgoat 10331 is the base board.
The Speedgoat 10331-6 is the AXM-A75 A/
D converter, an add-on to the Speedgoat
10331.

Speedgoat 10333 The Speedgoat 10333 is a field-
programmable gate array (FPGA) board

based on a Xilinx Kintex® 7 chip with 325k
logic cells.

HDL Coder HDL Workflow Advisor
supports the Speedgoat 10333-325K-06
configuration. For more information, see
Speedgoat HDL Coder Integration Package
for the 10333-325K.

To work with FPGAs in the Simulink Real-Time environment, you must:

+ Install HDL Coder and Xilinx design tools. For the specific tool and version required,
see the board reference topic and the HDL Coder documentation.

+ Install the Speedgoat FPGA 1/0 board in the Speedgoat target machine.

*  Be familiar with FPGA technology. In particular, you must know the clock frequency
and the I/O connector pin and channel configuration of your FPGA board.

* Have experience using data type conversion and designing Simulink fixed-point
algorithms.

To generate HDL code for your FPGA target, you do not need to have HDL programming
experience.

See Also
Speedgoat 10333 | Speedgoat 10321 | Speedgoat 10331

More About
. “Supported Third-Party Tools and Hardware” (HDL Coder)

1-3
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1-4

. “Tool Setup” (HDL Coder)

. “FPGA Programming and Configuration” on page 1-5
. “Digital I/O with Speedgoat FPGA Board”

. “PLL-Based Interrupt Generation from FPGA Input”

External Websites
. www.mathworks.com/products/simulink-real-time/supported/hardware-drivers.html
. www.speedgoat.com/support/iomodules

. www.speedgoat.com


https://www.mathworks.com/products/simulink-real-time/supported/hardware-drivers.html
http://www.speedgoat.com/support/iomodules
http://www.speedgoat.com

FPGA Programming and Configuration

FPGA Programming and Configuration

This example shows how to implement a Simulink® algorithm on a Speedgoat FPGA 1/0
board by using HDL Workflow Advisor to:

1  Specify an FPGA board and its I/O interface.

2 Synthesize the Simulink algorithm for FPGA programming.

3 Generate a Simulink® Real-Time™ interface subsystem model.

The interface subsystem model contains blocks to program the FPGA and communicate

with the FPGA I/O board during real-time application execution. You add the generated
subsystem to your Simulink Real-Time domain model.

The entire workflow looks like this figure.

Development computer Target machine

Simulink Real-
Time model

Simulink Real-
Time FPGA
interface block

F Y

block into Simulink
Real-Time model

Build and download real-time
application into target machine

TTL /O FPGA

HDL Workflow Simulink Real-
Advisor Time model
. ) Simulink Real-
Gege;rate ?lrn_ulmk Time FPGA
mo €1 containing interface block
Simulink FPGA interface block
model
Simulink FPGA
interface block CPU running Intertace block
- Simulink Real- loads bitstream
Copy interface Time kernel into FPGA



1

FPGA Models

1-6

This example uses the Speedgoat I0331. You can use any FPGA I/0O module supported by
Simulink Real-Time and HDL Coder that meets the speed, size, and pinout requirements
of the model.

Requirements and Preconditions
HDL Coder™
Before you start, complete an FPGA subsystem plan.

For the 10331 board, HDL Workflow Advisor requires the Xilinx® ISE toolset. To install
this toolset, in the Command Window, type:

hdlsetuptoolpath(*ToolName®", "Xilinx ISE", "ToolPath®, toolpath)
where toolpath is the full path to the synthesis tool executable.

For the toolset requirements of other boards, see Supported Third-Party Tools and
Hardware (HDL Coder).

Step 1. Simulink Domain Model

The Simulink FPGA domain model contains a subsystem (algorithm) to be programmed
onto the FPGA chip. Using this model, you can test your FPGA algorithm in a simulation
environment before you download the algorithm to an FPGA board.

1 Create a Simulink model that contains the algorithm that you want to load onto the
FPGA, in this case a loopback test.

2 Place the algorithm to be programmed on the FPGA inside a Subsystem block. The
model can include other blocks and subsystems for testing. However, one subsystem
must contain the FPGA algorithm.

3 Set or confirm the subsystem inport and outport names and data types. The HDL
Coder HDL Workflow Advisor uses these settings for routing and mapping algorithm
signals to I/O connector channels.

4 Save the model.

This model is your FPGA domain model. It represents the simulation sample rate of the
clock on your FPGA board. For example, the Speedgoat 10331 has an onboard 125 MHz
clock. One second of simulation equals 125e6 iterations of the model.

For an example of an FPGA domain model, see dslrtSGFPGAloopback_fpga. The
ServoSystem subsystem contains the FPGA algorithm.
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_ ¥l loopbeck test
1) Connect digital /O channels 0 - 7.

2) Write 10ms pulses to output channels.
2) Read input channels and display on a scope.
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Step 2. FPGA Target Configuration

This procedure uses the dslrtSGFPGAloopback fpga example. You must have already
created an FPGA subsystem (algorithm) in an FPGA domain model and developed an
FPGA subsystem plan.

Open the FPGA domain model dslrtSGFPGAloopback fpga.

2 Inthe FPGA model, right-click the FPGA subsystem (ServoSystem). From the
context menu, select HDL Code > HDL Workflow Advisor. The HDL Workflow
Advisor dialog box displays several tasks for the subsystem. Address only your
required subset of the tasks.

3 Expand the Set Target folder and select task 1.1 Set Target Device and
Synthesis Tool.

4 Set Target Workflow to Simulink Real-Time FPGA 1/0.

5 From the Target platform list, select the Speedgoat FPGA 1/0 board installed in
your Speedgoat target machine, in this case the Speedgoat 10331. Check that
HDL Workflow advisor sets the synthesis tool to the Xilinx® ISE Design Suite.

6 Click Run This Task.

1-7
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Step 3. FPGA Target Interface Configuration

You must have already configured the FPGA target.

1 In the Set Target folder, select task 1.2 Set Target Interface.
2 Inthe Processor/FPGA synchronization box, select Free running.

3 For signals hwln and hwOut, in the Target Platform Interfaces column, select
LVCMOS 1/0 Channel [0:63]. In the Bit Range/Address/FPGA Pin column,
enter the channel value for each signal, or take the defaults.
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4 For signals pciRead and pciWrite, in the Target Platform Interfaces column,
select PCI Interface. In the Bit Range/Address/FPGA Pin column, use the
automatically generated values. Do not enter PCI address values.

5 Click Run This Task.

12 HDL Werkflow Advisor - dsltSGFPGAloepback_fpga/loopback
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Step 4. FPGA Target Frequency Configuration

You must have already configured the FPGA target interface.

1 In the Set Target folder, select task 1.3 Set Target Frequency (optional). The Set
Target Frequency pane contains fields showing the FPGA input clock frequency
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(fixed) and the FPGA system clock frequency. The FPGA system clock frequency
defaults to the FPGA input clock frequency.

2 To specify a different system clock frequency (for example, 50 MHz), type the new
value in the field FPGA system clock frequency (MHz). For the permitted range
for the system clock rate, see the Speedgoat board characteristics table. The system
sometimes sets a value different from the one you specified.

3 Click Run This Task.

| HODL Workflow Advisar - dsItSGEPGAloopback faoalloopback = [ ]
File Edit Run Hep

Find: v 49

- 1.3. Set Target Frequency
4 1B HDL Workflow Advisor

— Analysis
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4, FPGA Synthesis and Analysis

Target Frequency (MHz): 50

Frequency Range (MHz):

Resuit: @) Passed

Download to Target

g Info: the DCM params are CLKFX_MULTIPLY = 2; CLKFX_DIVIDE = 5.

Pasced Set Target Frequency
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Step 5. Simulink Real-Time Interface Subsystem Generation

This procedure generates an interface subsystem file for the dxpcSGFPGAloopback_fpga
example.

Assign distinct names to blocks that contain different HDL code. The name of the
interface subsystem file is derived directly from the block name. If two blocks containing
different HDL code have the same name, the names collide and one of the blocks gets the
wrong code.

You must have already configured the FPGA target interface and the required target
frequency. If you have specified vector inports or outports, you must have already
selected the Scalarize vector ports check box. This check box is on the Coding style
tab of node Global Settings, under node HDL Code Generation in the Configuration
Parameters dialog box.

1 Expand the Download to Target folder, and right-click task 5.2 Generate
Simulink Real-Time Interface.
2 In this pane, click Run To Selected Task.

This action:

*  Runs the remaining tasks.

* Creates the FPGA bitstream file in the hdlsrc folder. The Simulink Real-Time
interface subsystem references this bitstream file during the build and download
process.

* Generates a model named gm_dsIrtSGFPGAloopback_fpga_slrt, which contains
the Simulink Real-Time interface subsystem.

Here is an example of the HDL Coder HDL Workflow Advisor after this action.

1-11
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The generated interface subsystem looks like this figure.

1-12
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This generated model contains a masked subsystem with the same name as the
subsystem in the Simulink FPGA domain model. Although the appearance is similar,
this subsystem does not contain the Simulink algorithm. Instead, the algorithm is
implemented in an FPGA bitstream. You reference and load this algorithm into the
FPGA from this subsystem.

Step 6. Simulink Real-Time Domain Model

Using the Simulink Real-Time software, transform a Simulink or Stateflow® domain
model into a Simulink Real-Time domain model and execute it on a Speedgoat target
machine for real-time testing applications. After creating a Speedgoat FPGA interface
subsystem. You can then include the FPGA board in your Simulink Real-Time domain
model by inserting the interface subsystem.

1 Create a Simulink Real-Time domain model with the functionality that you want
to simulate with the FPGA algorithm. Leave the inports and outports of the FPGA
subsystem disconnected.

2 Save the model.

The Simulink Real-Time domain model looks like this figure. See example model
dsIrtSGFPGAloopback_slirt.

1-13
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Step 7. Simulink Real-Time Interface Subsystem Integration

In the Simulink Real-Time interface subsystem mask, set three parameters:

* Device index
+ PCI slot

+  Sample time

To integrate the interface subsystem:

In the Simulink editor, open gm_dslrtSGFPGAloopback fpga slirt.

2 Copy the Simulink Real-Time interface subsystem and paste it into the Simulink

Real-Time domain model.

3 Save or discard gm_dslrtSGFPGAloopback _fpga_slrt. You can recreate it as

required using the HDL Coder HDL Workflow Advisor.

1-14
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4 In the domain model, connect signals to the inports and outports of the interface
subsystem.

5 Set the block parameters according to the FPGA 1/0 boards in your Speedgoat target
machine.
+ If you have a single FPGA I/0 board, leave the device index and PCI slot at the
default values. You can set the sample time or leave it at —1 for inheritance.
+ If you have multiple FPGA 1/O boards, give each board a unique device index.

+ If you have two or more boards of the same type (for example, two Speedgoat 10331
boards), specify the PCI slot ([bus, slot]) for each board. Get this information with the
SimulinkRealTime.target.getPCIInfo function.

6 Save the model.

The updated Simulink Real-Time domain model looks like this figure. See example model
dslrtSGFPGAloopback_slrt_wiss.
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Step 8. Real-Time Application Execution

To do this procedure, you must have already created a Simulink Real-Time domain
model that includes a Simulink Real-Time interface subsystem generated from the HDL
Coder HDL Workflow Advisor.

1 Configure the Speedgoat target machine and connect it to the development
computer.

2 Build and download the Simulink Real-Time application. The real-time application
loads onto the Speedgoat target machine and the FPGA algorithm bitstream loads
onto the FPGA.

3 Ifyou are using I/O lines (channels), confirm that you have connected the lines to the

external hardware under test.

The start and stop of the Simulink Real-Time model controls the start and stop of the
FPGA algorithm. The FPGA algorithm executes at the clock frequency of the FPGA I/
O board, while the real-time application executes in accordance with the model sample
time.

See Also
SimulinkRealTime.target.getPClInfo | Speedgoat 10331 | Subsystem

More About

. “HDL Workflow Advisor” (HDL Coder)

. “TP Core Generation Workflow for Speedgoat Boards” (HDL Coder)
. “FPGA Subsystem Plan” on page 1-19

. “FPGA Synchronization Modes” on page 1-23

. “FPGA Clock Frequency” on page 1-21

. “Digital I/O with Speedgoat FPGA Board”

. “PLL-Based Interrupt Generation from FPGA Input”
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Interrupt Configuration

Simulink Real-Time software schedules the real-time application using either the
internal timer of the Speedgoat target machine (default) or an interrupt from an I/O
board. You can use your Speedgoat FPGA board to generate an interrupt, which allows

you to:

* Schedule execution of the real-time application based on this interrupt (synchronous
execution). For this method, you must generate the interrupt periodically.

+  Execute a designated subsystem in your real-time application (asynchronous

execution).

To use FPGA-based interrupts, set up and configure the FPGA domain and Simulink
Real-Time domain models.

In this section...
“FPGA Domain Model” on page 1-17
“Simulink Real-Time Domain Model” on page 1-18

FPGA Domain Model

In the FPGA domain subsystem, create the interrupt source for the real-time application
in one of the following ways.

Source Description

Internal A clock you create using Simulink blocks to create input signals. This
clock is a binary pulse train of zeros and ones (transition from O to 1

and from 1 to 0). The clock generates an interrupt on a rising edge. The
following is an example of an internally generated interrupt source from
Simulink blocks. Connect the internally generated interrupt source to an
outport labeled INT.

it Tirmge ouns :E

nbernegd Source
.
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Source Description

External A clock signal that comes from a device outside the Speedgoat target

machine. You use a digital input pin to connect to this signal. The
following is an example of an externally generated interrupt source that
comes from TTL channel 8. Delay this source by one FPGA clock cycle and
connect to an outport labeled INT.

O— : ——D

EXT NTTTLC8 o MT

In both cases, wire the interrupt source to an outport in the FPGA subsystem. Assign the
outport as Interrupt from FPGA in the HDL Coder HDL Workflow Advisor task 1.2
Set Target Interface.

You are now ready to set up interrupt support in the Simulink Real-Time domain model.

Simulink Real-Time Domain Model

Configure the model Simulink Real-Time domain model to set up interrupt support:

1 Open the Simulink Real-Time domain model.
2 In the Simulink editor, select Simulation > Model Configuration Parameters.
3 Navigate to node Simulink Real-Time Options, under node Code Generation.
4 From the Real-time interrupt source list, select one of the following:
+ Auto (PCI only)
The IRQ assigned to your FPGA board
5 From the I/O board generating the interrupt parameter, select your FPGA
board, for example, Speedgoat 10331.
6 Add the Simulink Real-Time interface subsystem to the model.
7 Build and download the real-time application to the Speedgoat target machine.
8 When you start the real-time application, simulation updates occur when the
application receives an interrupt from the FPGA I/0 board.
More About

“PLL-Based Interrupt Generation from FPGA Input”
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FPGA Subsystem Plan

Before you work with the HDL Coder HDL Workflow Advisor, plan how to prepare the
FPGA subsystem for HDL code generation and FPGA synthesis.

In this section...

“Target Device” on page 1-19

“FPGA Synchronization Mode” on page 1-19
“FPGA Inports and Outports” on page 1-20
“FPGA Clock Frequency” on page 1-21
“FPGA Deployment” on page 1-21

Target Device

First, to decide which FPGA to target for code generation, consult the Speedgoat data
sheet for information:

* Availability and cost

*  Bus compatibility

+  Size

*  Pinouts

*  Clock speed

The example procedure uses the Simulink Real-Time FPGA workflow and the Speedgoat
10331 FPGA 10 board as target platform. This choice requires that you use the Xilinx
ISE synthesis tool.

For information about other target devices, see “Supported Third-Party Tools and
Hardware” (HDL Coder).

FPGA Synchronization Mode

To select the processor/FPGA synchronization mode, you must decide which of the FPGA
synchronization modes to use:

* Free running

1-19
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Coprocessing — blocking
Coprocessing — nonblocking with delay.

For more information, see “FPGA Synchronization Modes” on page 1-23.

FPGA Inports and Outports

Inports and outports can transmit signal data between the Speedgoat target machine
and the FPGA over the PCI bus. Alternatively, they can map to I/O channels for
communicating with external devices. For connector pin and I/O channel assignments of
your supported FPGA I/O board, see the board reference page for your board.

In addition to the Port Name and Port Type (Inport or Outport), to specify the I/0
interface, see:

Data Type—Encodes such attributes as width and sign. Data types must map
consistently to their corresponding I/O pins. An inport of type Boolean requires 1 bit,
one of type uint32 requires 32 bits, and so on. For example, you cannot connect an
inport of type uint32 to an FPGA I/0O interface of type TTL 1/0 channel [0:7]; it
requires TTL 1/0 channel [0:31].

Target Platform Interfaces—Encodes the I/O channels on the FPGA and their
functional type. For a single-ended interface (TTL, LVCMOS), one channel maps to one
connector pin. For a differential interface (RS422, LVDS), one channel maps to two
connector pins. To discover the mapping for a particular pin, see the pin connector
map provided with the board description.

I/0 channels can also map to a predefined specification or role (PCl1 Interface,
Interrupt from FPGA).

For information on using FPGA interrupts, see “Interrupt Configuration” on page
1-17.

Bit Range/Address/FPGA Pin—Encodes the pins on the target platform to which
the inports and outports are assigned, along with the channel number used by the
port. For specification PCI Interface, Bit Range/Address/FPGA Pin encodes the
PCI address used by the port.

If vector inports or outports are required, specify a vector port:

1-20
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* Outport — Add a mux inside the subsystem that connects to a demux outside the
subsystem.

* Inport and Outport — Configure the port dimension to be greater than 1.

Workflow Advisor automatically inserts a strobe to achieve a simultaneous update of
vector elements.

If you have specified vector inports or outports, before generating code, you must select
the Scalarize vector ports check box. This check box is on the Coding style tab

of node Global Settings, under node HDL Code Generation in the Configuration
Parameters dialog box.

FPGA Clock Frequency

The FPGA system clock frequency defaults to the fixed FPGA input clock frequency. The
fixed FPGA input clock frequency is shown in the FPGA input clock frequency (MHz)
box. You can specify another frequency in this box. If the FPGA clock circuits cannot
generate the specified value exactly, HDL Coder HDL Workflow Advisor generates the
closest match. The closest match, Fgysten, is based on the following formula:

F,

system = Finput * ClRFxMultiply / Clk FxDivide

Finput is the fixed FPGA input clock frequency. CIkFxMultiply and CIkFxDivide are
integers.

FPGA Deployment

When HDL Coder HDL Workflow Advisor generates the programmed

FPGA subsystem, it writes an SLX file (gm_md1lname .slx) and a C file
(blkorrefmdlname_topiospeedgoat#.c) into the model folder. The SLX file contains
the FPGA subsystem. The C file contains the bitstream.

For example, assume that model fpga_model . sIx contains a Subsystem block named
fpga_subsystem, and that you configure the FPGA target platform for the model as
Speedgoat 10333. Then HDL Coder HDL Workflow Advisor generates the following files:

gm_fpga_model _slx
fpga_subsystem_topl0331.c
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When you build your domain model with the integrated subsystem, the model compiler
reads the C file and inserts its contents into the compiled output. The compiler assumes
that the SLX file and the C file are in the same folder. If you deploy the model to another
location on the disk, copy the SLX file and the C file to the new location.

More About

“Supported Third-Party Tools and Hardware” (HDL Coder)
“FPGA Synchronization Modes” on page 1-23

“Interrupt Configuration” on page 1-17
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FPGA Synchronization Modes

In Simulink Real-Time, an FPGA operates in three synchronization modes:

Free running

Coprocessing — blocking

Coprocessing — nonblocking with delay

Free running (default) — The CPU of the Speedgoat target machine and the FPGA
each run nonsynchronized, continuously, and in parallel. Select this mode when you

want the CPU to run continuously without interrupts. For example, select this mode
when the model is processing continuous PWM output.

The CPU:

1 Strobes data out of the FPGA.

2 Reads results from the FPGA outputs.
3  Writes data to the FPGA inputs.

4  Strobes the data into the FPGA.

The shaded areas indicate that the processor and FPGA are running continuously.

|0 iTs LE
:Prﬂcsssc:-r : :
. [R] | W | SW [R] | W] i
[ | |
| . I 4 I
| I I
| Y | Y |
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Coprocessing — blocking — The CPU of the Speedgoat target machine and the
FPGA run synchronized and in tandem. Select this mode when the FPGA execution
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time is short compared to the target computer sample time. For example, select this

mode when the model requires the FPGA results to continue processing.

The CPU:

1  Writes data to the FPGA inputs.

2 Strobes the data into the FPGA.

3 Waits for the FPGA to finish executing.

4 Reads results from the FPGA outputs.
o Ts Te*2
I | |
| Frocessor | |
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Coprocessing — nonblocking with delay — The CPU of the Speedgoat target
machine and the FPGA run synchronized and in tandem. Select this mode when the
FPGA execution time is long compared to the Speedgoat target machine sample time.

For example, select this mode to manage multiple FPGAs effectively in parallel.

The

A W N —

CPU:

Waits for the FPGA to finish executing.
Reads the data from the previous time step.
Writes new data to the FPGA inputs.
Strobes the data into the FPGA.
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+ “Calibrate Real-Time Application” on page 2-2

* “Prepare ASAP2 Data Description File” on page 2-4

+ “Calibrate Parameters with Vector CANape” on page 2-10
* “Vector CANape Limitations” on page 2-13

+ “Vector CANape Troubleshooting” on page 2-14

+ “Calibrate Parameters with ETAS Inca” on page 2-15

+ “ETAS Inca Limitations” on page 2-18

+ “ETAS Inca Troubleshooting” on page 2-19



2 Third-Party Calibration Support

Calibrate Real-Time Application

Simulink Real-Time supports interaction with third-party calibration tools such as
Vector CANape (www.vector.com) and ETAS Inca (www.etas.com). Use these tools for:

*  Parameter display and tuning
+ Calibration data saving, restoring, and swapping by page

* Signal value streaming

These tools run in XCP master mode. Simulink Real-Time emulates an electronic control
unit (ECU) operating in XCP slave mode. To enable a real-time application to work with
the third-party software:

*  Configure the third-party software to communicate with the real-time application as
an ECU.

* Provide a standard TCP/IP physical layer between the development and target
computers. Simulink Real-Time supports third-party calibration software only
through TCP/IP.

* Generate a real-time application with signal and parameter attributes that are
consistent with A2L (ASAP2) file generation. See “Export ASAP2 File for Data
Measurement and Calibration” (Simulink Coder).

+ Use the build process to generate model slrt.a2l (ASAP2) files that the software
can load into its database. The generated file contains signal and parameter access
information for the real-time application and XCP-related sections and memory
addresses.

If your model includes referenced models, the build creates a model slrt.a2l
file for the real-time application and separate refmodel slrt.a2l files for each
referenced model.

Note: You cannot configure third-party software for calibration with only the A2L files
that Simulink Coder™ generates. These files do not contain XCP-related sections and
memory addresses. Simulink Real-Time adds this information during the build process.

More About
. “Export ASAP2 File for Data Measurement and Calibration” (Simulink Coder)
. “Prepare ASAP2 Data Description File” on page 2-4
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Calibrate Real-Time Application

. “Calibrate Parameters with Vector CANape” on page 2-10
. “Calibrate Parameters with ETAS Inca” on page 2-15
. “XCP Master Mode”

External Websites
. www.vector.com

. www.etas.com
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Prepare ASAP2 Data Description File

oooo
[3]

Signal
Generator

This example shows how to configure a Simulink Real-Time model so that the build
generates an ASAP2 (A2L) data description file for the real-time application. The real-

time application models a damped oscillator that feeds into 1-D and 2-D lookup tables,
which invert and rescale the input waveform.

This example uses ex_slrt_cal_osc (matlab:
open_system(docpath(fullfile(docroot, “toolbox®, "xpc®, "examples-®,
"ex_slrt_cal_osc™)))), which requires ex_slrt_cal_osc_data.mat (matlab:
load(docpath(fullfile(docroot, "toolbox", *"xpc®, "examples”,
"ex_slrt_cal_osc_data.mat")))).
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SignalGenerator

The goal of calibration is reducing the ringing in signals DampedOsc, L_1D, and L_2D.

In this section...

“Initial Setup” on page 2-6
“Set Up Parameters” on page 2-6

“Set Up Signals” on page 2-7
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In this section...

“Set Up Lookup Tables” on page 2-8

“Generate Data Description File” on page 2-8

Initial Setup

For best results, load the MATLAB® workspace variables before you load the model that
uses them.

1

Load workspace variables for the example model from
ex_slrt_cal _osc _data.mat (matlab: load(docpath(fullfile(docroot,
"toolbox", "xpc®, "examples®, "ex slrt_cal _osc data.mat")))).

The MATLAB workspace variables have the following functions:

Kg — Parameter object for the Gainl block

DampedOsc, SignalGenerator, L_1D, L_2D — Signal objects for output signals
ydata, zdata — 1-D and 2-D lookup tables respectively

xbreakl, xbreak2, ybreak — Indexes into lookup tables

Open ex_slrt_cal_osc (matlab:
open_system(docpath(fullfile(docroot, "toolbox",
"examples®, “ex_slrt_cal_osc")))).

xpc*,

Set Up Parameters

Set up parameter tuning by using Simulink parameter objects.

1

2
3

In ex_slrt_cal_osc, on the toolbar, click the Model Explorer button .
Select Base Workspace in the Model Hierarchy pane.
Check that the Kg parameter object exists and has these properties:

+ Value — 400

+ Data type — double

+ Storage class — ExportedGlobal

If the parameter object does not exist, add it. On the toolbar, click the Add
Simulink Parameter button |.|.
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5 Openex_slrt _cal_osc/Gainl.

6  Check that you have set the Gain value to the parameter object Kg.

Set Up Signals

As a best practice, set up signal viewing by using Simulink signal objects.

1 In ex_slrt_cal _osc, on the toolbar, click the Model Explorer button .

2 Select Base Workspace in the Model Hierarchy pane.
3 Check that the DampedOsc signal object exists and has these properties:

* Minimum — -10
Maximum — 10
+ Data type — double
Storage class — ExportedGlobal.
4 Check that the SignalGenerator signal object exists and has these properties:

* Minimum — -10
* Maximum — 10
+ Data type — double
Storage class — ExportedGlobal.
5 Check that the L_1D signal object exists and has these properties:

Minimum — -15
+ Maximum — 15
Data type — double
+ Storage class — ExportedGlobal.
6  Check that the L_2D signal object exists and has these properties:

Minimum — -15
+ Maximum — 15
Data type — double
+ Storage class — ExportedGlobal.
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7 If a signal does not exist, add it. On the toolbar, click the Add Simulink Signal
button [T

8 For each signal, open its Properties dialog box.

9 Check that you selected the Signal name must resolve to Simulink signal
object and the Test point check boxes.

Set Up Lookup Tables
The example model contains 1-D and 2-D lookup tables.

1 Open the block parameters for the 1-D Lookup Table block.
2 Inthe Table and Breakpoints pane, check the following settings:

Number of table dimensions — 1
+ Table data — ydata
Breakpoints specification — Explicit values
+ Breakpoints 1 — xbreakl
3 Open the block parameters for the 2-D Lookup Table block.
4 In the Table and Breakpoints pane, check the following settings:

* Number of table dimensions — 2
Table data — zdata

* Breakpoints specification — Explicit values
Breakpoints 1 — xbreak?2

* Breakpoints 2 — ybreak

To view the contents of the lookup tables, click Edit table and breakpoints, and then
click Plot > Mesh.

Generate Data Description File

1 Open Simulation > Model Configuration Parameters.
2 In the left pane, click the Simulink Real-Time Options node.

3 In the Miscellaneous options area, select the Generate INCA/CANape
extensions (disables Simulation Data Inspector and Dashboard blocks)
check box.
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This option enables real-time applications to generate an ASAP2 (A2L) data
description file. You can then use third-party calibration software.

Build the model.

The build produces a file named ex_slrt_cal_osc_slrt.a2l in the working
folder.

When the build is complete, on the target computer monitor, look for the following
message.

XCP Server set up, waiting for connection

This message indicates that you have built the real-time application without
producing an error. You can now connect to the target with a third-party calibration
tool.

See Also

“Generate INCA/CANape extensions (disables Simulation Data Inspector and Dashboard
blocks)” | n-D Lookup Table

More About

“Calibrate Parameters with Vector CANape” on page 2-10
“Calibrate Parameters with ETAS Inca” on page 2-15

External Websites

www.vector.com

www.etas.com
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Calibrate Parameters with Vector CANape

This example shows how to view signals and tune parameters by using Vector CANape.
You must have already completed the steps in “Prepare ASAP2 Data Description File” on
page 2-4.

You also must be familiar with the Vector CANape user interface. For information about
the user interface, see the vendor documentation (Www.vector .com).

In this section...

“Prepare Project” on page 2-10
“Prepare Device” on page 2-10
“Configure Signals and Parameters” on page 2-10

“Perform Signal Measurement and Parameter Calibration” on page 2-11

Prepare Project

1 Build and download real-time application ex_slrt_cal_osc.
2 Open Vector CANape.
3 Create a Vector CANape project with project name ex_slrt_cal_osc.

Accept the default folder.

Prepare Device

1 Fromex_slrt_cal_osc_slrt.a2l in your build folder, create an XCP device
named ex_slrt_cal _osc_slrt.

Do not configure dataset management.
2 Select your local computer Ethernet adapter as the Ethernet channel

w

Accept the remaining defaults.
4 Upload data from the device.

Configure Signals and Parameters

1 Open device ex_slrt_cal _osc_slrt, and then open
ex_slrt_cal _osc_slrt.az2l.
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Calibrate Parameters with Vector CANape

Add signals DampedOsc, SignalGenerator, L_1D, and L_2D in separate display
windows.

To make the waveform easier to evaluate, set the time and y-axis scaling.

For example, try the following settings for DampedOsc:

y-axis min home value — —25
* y-axis max home value — 25
Min home time-axis value — O s
* Max home time-axis value — 0.1 s
Time duration — 0.1 s
Open the measurement list.
To set the required sample rate for a signal, open the measurement properties for
the signal. Select the required sample rate from the measurement mode list.
The default rate is the base sample rate.

Add a graphic control on parameter Kg.

Perform Signal Measurement and Parameter Calibration

1

Start the Vector CANape measurement.

2 In Simulink Real-Time Explorer, start the real-time application.
The signal windows show the four waveforms, corresponding to the displays on the
target computer screen.

3 To shorten the ring time on DampedOsc, L_1D, and L_2D, set parameter Kg to, for
example, 800.

4  Asrequired, toggle between calibration RAM active and inactive.

More About

“Prepare ASAP2 Data Description File” on page 2-4
“Vector CANape Limitations” on page 2-13
“Vector CANape Troubleshooting” on page 2-14
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External Websites

. www.vector.com
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Vector CANape Limitations

Vector CANape Limitations

For Vector CANape, the Simulink Real-Time software does not support:
+ Starting and stopping the real-time application by using Vector CANape commands.

To start and stop the real-time application on the target computer, use the Simulink
Real-Time start and stop commands, for example start(tg), stop(tg).

* Vector CANape flash programming.

*  Multiple simultaneous Vector CANape connections to a single target computer.
Event mode data acquisition has the following limitations:

+ Every piece of data that the Simulink Real-Time software adds to the event list slows
the real-time application. The amount of data that you can observe depends on the
model sample time and the speed of the target computer. It is possible to overload the
target computer CPU to where data integrity is reduced.

* You can trace only signals and scalar parameters. You cannot trace vector
parameters.
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Vector CANape Troubleshooting

2-14

Simulation Data Inspector in Use

Simulation Data Inspector (SDI) and the third-party calibration tools (Vector CANape
and ETAS Inca) are mutually exclusive. If you use SDI to view signal data, you cannot
use the calibration tools. If you use the calibration tools, you cannot use SDI to view
signal data.

Master Cannot Connect

Check the IP address of the target computer associated with the model and compare it
with the address stored in the ASAP2 file.

ASAP2 File Out of Date

When you rebuild a Simulink Real-Time application, update the ASAP2 file loaded in
the calibration tool with the new version of the file. The ASAP2 file is valid only until the
next time you build the application.
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Calibrate Parameters with ETAS Inca

This example shows how to view signals and tune parameters by using ETAS Inca. You
must have already completed the steps in “Prepare ASAP2 Data Description File” on
page 2-4.

You also must be familiar with the ETAS Inca user interface. For information about the
user interface, see the vendor documentation (Www . etas.com).

In this section...

“Prepare Database” on page 2-15

“Prepare Project” on page 2-15

“Prepare Workspace” on page 2-15

“Prepare Experiment” on page 2-16

“Configure Signals and Parameters” on page 2-16

“Perform Signal Measurement and Parameter Calibration” on page 2-16

Prepare Database

Build and download real-time application ex_slrt_cal_osc.

Open ETAS Inca.
Add an ETAS Inca database with folder named SLRTDatabase.
Add subfolders named Experiment, Project, and Workspace.

B WN —

Prepare Project

Under folder Project, add an ECU project.

2 When prompted, select A2L file ex_slrt_cal_osc_slrt.a2l in your build folder.
Ignore the prompt for a HEX file.

If you change and rebuild the real-time application, delete the ECU project and
recreate it with the new A2L file.

Prepare Workspace

1  Under folder Workspace, add workspace ex_slrt_cal_osc_wksp.
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g WODN

Add project ex_slrt_cal_osc_slrt to workspace ex_slrt_cal_osc_wksp.
When prompted, add an Ethernet system XCP device to the workspace.
Configure the XCP device and initialize it. Auto configure the ETAS network.
To upload data from the device hardware, use enhanced operations on memory
pages.

Data is uploaded from the real-time application on the target computer.

Prepare Experiment

1
2

Under folder Experiment, add experiment ex_slrt_cal _osc_exp.
Add experiment ex_slrt_cal_osc_exp to workspace ex_slrt_cal_osc_wksp.

Configure Signals and Parameters

1
2

3
4

Start experiment ex_slrt_cal_osc_exp.

To create graphic controls for the variables, add variables Kg, DampedOsc,
SignalGenerator, L_1D, L 2D, and zdata.

Add YT oscilloscopes for DampedOsc, SignalGenerator, L_1D, L_2D.

For each signal, set the rate to the base sample rate of the real-time application (250
us).

Perform Signal Measurement and Parameter Calibration

Start the ETAS Inca measurement.

In Simulink Real-Time Explorer, start the real-time application.

The signal windows show the four waveforms, corresponding to the displays on the
target computer screen.

To shorten the ring time on DampedOsc, L_1D, and L_2D, set parameter Kg to, for
example, 800.

As required, toggle between reference page and working page.

To freeze the parameter set on the target computer, use the freeze working data
command.

To save the working data on the development computer, use the save working data
command.
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More About

“Prepare ASAP2 Data Description File” on page 2-4
“ETAS Inca Limitations” on page 2-18

“ETAS Inca Troubleshooting” on page 2-19

External Websites

. www.etas.com
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ETAS Inca Limitations

For ETAS Inca, the Simulink Real-Time software does not support:

2-18

Starting and stopping the real-time application by using ETAS Inca commands.

To start and stop the real-time application on the target computer, use the Simulink
Real-Time start and stop commands, for example start(tg), stop(tg).

ETAS Inca flash programming.

Multiple simultaneous ETAS Inca connections to a single target computer.

Event mode data acquisition has the following limitations:

Every piece of data that the Simulink Real-Time software adds to the event list slows
the real-time application. The amount of data that you can observe depends on the
model sample time and the speed of the target computer. It is possible to overload the
target computer CPU to where data integrity is reduced.

You can trace only signals and scalar parameters. You cannot trace vector
parameters.
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ETAS Inca Troubleshooting

Simulation Data Inspector in Use
Simulation Data Inspector (SDI) and the third-party calibration tools (Vector CANape
and ETAS Inca) are mutually exclusive. If you use SDI to view signal data, you cannot

use the calibration tools. If you use the calibration tools, you cannot use SDI to view
signal data.

Master Cannot Connect

Check the IP address of the target computer associated with the model and compare it
with the address stored in the ASAP2 file.

ASAP2 File Out of Date
When you rebuild a Simulink Real-Time application, update the ASAP2 file loaded in

the calibration tool with the new version of the file. The ASAP2 file is valid only until the
next time you build the application.

Cannot Disable Freeze Mode
Remove the dataset file from the target file system and reset the parameters

to the original values specified in your model. The dataset file is named
flashdata_model name.dat.
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* “Fortran S-Functions” on page 3-2

* “Fortran Atmosphere Model” on page 3-4
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Fortran S-Functions

The Simulink Real-Time product supports Fortran in Simulink models using S-functions.
For more details, see “Create Level-2 Fortran S-Functions” (Simulink) and “Port Legacy
Code” (Simulink).

In this section...

“Prerequisites” on page 3-2
“Simulink S-Function Example” on page 3-2

“Steps to Incorporate Fortran” on page 3-2

Prerequisites

You must have Simulink Real-Time Version 1.3 or later to use Fortran for real-time
applications. The Simulink Real-Time product supports the Fortran compilers listed
here:

www . mathworks.com/support/compilers/current_release

Simulink S-Function Example

The Simulink examples folder contains a tutorial and description on how to incorporate
Fortran code into a Simulink model using S-functions. To access the tutorial and
description:

1  Open “Custom Code and Hand Coded Blocks using the S-function API” (Simulink)
2 Open the associated model.

3 Open the Fortran S-functions example model. Fortran S-functions and associated
templates appear.

Steps to Incorporate Fortran

This topic lists the general steps to incorporate Fortran code into a real-time application.
Detailed commands follow in the accompanying examples.

1 Using the Fortran compiler, compile the Fortran subroutines (*.F). Specify
particular compiler options.
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Fortran S-Functions

Write a Simulink C-MEX wrapper S-function. This wrapper S-function calls one or
more of the Fortran subroutines in the compiled Fortran object code from step 1.
Use the mex function to compile this C-MEX S-function using a Microsoft® Visual C+
+* compiler. Define several Fortran run-time libraries to be linked in.

This step creates the Simulink S-function MEX-file.

To validate the compiled Fortran code and wrapper S-function, run a simulation C-
MEX file with the Simulink software.

Copy the relevant Fortran run-time libraries to the real-time application build
folder.

Define the Fortran libraries, and the Fortran object files from step 1, in the Simulink
Coder dialog box of the Simulink model. Define these libraries and files as additional
components to be linked in when the real-time application link takes place.

Initiate the Simulink Real-Time specific Simulink Coder build procedure for the
example model. Simulink Coder builds and downloads Simulink Real-Time onto the
target computer.
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Fortran Atmosphere Model

3-4

This example uses the example Atmosphere model that comes with the Simulink
product. The following procedures require you to know how to write Fortran code
according to Simulink and Simulink Real-Time software requirements.

Before you start, create a Simulink Real-Time Simulink model for the Atmosphere
model. See “Creating a Fortran Atmosphere Model” on page 3-4.

In this section...

“Creating a Fortran Atmosphere Model” on page 3-4

“Compiling Fortran Files” on page 3-6

“Creating a C-MEX Wrapper S-Function” on page 3-6

“Compiling and Linking the Wrapper S-Function” on page 3-10
“Validating the Fortran Code and Wrapper S-Function” on page 3-11
“Preparing the Model for the Real-Time Application Build” on page 3-12

“Building and Running the Real-Time Application” on page 3-13

Creating a Fortran Atmosphere Model

To create a Simulink Real-Time Atmosphere model in Fortran, add a Simulink Real-
Time Scope block to the sfcndemo_atmos model. Perform this procedure if you do not
already have a Simulink Real-Time Atmosphere model for Fortran.

1  From the MATLAB window, change folder to the working folder, for example,
xpc_fortran_test.

2 Type

sfcndemo_atmos

The sfcndemo_atmos model is displayed.
3 Add a Simulink Real-Time Scope block of type Target.
4  Connect this Scope block to the Tamb, K signal.

The model sfcndemo_atmos looks like the figure shown.
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Atmosphere Model in Fortran
? C-MEX Calling Fortran Example

[Simulation only - no code generation suppart in this demo)

L

Altituda, km

'
Tamb, K
3,11,25] ——m+ - P =fun_atm >
L : 4 Akiude, km slun_simos Pamb, Pa
Constant T
Density, kg/m3
C-MEX Gateway Scope
/\j S-Function
| o Fortran
Sine Wave

| gateway: matlabroofitoolbox\simulink\simdemosisimfeaturesisrcFortran\sfun_atmos.c

| Foriran: matlabroofitooclboxisimulinkisimdemos!simfeatures\srcForransfun_atmos_sub.F

Double-click the target Scope block.

From the Scope mode parameter, choose Graphical rolling.
For the Number of samples parameter, enter 240.

Click Apply, then OK.

9 Double-click the Sine Wave block.

10 For the Sample time parameter, enter 0.05.

11 Click OK.

12 From the File menu, click Save as. Browse to your current working folder,
for example, xpc_fortran_test. Enter a file name. For example, enter
fortran_atmos_xpc and then click Save.

© N O O

Your next task is to compile Fortran code. See “Compiling Fortran Files” on page
3-6.
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Compiling Fortran Files

To access the files for this example, in the Command Window, type:

cd(fullfile(matlabroot, "toolbox", "simulink®, "simdemos”, . ..
"simfeatures”, "srcFortran®));

1 In the Command Window, copy the file sfun_atmos_sub.F into your Fortran
working folder, for example, xpc_Ffortran_test. This file contains Fortran code
that implements a subroutine for the Atmosphere model.

2 From Fortran_compiler _dir\lib\ia64, copy the following files to the working

folder:

+ libifcore.lib

+ libifcoremd.lib
ifconsol_lib

« libifportmd.lib
libifport.lib

« libmmd.lib

« libm_lib
libirc.lib

« libmmt_lib
libifcoremt._lib

+ svml_disp.lib

3 From a DOS prompt, change folder to the working folder and create the object file.
For example:

ifort /fpp /Qprec /c /nologo /MT /fixed /iface:cref -Ox sfun_atmos_sub.F
Your next task is to create a wrapper S-function. See “Creating a C-MEX Wrapper S-

Function” on page 3-6.

Creating a C-MEX Wrapper S-Function

This topic describes how to create a C-MEX wrapper S-function for the Fortran code

in sfun_atmos_sub.T. This function is a level 2 S-function. It incorporates existing
Fortran code into a Simulink S-function block and lets you execute Fortran code from the
Simulink software. Before you start:
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*  Compile your Fortran code. See “Compiling Fortran Files” on page 3-6.
*  Become familiar with the guidelines and calling conventions for Simulink Fortran
level 2 S-functions (see “Create Level-2 Fortran S-Functions” (Simulink)).

+ Implement the required callback functions using standard functions to access the
fields of the S-function simulation data structure,SimStruct (see “Templates for C S-
Functions” (Simulink)).

The following procedure outlines the steps to create a C-MEX wrapper S-function to work
with sfun_atmos_sub. . It uses the template file sfuntmpl_gate fortran.c.

Note: This topic describes how to create a level 2 Fortran S-function for the
fortran_atmos_xpc model. This file is also provided in sfun_atmos.c.

1  Copy the file sfuntmpl_gate_fortran.c to your working folder.

This file is the C-MEX file for calling into your Fortran subroutine. It works with a
simple Fortran subroutine.

2 With a text editor of your choice, open sfuntmpl_gate fortran.c.
3 Inspect the file.

This self-documenting file contains placeholders for standard Fortran level 2 S-
functions, such as the S-function name specification and Simulink callback methods.

4 In the #define S_FUNCTION_NAME definition, add the name of your S-function. For
example, edit the definition line to look like
#define S_FUNCTION_NAME sfun_atmos

5 In the file, read the commented documentation for fixed-step and variable-step fixed
algorithm support.

6 Delete or comment out the code for fixed-step and variable-step fixed-algorithm
support. You do not need these definitions for this example.

7 Find the line that begins extern void nameofsub_. Specify the function prototype
for the Fortran subroutine. For the sfun_atmos_sub.obj executable, the Fortran
subroutine is atmos_. Replace

extern void nameofsub_(float *sampleArgs, float *sampleOutput);

with

extern void atmos_(float *falt, float *fsigma, float *fdelta, float *ftheta);

3-7



3

Incorporating Fortran S-Functions

Enter a #if defined/#endif statement like the following for Windows" compilers.

#ifdef _WING4
#define atmos_ atmos
#endif

To specify the parameters for the block, add a typedef. For example,
typedef enum {TO_IDX=0, PO_IDX, RO_IDX, NUM_SPARAMS } paramlndices;

#define TO(S) (ssGetSFcnParam(S, TO_IDX))

#define PO(S) (ssGetSFcnParam(S, PO_IDX))

#define RO(S) (ssGetSFcnParam(S, RO_IDX))

Use the mdl InitializeSizes callback to specify the number of inputs, outputs,
states, parameters, and other characteristics of the S-function. S-function callback
methods use SimStruct functions to store and retrieve information about an S-
function. Be sure to specify the temperature, pressure, and density parameters.
For example,

static void mdlInitializeSizes(SimStruct *S)

ssSetNumSFcnParams (S, NUM_SPARAMS) ; /* expected number */
#iT defined(MATLAB_MEX_FILE)
it (ssGetNumSFcnParams(S) != ssGetSFcnParamsCount(S)) goto EXIT_POINT;
#endif

{
int iParam = 0O;
int nParam = ssGetNumSFcnParams(S);
for ( iParam = 0; iParam < nParam; iParam++ )
ssSetSFcnParamTunable( S, iParam, SS_PRM_SIM_ONLY_TUNABLE );
¥
¥

ssSetNumContStates( S, 0 );

ssSetNumDiscStates( S, 0 );
ssSetNumlnputPorts(S, 1);

ssSetlnputPortWidth(S, 0, 3);
ssSetlnputPortDirectFeedThrough(S, 0, 1);
ssSetlnputPortRequiredContiguous(S, 0, 1);
ssSetNumOutputPorts(S, 3);
ssSetOutputPortWidth(S, 0, 3); /* temperature */
ssSetOutputPortWidth(S, 1, 3); /* pressure */
ssSetOutputPortWidth(S, 2, 3); /* density */

#iT defined(MATLAB_MEX_FILE)
EXIT_POINT:
#endi T

return;
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}

10 Use the mdlInitializeSampleTimes callback to specify the sample rates at which
this S-function operates.

static void mdlInitializeSampleTimes(SimStruct *S)

{
ssSetSampleTime(S, 0, INHERITED_SAMPLE_TIME);
ssSetOffsetTime(S, 0, 0.0);
ssSetModelReferenceSampleTimeDefaultinheritance(S);
3

11 Use the mdlOutputs callback to compute the signals that this block emits.

static void mdlOutputs(SimStruct *S, Int_T tid)

{
double *alt = (double *) ssGetlnputPortSignal(S,0);
double *T = (double *) ssGetOutputPortRealSignal(S,0);
double *P = (double *) ssGetOutputPortRealSignal(S,1);
double *rho = (double *) ssGetOutputPortRealSignal(S,2);

int w
int k;
float falt, fsigma, fdelta, ftheta;

ssGetlInputPortWidth(S,0);

for (k=0; k<w; k++) {

/* set the input value */
falt = (float) alt[K];

/* call the Fortran routine using pass-by-reference */
atmos_(&falt, &fsigma, &fdelta, &ftheta);

/* format the outputs using the reference parameters */
TIK] = mxGetScalar(T0(S)) * (double) ftheta;
PLk] mxGetScalar(PO(S)) * (double) fdelta;
rho[k] mxGetScalar(RO(S)) * (double) fsigma;

+
}

12 Use the mdITerminate callback to perform the actions required at termination of

the simulation. Even if you do not require such operations, you must include a stub
for this callback.

static void mdITerminate(SimStruct *S)

{
}
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13 In the file, read the commented documentation for the following callbacks:

« mdlInitalizeConditions — Initializes the state vectors of this S-function.

+ mdlStart — Initializes the state vectors of this S-function. This function is called
once at the start of the model execution.

mdlUpdate — Updates the states of a block.

These callbacks are optional callbacks that you can define for later projects. You do
not need to specify these callbacks for this example.

14 Delete or comment out the code for these callbacks.

15 Save the file under another name. For example, save this file as sfun_atmos.c. Do
not overwrite the template file.

16 Copy the file sfun_atmos.c into your Fortran working folder, for example,
xpc_fortran_test.

Your next task is to compile and link the wrapper S-function. See “Compiling and
Linking the Wrapper S-Function” on page 3-10.

Compiling and Linking the Wrapper S-Function

This topic describes how to create (compile and link) a C-MEX S-function from the
sfun_atmos.c file. Before you start, check that you copied the following files into the
working folder, xpc_fortran_test, when you performed the steps in “Compiling
Fortran Files” on page 3-6.)

* libifcore.lib

« libifcoremd. lib

+ 1ifconsol.lib

+ libifportmd.lib

+ libifport_lib

+ libmmd.lib

« libm.lib

« libirc.lib

« libmmt.lib

+ libifcoremt.lib
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+ svml_disp.lib
Use the mex command with a C/C++ compiler such as Microsoft Visual C++ Version 6.0.

This topic assumes that you have created a C-MEX wrapper S-function. See “Creating a
C-MEX Wrapper S-Function” on page 3-6.

Invoking the mex command requires you to compile the wrapper C file sfun_atmos.c.

Be sure to link in the following:

*  Compiled Fortran code: sfun_atmos_sub.obj

*  Fortran run-time libraries to resolve external function references and provide the
Fortran run-time environment

When you are ready, mex the code. For example:

mex -v LINKFLAGS=""$LINKFLAGS /NODEFAULTLIB:libcmt.lib libifcoremd.lib

ifconsol.lib libifportmd.lib libmmd.lib libirc.lib svml_disp.lib" sfun_atmos.c
sfun_atmos_sub.obj

Note: The command and all its parameters must be on one line.

This command compiles and links the sfun_atmos_sub.c file. It creates the
sfun_atmos.mex file in the same folder.

Your next task is to validate the Fortran code and wrapper S-function. See “Validating
the Fortran Code and Wrapper S-Function” on page 3-11.

Validating the Fortran Code and Wrapper S-Function

Validate the generated C-MEX S-function, sfun_atmos.mex. Bind the C-MEX S-
function to an S-function block found in the Simulink block library. You can mask the S-
function block like other S-function blocks to give it a specific dialog box.

This topic assumes that you have compiled and linked a wrapper S-function. See
“Compiling and Linking the Wrapper S-Function” on page 3-10.

The Atmosphere model example has a Simulink model associated with it.

1 In the MATLAB window, type
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fortran_atmos_xpc
This command opens the Simulink model associated with the Atmosphere model.
This model includes an S-function block bound to sfun_atmos.mex.

2 To simulate the model, select Simulation > Run.

3 Examine the behavior of the Atmosphere model by looking at the signals traced by
the Scope block.

Your next task is to prepare the model to build a real-time application. See “Preparing
the Model for the Real-Time Application Build” on page 3-12.

Preparing the Model for the Real-Time Application Build

Before you build the Atmosphere model for Simulink Real-Time, define the following
build dependencies:

* The build procedure has access to sfun_atmos.sub.obj for the link stage.

* The build procedure has access to the Fortran run-time libraries (see “Compiling and

Linking the Wrapper S-Function” on page 3-10) for the link stage.

This topic assumes that you have validated the Fortran code and wrapper S-function (see
“Validating the Fortran Code and Wrapper S-Function” on page 3-11).

1 In the MATLAB window, type

fortran_atmos_xpc

This command opens the Simulink model associated with the Atmosphere model.

2 In the Simulink model, click Simulation > Model Configuration Parameters.

The Configuration Parameters dialog box appears.

3 In the left pane, click the Code Generation node.

The Code Generation pane opens.

4 In the Target selection section, click the Browse button at the System target file
list.

5 Clickslirt.tlc.
6 In the Make command field, replace make_rtw with one for the Fortran compiler.



Fortran Atmosphere Model

make_rtw S_FUNCTIONS_LIB="__\sfun_atmos_sub.obj ..\libifcoremt_lib ._\libmmt_lib
_-\ifconsol _lib . _\libifport_lib ._\libirc_.lib __\svml_disp.lib"

Note: The command and all its parameters must be on one line.
7 Click Apply.
8 Click OK.

9 From the File menu, click Save.

This command requires that the real-time application build folder is the current folder
(one level below the working folder, xpc_fortran_test). Therefore, all additional
dependency designations must start with . .\.

If your model (S-Function blocks) depends on more than one file, specify all Fortran
object files. For this example, you specify the run-time libraries only once.

Your next task is to build and run the real-time application. See “Building and Running
the Real-Time Application” on page 3-13 .

Building and Running the Real-Time Application

This topic assumes that you have prepared the model to build a Simulink Real-Time
application. See “Preparing the Model for the Real-Time Application Build” on page
3-12.

Build and run the real-time application as usual. Be sure that you have defined Microsoft
Visual C++ as the Simulink Real-Time C compiler using slrtsetCC.

After the build procedure succeeds, Simulink Real-Time automatically downloads the
real-time application to the target computer. The Atmosphere model already contains
a Simulink Real-Time Scope block. This block allows you to evaluate the behavior of
the model. You can compare the signals shown on the target display with the signals
obtained earlier by the Simulink simulation run (see “Validating the Fortran Code and
Wrapper S-Function” on page 3-11).
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Default Target Computers

4-2

When you start Simulink Real-Time Explorer for the first time, it opens a default node,
TargetPCL1l. You can configure this node for a target computer, then connect the node to
the target computer. If you later build a real-time application from a Simulink model, the
Simulink Real-Time software builds and downloads that application to the default target
computer.

You can add other target computer nodes and designate one of them as the default target
computer instead of the first one. To set a target computer node as the default, right-
click that node and select Set As Default Target from the context-sensitive menu. The
default target computer node is boldface.

If you delete a default target computer node, the target computer node preceding it
becomes the default target computer node. The last target computer node becomes the
default target computer node and cannot be deleted.

If you want to use the Simulink Real-Time command-line interface to work with the
target computer, you must indicate which target computer the command is interacting
with. If you do not identify a particular target computer, the Simulink Real-Time
software uses the default target computer.

TheSimul inkReal Time target computer environment, manages collective and
individual target computer environments. See “Command-Line Setup” on page 4-5.

When you call SimulinkReal Time.getTargetSettings without arguments (for
example, env = SimulinkRealTime.getTargetSettings), the constructor gets the
target environment settings for the default target computer.

When you call slrt without arguments (for example, tg = slrt), the constructor
uses the link properties of the default target computer to communicate with the target
computer.
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Command-Line C Compiler Configuration

To configure the development computer for the C compiler using MATLAB language, use
this procedure.

The command mex -setup sets the default compiler for Simulink Real-Time builds,
provided the MEX compiler is a supported Microsoft compiler. Use slrtsetCC -setup
only if you require different compilers for MEX and Simulink Real-Time.

Note: By default, the Microsoft Visual Studio® 2015 installer does not install the C+
+ compiler that Simulink Real-Time requires. To install the C++ compiler, perform a
custom install and select the C++ compiler. If you already installed Microsoft Visual
Studio with the default configuration, rerun the installer and choose the modify option.

1 Install a supported C compiler on the development computer.

For more about the Simulink Real-Time C compiler requirements, see
www . mathworks.com/support/compilers/current_release.

2 Inthe Command Window, type:

slrtsetCC setup

The function queries the development computer for C compilers that the Simulink
Real-Time environment supports. It returns output like the following:
Select your compiler for Simulink Real-Time.
[1] Microsoft Visual C++ Compilers 2008 Professional Edition (SP1l) in
c:\Program Files (x86)\Microsoft Visual Studio 9.0
[2] Microsoft Visual C++ Compilers 2010 Professional in
C:\Program Files (x86)\Microsoft Visual Studio 10.0
[0] None

Compiler:

3 At the Compi ler prompt, enter the number for the compiler that you want to use.
For example, 2.

The function verifies that you have selected the required compiler:
Verify your selection:

Compiler: Microsoft Visual C++ Compilers 2010 Professional


https://www.mathworks.com/support/compilers/current_release/
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Location: C:\Program Files (x86)\Microsoft Visual Studio 10.0

Are these correct [y]/n?

4 Typey or press Enter.
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Command-Line Setup

Use the following procedures to configure single- and multiple-target systems.

You must have installed and configured a C compiler and verified the target computer
BIOS settings. If not, see:

+ “Command-Line C Compiler Configuration” on page 4-3.
“BIOS Settings”

1  “Command-Line PCI Bus Ethernet Setup” on page 4-6 or “Command-Line USB-
to-Ethernet Setup” on page 4-9

2 “Command-Line Target Computer Settings” on page 4-18
3 “Command-Line Target Computer Boot Methods” on page 4-21

The next task is “Run Confidence Test on Configuration”.
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Command-Line PCl Bus Ethernet Setup

If your target computer has a PCI bus, use an Ethernet card for the PCI bus. The PCI
bus has a faster data transfer rate than the other bus types.

In this section...

“PCI Bus Ethernet Protocol Hardware” on page 4-6
“Command-Line PCI Bus Ethernet Settings” on page 4-7

PCI Bus Ethernet Protocol Hardware

Development Target
computer computer
network
card
—

Ethernet link

To install PCI bus Ethernet protocol interface hardware:

1  Acquire a supported PCI bus Ethernet card.

If you want to start the target computer from the network, check that the Ethernet
adapter is compatible with the Preboot eXecution Environment (PXE) specification.
Turn off your target computer.

If the target computer already has an unsupported Ethernet card, remove the card.

Plug the supported Ethernet card into a free PCI bus slot.

O b WD

Assign a static IP address to the target computer Ethernet card.

Unlike the target computer, the development computer network adapter card can
have a dynamic host configuration protocol (DHCP) address and can be accessed
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from the network. Configure the DHCP server to reserve static IP addresses to
prevent these addresses from being assigned to other systems.

Connect your target computer Ethernet card to your LAN using an unshielded
twisted-pair (UTP) cable.

You can directly connect your computers using a crossover UTP cable with RJ45
connectors. Both computers must have static IP addresses. If the development
computer has a second network adapter card, that card can have a DHCP address.

Command-Line PCl Bus Ethernet Settings

After you install the PCI bus Ethernet card, to build and download a real-time
application, first specify the environment properties for the development and target
computers.

Before you start, ask your system administrator for the following information for your
target computer:

IP address
Subnet mask address
Port number (optional)

Gateway (optional)

Use the following procedure for target TargetPC1:

1

At the MATLAB prompt, create an environment object for this target computer and
make it the default target:

env = SimulinkRealTime.addTarget("TargetPCl");
setAsDefaultTarget(env);

You make all other settings to this object.
Set the IP address for your target computer. For example:

env.TcplpTargetAddress = "10.10.10.15";
Set the subnet mask address of your LAN. For example:

env.TcplpSubNetMask = "255.255.255.0%;

Set the TCP/IP port (optional) to a value higher than "20000" and less than
"65536". For example:
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env.TcplpTargetPort = "22222%;

This property is set by default to "22222", a value higher than the reserved area
(telnet, Ftp, and so on).

Set the TCP/IP gateway (optional) to the gateway required to access the target
computer. For example:

env._TcplpGateway = "255.255.255.255%;

This property is set by default to "255.255.255.255", which means that you do
not use a gateway to connect to your target computer. If you connect your computers
with a crossover cable, leave this property as "255.255.255.255".

If you communicate with the target computer from within your LAN, do not change
the default setting. If you communicate from a development computer within a LAN
different from your target computer, define a gateway and enter its IP address here.
In particular, create a gateway if you access the target computer via the internet.

Set the bus type to "PCI ".

env.TcplpTargetBusType = "PCI";

Set the target driver to one of " 18254x", " 182559", "R8139", "R8168", or "Auto”
(the default).

env.TcplpTargetDriver = "Auto”;

For target driver "Auto”, the software determines the target computer TCP/IP
driver from the card installed on the target computer. If no supported Ethernet card
is installed in your target computer, the software returns an error.

If the target computer has multiple Ethernet cards, follow the procedure in
“Command-Line Ethernet Card Selection by Index” on page 4-15.

Repeat this procedure as required for each target computer.

The next task is “Command-Line Target Computer Settings” on page 4-18.
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Command-Line USB-to-Ethernet Setup

If the target computer has a USB 2.0 port but no supported PCI Ethernet card, use a
USB-to-Ethernet adapter.

In this section...
“USB-to-Ethernet Protocol Hardware” on page 4-9
“Command-Line USB-to-Ethernet Settings” on page 4-11

USB-to-Ethernet Protocol Hardware

You can plug the USB-to-Ethernet adapter into the development computer or the target
computer. The setup is slightly different for each location.

Development Computer USB Port

.

Target
computer

Ethernet link

Development
computer

USE-to-Ethernet
adapter

To connect the USB-to-Ethernet protocol interface hardware to the USB port on the
development computer:

1 Acquire a supported USB-to-Ethernet adapter.

If you want to start the target computer from the network, check that the Ethernet
adapter is compatible with the Preboot eXecution Environment (PXE) specification.

2 Plug the USB-to-Ethernet adapter into the USB port in the development computer.

Do not connect the development computer USB port to a target computer USB port
using a plain USB cable. A USB-to-Ethernet adapter plugged into the development
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computer USB port behaves like an Ethernet card installed in the development
computer.

3 Connect the USB-to-Ethernet adapter from your development computer to your LAN
using an unshielded twisted-pair (UTP) cable.

4  Connect the target computer Ethernet card to your LAN using another UTP cable.

You can directly connect your computers using a crossover UTP cable with RJ45
connectors. Both computers must have static IP addresses. If the development
computer has a second network adapter, that adapter can have a DHCP address.

Target Computer USB Port

Development
computer

Ethernet link

Target
computer

USE-to-Ethernet
adapter

To connect the USB-to-Ethernet protocol interface hardware to the USB port on the
target computer:

Acquire a supported USB-to-Ethernet adapter.
2  Turn off your target computer.

3 Prepare a boot drive according to the instructions in “Target Computer Boot
Methods”.

You cannot use the network boot method with this hardware configuration.
4  Plug the USB-to-Ethernet adapter into the USB port in the target.
Do not connect the development computer USB port to the target computer USB

port using a plain USB cable. A USB-to-Ethernet adapter plugged into the target
computer USB port behaves like an Ethernet card installed on the target computer.
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Connect the USB-to-Ethernet adapter to your LAN using an unshielded twisted-pair
(UTP) cable.

Assign a static IP address to the target computer USB-to-Ethernet adapter.

Unlike the target computer, the development computer network adapter card can
have a dynamic host configuration protocol (DHCP) address and can be accessed
from the network. Configure the DHCP server to reserve static IP addresses to
prevent these addresses from being assigned to other systems.

Connect your development computer Ethernet card to your LAN using an unshielded
twisted-pair (UTP) cable.

You can directly connect your computers using a crossover UTP cable with RJ45
connectors. Both computers must have static IP addresses. If the development
computer has a second network adapter, that adapter can have a DHCP address.

Command-Line USB-to-Ethernet Settings

After you have installed the USB-to-Ethernet adapter, to build and download a real-
time application, first specify the environment properties for the development and target
computers.

Before you start, ask your system administrator for the following information for your
target computer:

IP address
Subnet mask address
Port number (optional)

Gateway (optional)

Use the following procedure for target TargetPC1:

1

At the MATLAB prompt, create an environment object for this target computer and
make it the default target:

env = SimulinkRealTime.addTarget("TargetPCl");
setAsDefaultTarget(env);

You make all other settings to this object.

Set the IP address for your target computer. For example:
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env._TcplpTargetAddress = "10.10.10.15%;
3 Set the subnet mask address of your LAN. For example:

env._TcplpSubNetMask = "255.255.255.0%;
4  Set the TCP/IP port (optional) to a value higher than "20000" and less than
"65536". For example:

env.TcplpTargetPort = "22222";
This property is set by default to "22222", a value higher than the reserved area
(telnet, ftp, and so on).

5 Set the TCP/IP gateway (optional) to the gateway required to access the target

computer. For example:

env._TcplpGateway = "255.255_255.255" ;

This property is set by default to "255.255.255.255", which means that you do
not use a gateway to connect to your target computer. If you connect your computers
with a crossover cable, leave this property as "255.255.255.255".

If you communicate with the target computer from within your LAN, do not change
the default setting. If you communicate from a development computer within a LAN
different from your target computer, define a gateway and enter its IP address here.
In particular, create a gateway if you access the target computer via the internet.

6 Set the bus type to "USB".

env._.TcplpTargetBusType = "USB";
7 Set the target driver to one of "USBAX772", "USBAX172", or "Auto”.

env._TcplpTargetDriver = “Auto”;

If the target driver is "Auto”, the software sets the driver to "USBAX772", the
driver most commonly used.

Repeat this procedure as required for each target computer.

The next task is “Command-Line Target Computer Settings” on page 4-18.
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Ethernet Card Selection by Index

If the target computer has multiple Ethernet cards, you must specify which card to use
for the Ethernet link. Use the following procedure to discover the Ethernet index of the
PCI cards on the target computer and to specify which card to use.

Note: For this procedure, you must be able to burn CDs on your development computer
and use Network boot mode for routine target operations.

Use the following procedure for target TargetPC1.:

1

o O bW

At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings("TargetPC1");
setAsDefaultTarget(env);

You make all other settings to this object.

At the MATLAB prompt, type:

env.ShowHardware = "on";

With ShowHardware set, after the kernel starts, the development computer cannot
communicate with the target computer. When you have gathered your information,
to resume normal functionality, set this property to "oFFf", recreate the boot image,
and restart the target computer.

At the MATLAB prompt, type: slrtexplr.

In the Targets pane, expand the target computer node.

In the toolbar, click the Target Properties button .

Select Host-to-Target communication and set Target driver to Auto. If you set
Target driver to a specific driver, such as INTEL 182559, the kernel displays only
information about boards that use that driver.

Select Target settings and clear the Graphics mode check box. This setting
causes the kernel to print text only.

Select Boot configuration and set Boot mode to CD.

To create a boot disk, click Create boot disk and follow the prompts.
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10 Insert the new boot disk and restart the target computer from the target computer
boot switch.

After the start is complete, the target monitor displays information about the
Ethernet cards in the target computer, for example:

index: O, driver: R8139, Bus: 16, Slot: 8, Func: O
index: 1, driver: 182559, Bus: 16, Slot: 9, Func: O

Check that the boot order allows you to start the target computer from your disk.
You can change the boot order from the target computer BIOS. After the kernel
starts with ShowHardware "on", the development computer cannot communicate
with the target computer.

11 Note the index of the Ethernet card that you want to use for the Ethernet link, for
example, 2.

12 At the MATLAB prompt, type:

env.ShowHardware = "off";

env.Ethernetlndex = "#%;

# is the index of the Ethernet card, for example, 2.
13 Select Target settings and select the Graphics mode check box.
14 Set Boot mode to Network.
15 Click Create boot disk.

16 Remove the boot disk from the target computer drive and start the target computer
from the target computer boot switch.

The kernel selects the specified Ethernet card as the target computer card, instead of
the default card with index number O.

Repeat this procedure as required for each target computer.
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Command-Line Ethernet Card Selection by Index

If you are using multiple target computers that have multiple Ethernet cards, you must
specify which card to use for the Ethernet link. Use the following procedure to discover
the Ethernet index of the PCI cards on a specific target and specify which card to use.

Note: For this procedure, you must be able to burn CDs on your development computer
and use network boot mode for routine target operations.

Use the following procedure for target TargetPC1.:

1

At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings("TargetPC1");
setAsDefaultTarget(env);

You make all other settings to this object.

At the MATLAB prompt, type:

env.ShowHardware = “on";

With ShowHardware set, after the kernel starts, the development computer cannot
communicate with the target computer. When you have gathered your information,
to resume normal functionality, set this property to "ofFf", recreate the boot image,
and restart the target computer.

Set the Ethernet driver to the default:

env._TcplpTargetDriver = “Auto”;

If TecplpTargetDriver is set to a specific driver, such as "182559", the kernel
displays only information about boards that use that driver.

Set the boot method to CD/DVD boot:

env.TargetBoot="CDBoot";

Set the target monitor to print text only:

env.TargetScope = "Disabled” ;
Type SimulinkReal Time.createBootlImage.
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10

11

12
13

The Simulink Real-Time software displays the following message and creates the
CD/DVD boot image.

Current boot mode: CDBoot
CD boot image is successfully created

Insert an empty CD/DVD. Available drives:
[1] d:\
[0] Cancel Burn

Insert the new boot disk and restart the target computer from the target computer
boot switch.

After the start is complete, the target monitor displays information about the
Ethernet cards in the target computer, for example:

index: O, driver: R8139, Bus: 16, Slot: 8, Func: O
index: 1, driver: 182559, Bus: 16, Slot: 9, Func: O

Check that the boot order allows you to start the target computer from your disk.
You can change the boot order from the target computer BIOS. After the kernel
starts with ShowHardware "on", the development computer cannot communicate
with the target computer.

Note the index of the Ethernet card you want to use for the Ethernet link, for
example, 2.

At the MATLAB prompt, type:

env.ShowHardware = “off";

env.Ethernetlndex = "#%;

# is the index of the Ethernet card, for example, 2.
Set the boot method back to network boot:

env.TargetBoot= "NetworkBoot";

Set the target monitor to graphics mode:

env.TargetScope = "Enabled” ;
Type SimulinkReal Time.createBootlImage.

Start the target computer from the target computer boot switch.
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The kernel selects the specified Ethernet card as the target computer card, instead of
the default card with index number O.

Repeat this procedure as required for each target computer.
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Command-Line Target Computer Settings
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To run a Simulink Real-Time model on a target computer, you must configure the target
settings to match the capabilities of the target computer.

Note:

The NonPentiumSupport property has ceased to function. Use a target computer
with an Intel® Pentium or AMD®™ K5/K6/Athlon processor.

In R2017b, the property Secondary IDE will be removed from the product. The
Secondary IDE option has been removed from Simulink Real-Time Explorer. Install
a SATA hard drive in the target computer.

In R2017b, the MulticoreSupport target setting will be read-only and set to "on*®.
The Multicore CPU check box will be removed from Simulink Real-Time Explorer.

In R2017b, the property MaxModelSize will be removed. The property has ceased
to function. The Model Size option has been removed from Simulink Real-Time
Explorer.

The RAM size check box has been removed from Simulink Real-Time Explorer. The
property value TargetRAMSizeMB continues to function.

Use the following procedure for target TargetPC1:

1

At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings("TargetPC1");
setAsDefaultTarget(env);

You make all other settings to this object.

Assign the following target computer settings as required:
Target scope display

+ env.TargetScope="Enabled” (the default) — Use to display information,
such as a target scope, in graphic format.

+ env.TargetScope="Disabled” — Use to display information as text.
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To use the full features of a target scope, install a keyboard on the target
computer.

USB support

* env.USBSupport="on" (the default) — Use to enable USB ports on the
target computer; for example, to connect a USB keyboard.

* env.USBSupport="off" — Otherwise.

Secondary IDE support

* env.SecondarylIDE="on" — Use only to access the disks connected to a
secondary IDE controller.

+ env.SecondarylIDE="0off" (the default) — Otherwise.

Multicore support

env.MulticoreSupport="on" (the default) — Use to access multicore
processors on the target computer.

env.MulticoreSupport="off" — Otherwise.
Target RAM size

env.TargetRAMSizeMB="Auto" (the default) — Use to read the target
computer BIOS and determine the amount of memory installed in the target
computer.

env.TargetRAMSizeMB="xxx" — Use if the real-time application cannot read
the BIOS. Assign the amount of memory, in megabytes, installed in the target
computer.

The Target RAM size parameter defines the total amount of installed RAM in
the target computer. This memory is the memory that is available for the kernel,
real-time application, data logging, and other functions that use the heap.

Target computer memory for the real-time application executable, the kernel, and
other uses is limited to a maximum of 4 GB.

Maximum model size

env.MaxModelSize="1MB" (the default) — Use to specify that the real-time
application requires at most this much memory on the target computer.

4-19



4 Real-Time Application Environment

env.MaxModelSize="4MB" — For a medium-sized model.
env.MaxModelSize="16MB" — For a large-sized model.

Setting Maximum model size takes effect for
env.TargetBoot="StandAlone" only.

Memory not used by the real-time application is used by the kernel and by the
heap for data logging. Selecting too high a value leaves less memory for data
logging. Selecting too low a value does not reserve enough memory for the real-
time application and creates an error. You can approximate the size of the real-
time application by the size of the DLM file produced by the build process.

Repeat this procedure as required for each target computer.

The next task is “Command-Line Target Computer Boot Methods” on page 4-21.
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Command-Line Target Computer Boot Methods

You can start your target computer with the Simulink Real-Time kernel using one of
several methods.

Speedgoat systems come with DOS Loader software preinstalled. You can set up the DOS
Loader boot method on your development computer or configure another boot method.
See your Speedgoat system documentation or follow the link from “Speedgoat Real-Time
Target Machines” for further information.

1  Before creating a boot kernel, perform “Command-Line Kernel Creation Prechecks”
on page 4-22.
2 Select one of the following methods:

* “Command-Line Network Boot Method” on page 4-23

+ “Command-Line CD/DVD Boot Method” on page 4-25
“Command-Line DOS Loader Boot Method” on page 4-26

+ “Command-Line Removable Disk Boot Method” on page 4-28

+ “Command-Line Standalone Boot Method” on page 4-30

3  For boot methods other than StandAlone, perform “Run Confidence Test on
Configuration”.

For boot method StandAlone, create a model-specific confidence test, restart the
target computer, and run that confidence test. The default confidence test is not
intended for standalone execution.
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Command-Line Kernel Creation Prechecks

4-22

Before creating the target boot kernel, configure your Simulink Real-Time system. At a
minimum, do the following:

1

w

5

6

Check the physical connections between the development computer and the target
computer. These Ethernet connections can pass through a LAN.

Check your target computer BIOS settings (see “BIOS Settings”).

Check that you have write permission for your current working folder.

At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings("TargetPC1");
setAsDefaultTarget(env);

The contents of environment object env are printed in the Command Window.

Check the link settings. See “Command-Line PCI Bus Ethernet Setup” on page 4-6
or “Command-Line USB-to-Ethernet Setup” on page 4-9.

Check that TargetBoot is set to the required value.

Repeat this procedure as required for each target computer.
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Command-Line Network Boot Method

After you have configured the target computer environment parameters, you can use a
dedicated Ethernet network to load and run the Simulink Real-Time kernel. You do not
need a boot CD or removable boot drive.

There are the following limitations:

Do not use the network boot method on a corporate or nondedicated network. Doing
so can interfere with dynamic host configuration protocol (DHCP) servers and cause
problems with the network.

Your Ethernet card must be compatible with the Preboot eXecution Environment
(PXE) specification.

If Stand Alone mode is enabled, you cannot start the target computer across the
network.

Before you start, establish the required Ethernet connection between development and
target computers using the procedures in “Command-Line PCI Bus Ethernet Setup” on
page 4-6 or “Command-Line USB-to-Ethernet Setup” on page 4-9.

Use the following procedure for target TargetPC1:

1

At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings( " TargetPCl");
setAsDefaultTarget(env);

The contents of environment object env are printed in the Command Window. Some
properties can already have the required values.

Set network boot method:

env.TargetBoot="NetworkBoot"

Set a TCP/IP address. Check that the subnet of this IP address is the same as the
development computer. Otherwise your network boot fails. For example, type:

env._TcplpTargetAddress="10.10.10.11"
Set the target computer MAC address (in hexadecimal). For example, type:

env._TargetMACAddress="01:23:45:67:89:ab"
In the Command Window, type:
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SimulinkRealTime.createBootlmage

The following message appears:

Current boot mode: NetworkBoot

Synchronizing network boot table...._ok
Starting network boot server....ok
Creating batch file (slrtnetboot.bat)....ok

Network boot image created successfully

The software creates and starts a network boot server process on the development
computer. You start the target computer using this process.

A minimized icon (!) representing the network boot server process appears on the
bottom right of the development computer system tray.

Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line CD/DVD Boot Method

After you have configured the target computer environment parameters, you can use
a target boot CD or DVD to load and run the Simulink Real-Time kernel. This topic
describes using the MATLAB command line to create a boot CD or DVD for a single
target computer system.

Use the following procedure for target TargetPC1:

1

N O 0

At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings( "TargetPCl1");
setAsDefaultTarget(env);

You make all other settings to this object.

Set the CD boot method:

env.TargetBoot="CDBoot"
In the Command Window, type Simul inkReal Time.createBootlImage.

The Simulink Real-Time software displays the following message and creates the
CD/DVD boot image.

Current boot mode: CDBoot
CD boot image is successfully created

Insert an empty CD/DVD. Available drives:
[1] d:\
[0] Cancel Burn

Insert the empty CD or DVD in the development computer.
Type 1 and then press Enter.
When the write operation has finished, remove the CD or DVD from the drive.

Insert the bootable CD/DVD into your target computer drive and restart the target
computer.

Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line DOS Loader Boot Method

4-26

In DOS Loader mode, you start the Simulink Real-Time kernel on a target computer
from a fixed or removable device with DOS boot capability. Examples include a hard
disk or a flash memory stick. After starting the target computer, you can download your
real-time application from the development computer over an Ethernet link between the
development and target computers.

To run in DOS Loader mode, the target computer boot device must provide a minimal
DOS environment complying with certain restrictions. For details, see:

+ “Create a DOS System Disk”

+ “DOS Loader Mode Restrictions”

Use the following procedure for target TargetPC1.:

1 At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings("TargetPC1");
setAsDefaultTarget(env);
You make all other settings to this object.

2 Set the DOS Loader boot method:

env._TargetBoot = "DOSLoader”;

3 Set DOSLoaderLocation to the folder where you want to create the DOS Loader
boot files. This location can be a local folder on the development computer or a
removable storage device that you use to start the target computer. By default, the
folder is the current working folder.
env._DOSLoaderLocation = "D:\";

4 Inthe Command Window, type Simul inkReal Time.createBootlImage.

The Simulink Real-Time software displays the following message:

Current boot mode: DOSLoader
Simulink Real-Time DOS Loader files are successfully created

This operation creates the following boot files in the specified location:
autoexec.bat
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Xpchboot.com
*_rtb

5 If you create boot files on a local hard disk, copy these files to a floppy disk, CD/DVD,
or other removable storage media.

6 Transfer the boot files to your target computer or insert the removable media
containing the boot files into the target computer drive or USB port.

7 Check that autoexec.bat file is on the DOS boot path (typically the root folder).
Select the required boot device in the BIOS of the target computer.

[}

9 Start the target computer.

When the target computer starts, it loads DOS, which executes the autoexec.bat
file. This file starts the Simulink Real-Time kernel (*.rtb). The target computer then
awaits commands from the development computer.

Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line Removable Disk Boot Method

4-28

After you have configured the target computer environment parameters, use a removable
drive or USB flash drive to load and run the Simulink Real-Time kernel. This topic
describes using the MATLAB command line to create a removable boot disk.

If you are creating a removable boot drive from a USB flash drive, before performing this
procedure, create a bootable partition on the drive. See “Create a Bootable Partition”.

Use the following procedure for target TargetPC1.:

1 At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings("TargetPCl1");
setAsDefaultTarget(env);

You make all other settings to this object.

2 In the output of the setAsDefaultTarget command, check that property
TargetBoot is BootFloppy.

You can update property TargetBoot by using the command
env.TargetBoot="BootFloppy".

3 If you are creating a removable boot disk from a USB drive, insert the USB drive in
the development computer USB port. Wait for it to be recognized.

4 In the Command Window, type Simul inkReal Time.createBootlImage.

The Simulink Real-Time software creates the CD/DVD boot image and displays the
following message:

Current boot mode: BootFloppy
Insert a formatted floppy disk into your host PC"s
disk drive and press a key to continue

5 Insert an empty removable disk in the development computer drive and then press a
key.

6 When the write operation has finished, remove the removable disk from the drive or
USB port.

7 Insert the removable boot disk into your target computer drive or USB port and
restart the target computer.
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Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line Standalone Boot Method

4-30

Using the MATLAB command line, you can configure the Simulink Real-Time software
to run as a standalone real-time application. For information on Boot mode Stand
Alone, see “Standalone Mode”.

To run in Stand Alone mode, the target computer and its DOS environment must meet
specific requirements and restrictions.

In this section...

“Target Computer Requirements” on page 4-30
“DOS Environment Restrictions” on page 4-31
“Command-Line Standalone Settings” on page 4-31

“Real-Time Application Build” on page 4-32

“Real-Time Application Transfer and Boot Configuration” on page 4-33

Target Computer Requirements
To run in Stand Alone mode, the target computer must meet specific requirements.

In Stand Alone mode, the real-time application and the kernel are available on a hard
drive or flash memory. The kernel and real-time application start together on the target
computer. The development computer can be disconnected from the target computer, but
the target computer must be able to start from DOS.

For each target computer, check that the system meets the following requirements:

The target computer must be equipped with a bootable drive, such as a serial ATA
(SATA) drive or a flash drive.

* The target computer must not cable select the boot drive.
* The target computer BIOS must be able to detect the boot drive.

*  The boot drive must be formatted with one of these file systems:

+ FAT-12
+ FAT-16
+ FAT-32
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+ Install a supported version of DOS on the boot drive. You can create a standard DOS
boot device from a CD ROM, 3.5—inch floppy drive, flash drive, or hard drive. See
“Create a DOS System Disk”.

+ Configure the Ethernet link. This communication transfers the kernel and real-time
application files built on the development computer to the target computer.

DOS Environment Restrictions

To use Stand Alone mode, the target computer DOS environment must comply with the

following restrictions:

+ The CPU must execute in real mode.

*  While loaded in memory, the DOS partition must not overlap the address range of a
real-time application.

To satisfy these restrictions:

* Avoid additional memory managers, such as emm386 or gemm.

+ Avoid utilities that attempt to load in high memory (for example, himem.sys).

* Avoid including memory manager entries in the autoexec.bat file.

* Avoid using a config.sys file.

If you want to use real-time Scope blocks to display or record output, there are additional
restrictions:

+ Use only Target or File type blocks.

+ Select the Start scope when application starts check box in the block parameters
dialog box.

Command-Line Standalone Settings

Use the command line to set the kernel environment properties. When you are done, you
can create a standalone kernel combined with your real-time application.

For Boot mode Stand Alone, you do not create a Simulink Real-Time boot disk or
network boot image. Instead, you copy files created from the build process to the target
computer hard drive.

Use the following procedure for target TargetPC1:
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At the MATLAB prompt, get the environment object for this target computer and
make it the default target:

env = SimulinkRealTime.getTargetSettings( " TargetPCl1");
setAsDefaultTarget(env);

You make all other settings to this object.
Set network boot method:

env.TargetBoot="StandAlone";

Repeat this procedure as required for each target computer.

Real-Time Application Build

After you set Simulink Real-Time boot mode to Stand Alone, you can use Simulink
Real-Time, Simulink Coder, and a C/C++ compiler in Stand Alone mode to build a
standalone kernel and real-time application with utility files.

1

In the Command Window, open your Simulink model, for example,
ex_slrt_rt_osc (matlab: open_system(docpath(fullfile(docroot,
"toolbox", "xpc®", "examples®, "ex_slrt_rt_osc")))). Simulink Editor
opens displaying the model.

From the Code menu, click C/C++ Code > Build Model.

The Simulink Coder and Simulink Real-Time software create a folder,
ex_slrt_rt_osc_slrt_emb, containing the following files:

+ autoexec.bat — Contains Simulink Real-Time-specific code that calls the
Xpcboot.com executable to start the Simulink Real-Time kernel (the *. rtb file).

xpcboot.com — Loads and executes the *.rtb file. This static file is part of the
Simulink Real-Time software.

slrtkrnl .rtb — Contains the Simulink Real-Time standalone kernel. This
image also contains applicable options, such as the IP address of the target
computer.

+ ex_slrt_rt_osc.mldatx — Contains the real-time application and application-
specific data.

You do not need a config.sys file to start the kernel using autoexec.bat and
Xpcboot.com.
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Repeat this procedure as required for each real-time application.

Real-Time Application Transfer and Boot Configuration

After building the kernel and real-time application on a development computer, transfer
the files to a target computer by using the Simul inkReal Time. fileSystem functions.
Configure the target computer to run the real-time application upon startup.

For this procedure, your target computer must support network boot mode. If it does not
support network boot mode, see “Application Transfer and Boot Configuration with Flash
Drive”.

1

Restart the target computer in DOS mode and open the DOS prompt.

If the target computer was previously started from the network boot image, to
disable the network boot capability, kill the boot server from Windows Task
Manager.

At the DOS prompt, save a copy of the target computer C:\autoexec.bat file to a
backup file, such as C:\autoexec_back.wrk.

Start the target computer by using network boot mode.

In the Command Window, change to the folder that contains the kernel and real-
time application files.

Copy these files to the root folder of the target computer C:\ drive:
tg = slrt;

SimulinkRealTime.copyFileToTarget(tg, "autoexec.bat®)
SimulinkRealTime.copyFileToTarget(tg, "xpcbhoot.com®)

SimulinkRealTime.copyFileToTarget(tg, “slrtkrnl_rtb®)
SimulinkRealTime.copyFileToTarget(tg, "ex_slrt_rt_osc.mldatx®)

Restart the target computer.

To boot the kernel and start the real-time application, the target computer executes
the following sequence of calls:

a C:\autoexec.bat

b C:\xpcboot.com

C:\slrtkrnl.rtb

C:\<application>.mldatx

[« I o)
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Repeat this procedure for each target computer that you start in Stand Alone mode.

Continue by testing a real-time application in Stand Alone mode.
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Changing parameters in your real-time application while it is running, viewing the
resulting signal data, and checking the results, are important prototyping tasks. The
Simulink Real-Time software includes command-line and graphical user interfaces to
complete these tasks.

“Signal Monitoring Basics” on page 5-4

“Monitor Signals with Simulink Real-Time Explorer” on page 5-5
“Monitor Signals with MATLAB Language” on page 5-8

“Instrument a Stateflow Subsystem” on page 5-10

“Signal Group Monitoring Formats” on page 5-15

“Monitor Stateflow States with MATLAB Language” on page 5-16
“Animate Stateflow Charts with Simulink External Mode” on page 5-17
“Signal Tracing Basics” on page 5-19

“Simulink Real-Time Scope Usage” on page 5-20

“Target Scope Usage” on page 5-22

“Configure Real-Time Target Scope Blocks” on page 5-24

“Create Target Scopes with Simulink Real-Time Explorer” on page 5-30
“Configure Scope Sampling with Simulink Real-Time Explorer” on page 5-35
“Trigger Scopes with Simulink Real-Time Explorer” on page 5-38
“Configure Target Scopes with Simulink Real-Time Explorer” on page 5-49
“Configure Target Scopes with MATLAB Language” on page 5-53
“Create Signal Groups with Simulink Real-Time Explorer” on page 5-56
“Host Scope Usage” on page 5-59

“Configure Real-Time Host Scope Blocks” on page 5-60

“Create Host Scopes with Simulink Real-Time Explorer” on page 5-64
“Configure the Host Scope Viewer” on page 5-69
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“Trace Signals with Simulink External Mode” on page 5-71

“Inspect Simulink® Real-Time™ Signals with Simulation Data Inspector” on page
5-74

“External Mode Usage” on page 5-77

“Signal Logging Basics” on page 5-78

“File Scope Usage” on page 5-79

“Configure Real-Time File Scope Blocks” on page 5-82

“Create File Scopes with Simulink Real-Time Explorer” on page 5-87
“Configure File Scopes with Simulink Real-Time Explorer” on page 5-91
“Log Signal Data into Multiple Files” on page 5-95

“Log Signal Data with Outport Blocks and Simulink Real-Time Explorer” on page
5-99

“Log Signal Data with Outport Block and MATLAB Language” on page 5-105
“Signal Logging Buffer Size” on page 5-112

“Configure File Scopes with MATLAB Language” on page 5-113

“Tune Parameters with Simulink Real-Time Explorer” on page 5-117

“Create Parameter Groups with Simulink Real-Time Explorer” on page 5-123
“Tune Parameters with MATLAB Language” on page 5-126

“Tune Parameters with Simulink External Mode” on page 5-129

“Save and Reload Parameters with MATLAB Language” on page 5-131
“Tunable Block Parameters and MATLAB Variables” on page 5-134

“Tune Inlined Parameters with Simulink Real-Time Explorer” on page 5-137
“Tune Inlined Parameters with MATLAB Language” on page 5-143

“Tune Parameter Structures with Simulink Real-Time Explorer” on page 5-145
“Tune Parameter Structures with MATLAB Language” on page 5-151
“Define and Update Inport Data” on page 5-155

“Define and Update Inport Data with MATLAB Language” on page 5-161
“Inport Data Mapping Limitations” on page 5-166

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
“Nonobservable Signals” on page 5-172

“Nonobservable Parameters” on page 5-174
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*  “Internationalization Issues” on page 5-175
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Signal Monitoring Basics

5-4

Signal monitoring acquires real-time signal data without time information during real-
time application execution. There is minimal additional load on the real-time tasks. Use
signal monitoring to acquire signal data without creating scopes that run on the target
computer.

In addition to signal monitoring, Simulink Real-Time enables you to monitor Stateflow™
states as test points through the Simulink Real-Time Explorer and MATLAB command-
line interfaces. You designate data or a state in a Stateflow diagram as a test point,
making it observable during execution. You can work with Stateflow states as you do
with Simulink Real-Time signals, such as monitoring or plotting Stateflow states.

When you monitor signals from referenced models, first set the test point for the signal in
the referenced model.

Note:

+ Simulink Real-Time Explorer works with multidimensional signals in column-major
format.

*  Some signals are not observable.

You can monitor signals using Simulink Real-Time Explorer and MATLAB language.
You can monitor Stateflow states using Simulink Real-Time Explorer, MATLAB
language, and Simulink external mode.

More About

. “Nonobservable Signals” on page 5-172

. “Simulink Real-Time Scope Usage” on page 5-20
. “Target Scope Usage” on page 5-22

. “Host Scope Usage” on page 5-59

. “File Scope Usage” on page 5-79

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Monitor Signals with Simulink Real-Time Explorer

This procedure uses the model xpcosc. You must have already completed the following

setup:

1 Built and downloaded the real-time application to the target computer using
Simulink (85 on the toolbar).

2 Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).
Connected to the target computer in the Targets pane (5! on the toolbar).

4 Set property Stop time to infin the Applications pane ((_;’;} on the toolbar).

To monitor a signal:

1

In Simulink Real-Time Explorer, expand the Model Hierarchy node under the real-
time application node.

To view the signals in the real-time application, select the model node. On the
toolbar, click the View Signals button 4. The Signals workspace opens.

To view the value of a signal, in the Signals workspace, select the Monitor check
box for the signal. For instance, select the check boxes for Signal Generator and
Integratorl. The signal values are shown in the Monitoring Value column.

To start execution, click the real-time application. On the toolbar, click the Start

button &

To stop execution, click the real-time application. On the toolbar, click the Stop
button M.

The Application Properties and Signals workspaces look like this figure.
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To make both workspaces visible at the same time, drag one workspace tab down until

the

icon appears in the middle of the dialog box. Continue to drag the workspace until
the cursor reaches the required quadrant, and then release the mouse button.

To save your Simulink Real-Time Explorer layout, click File > Save Layout. In a later
session, you can click File > Restore Layout to restore your layout.
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More About

“Create Signal Groups with Simulink Real-Time Explorer” on page 5-56

“Display and Filter Hierarchical Signals and Parameters” on page 5-167

“Signal Group Monitoring Formats” on page 5-15
“Nonobservable Signals” on page 5-172
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Monitor Signals with MATLAB Language

This procedure uses the model ex_slrt_rt_osc (matlab:
open_system(docpath(fullfile(docroot, “toolbox®, "xpc®, "examples-®,
"ex_slrt_rt_osc")))). You must have already completed the setup in “Prepare Real-
Time Application with MATLAB Language”.

Note:

+ Signal access by signal index will be removed in a future release. Access signals by
signal name instead.

*  The Simulink Real-Time software lists referenced model signals with their full block
path. For example, ex_slrt_rt_osc/childmodel/gain.

1 To get a list of signals, type:

tg-ShowSignals

= on

Target: TargetPCl

Connected
Application

Scopes
NumSignals
ShowSignals
Signals

INDEX VALUE

O WNEFO
cNoNoNoNoNe)

0.
-000000
-000000
-000000
-000000
-000000
-000000

000000

= Yes

= Xpcosc

=1

=7

= on

Type BLOCK NAME LABEL
DOUBLE Gain

DOUBLE Gainl

DOUBLE Gain2

DOUBLE [Integrator
DOUBLE Integratorl
DOUBLE Signal Generator
DOUBLE Sum
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If your signal has a unique label, its label is displayed in the Label column. If the
label is not unique, the command returns an error.

2 To get the value of a signal, use the getsignal method. In the Command Window,
type:

getsignal(tg, " Integratorl®)

ans =

-3.8771

More About

. “Configure Target Scopes with MATLAB Language” on page 5-53
. “Nonobservable Signals” on page 5-172
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Instrument a Stateflow Subsystem
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In this section...

“Configure Stateflow States as Test Points” on page 5-10

“Monitor Stateflow States with Simulink Real-Time Explorer” on page 5-11

A Simulink Real-Time model that uses Stateflow blocks can present special
circumstances. For example, if the model implements a control algorithm as a Stateflow
subsystem, the Stateflow signals are not visible to Simulink Real-Time by default.

This procedure uses the model ex_slrt_sf car (matlab:

open_system(docpath(fullFile(docroot, "toolbox®, "xpc", "examples”®,
"ex_slrt_sf _car")))).

Configure Stateflow States as Test Points

To make Stateflow signals visible to Simulink Real-Time, mark them as test points:

1 Openex_slrt_sf car.
2 Double-click the shift_logic chart.



Instrument a Stateflow Subsystem

*ﬁ Stateflow (chart) ex_slrt_sf_car/shift_logic - Simulink prerelease use EI@
File Edit View Display Chart Simulation Analysis Code Tools Help
B <« G%E@"E@%I\I})HD @'10 Normal - | @ - &~
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{gear_state. DOWN} {gear_state
(E=] )
Ready 112% odes
3 In the shift_logic chart, click Tools > Model Explorer.
4 In the Model Explorer, expand ex_slrt_sf car, and then shift_logic.
5 Expand gear_state, and then select first.
6 To create a test point for the First state, in the State first pane Logging tab,
select the Test point check box.
Click Apply.
8 Repeat steps 8-10 for gear_state values second, third, and fourth.
9 Build and download the ex_slrt_sf_car real-time application to the target

computer (84 on the toolbar).

Monitor Stateflow States with Simulink Real-

Time Explorer

1  Open Simulink Real-Time Explorer (Tools > Simulink Real-Time).
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Connect to the target computer in the Targets pane (35 on the toolbar).

In the Applications pane, expand the real-time application and the Model
Hierarchy node.

To view the test point, select shift_logic and click the View Signals

button £ on the toolbar.

In the Signals workspace, select the Monitor check box for gear_state.first,

gear_state.second, gear_state.third, and gear_state.fourth. The values
of the signals are shown in the Monitoring Value column.

To start execution, click the real-time application. On the toolbar, click the Start
button &

To stop execution, click the real-time application. On the toolbar, click the Stop
button M.
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Ready

More About
. “Monitor Stateflow States with MATLAB Language” on page 5-16

. “Animate Stateflow Charts with Simulink External Mode” on page 5-17
. “Create Signal Groups with Simulink Real-Time Explorer” on page 5-56

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167

. “Signal Group Monitoring Formats” on page 5-15
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. “Nonobservable Signals” on page 5-172
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Signal Group Monitoring Formats

When monitoring a signal group using Simulink Real-Time Explorer, you can change
the output format of the group by selecting one of the Format options. The monitoring
formats are an extension of the options used in C sprint format character vectors.

Data Type Digits Meaning Example

F 1-7 Decimal float, with from one |Decimal 31.5415 with
to seven digits to the right |format F7 is 31.5415000.
of the decimal point

E 1-7 Scientific notation, with Decimal 31.5415 with
from one to seven digits format E7 1s 3.1541500E1.
to the right of the decimal
point

G 1-7 The shorter of F and E, with |Decimal 31.5415 with
from one to seven digits format G7 is 31.5415000.
to the right of the decimal
point

H 1-7 Hexadecimal integer, one Decimal 315 with format H7
to seven hexadecimal digits |is OXxO00013B.
wide

B 1-7 Binary integer, one to seven |Decimal 31 with format B7 is
binary digits wide 0011111.

More About

. “Create Signal Groups with Simulink Real-Time Explorer” on page 5-56
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Monitor Stateflow States with MATLAB Language

You must have already set Stateflow states as test points in model ex_slrt_sf _car
(matlab: open_system(docpath(Ffullfile(docroot, "toolbox®", "xpc”,
"examples®, "ex_slrt_sfT car®)))). If you have not, see “Configure Stateflow
States as Test Points” on page 5-10.

1  To get a list of signals in the Command Window, type:

tg = sirt
2 To display the signals in the real-time application, type:

tg.ShowSignals = “on”

The latter causes the Command Window to display a list of the target object
properties for the available signals.

For Stateflow states that you have set as test points, the state appears in the BLOCK
NAME column. For example, assume that you set a test point for the First state of
gear_state in the shift_logic chart of the ex_slrt_sf _car model. The state of
interest, First, appears as follows in the list of signals in the MATLAB interface:

shift_logic:gear_state.first

shift_logic is the path to the Stateflow chart. gear_state.first is the path to
the specific state.

More About
. “Nonobservable Signals” on page 5-172
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Animate Stateflow Charts with Simulink External Mode

The Simulink Real-Time software supports the animation of Stateflow charts in your
model to provide visual confirmation that your chart behaves as expected.

You must be familiar with the use of Stateflow animation. For more information on
Stateflow animation, see “Animate Stateflow Charts” (Stateflow) in the Stateflow
documentation.

You must have already set Stateflow states as test points in model ex_slrt_sf car
(matlab: open_system(docpath(fullfile(docroot, "toolbox", "xpc-,
"examples”™, "ex_slrt_sf car")))). If you have not, see “Configure Stateflow
States as Test Points” on page 5-10.

In the Simulink Editor, select Simulation > Mode > External.
Select Code > External Mode Control Panel.
Select Signal & Triggering.

A WN —

In the Trigger section of the External Signal & Triggering window:

Set Mode to normal.
* In the Duration box, enter 5.
+ Select the Arm when connecting to target check box.
Click Apply.
Select Simulation > Model Configuration Parameters.
Navigate to the Simulink Real-Time Options node.
Select the Enable Stateflow animation check box.
Click Apply.
Build and download the model to the target computer.

- = 0 00 N O O

- O

On the toolbar, click the Connect To Target button &> .

The current Simulink model parameters are downloaded from the development
computer to the real-time application.

12 To start the simulation, click the Run button 'L!";' on the toolbar.

The simulation begins to run. You can observe the animation by opening the
Stateflow Editor for your model.
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To stop the simulation, click the Stop button ™. on the toolbar.

Note: Enabling the animation of Stateflow charts also displays additional Stateflow
information. The Stateflow software requires this information to animate charts. You can
disregard this information.

More About

. “Nonobservable Signals” on page 5-172
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Signal Tracing Basics

Signal tracing acquires signal and time data from a real-time application. While the real-
time application is running, you can visualize the data on the target computer using a
target scope. You can also upload the data to the development computer and display it
using a host scope.

You trace signals using target and host scopes and view them using Simulink Real-Time
Explorer, Simulink external mode, MATLAB language, and a web browser interface.

Simulink Real-Time Explorer can display multidimensional signals in column-major
format.

Some signals are not observable.

More About

. “Nonobservable Signals” on page 5-172

. “Simulink Real-Time Scope Usage” on page 5-20
. “Target Scope Usage” on page 5-22

. “Host Scope Usage” on page 5-59

. “File Scope Usage” on page 5-79

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Simulink Real-Time Scope Usage

5-20

To monitor an output signal from a Constant block by connecting it to a Simulink
Real-Time Scope block, add a test point for the Constant block output signal.

You can add a Simulink Real-Time Scope block only to the topmost model, not to a
referenced model. To log signals from referenced models, use Simulink Real-Time
Explorer scopes or Simulink Real-Time language scope objects.

When you build and download the real-time application, the Simulink Real-Time
kernel creates a scope representing the real-time Scope block. You can change the
Scope parameters after building the real-time application or while it is running.

To change the parameters, assign the scope to a MATLAB variable using the

target object method Simul inkRealTime.target.getscope. You can use
SimulinkReal Time.target.getscope to remove a scope created during the build
and download process. The Simulink Real-Time kernel recreates the scope when you
restart the real-time application.

If the output of a Mux block is connected to the input of a Simulink Real-Time Scope
block, the signal is not observable. To observe the signal, add a unity gain block (a
Gain block with a gain of 1.0) between the Mux block and the Simulink Real-Time
Scope block.

You can pass vector signals into a Simulink Real-Time Scope block. The real-time
application interprets the vector as a series of individual signals. However, you cannot
pass a matrix signal into a Scope block. Doing so results in a build error. To display a

matrix signal, pass it to a Reshape block and pass the resulting vector into the Scope
block.

The real-time application can generate data faster than the kernel can process it.
Previous data can be overwritten, causing gaps. If gaps occur in the data, consider
increasing the value of the Decimation property of the scope.

See Also

Gain | Mux | Reshape | SimulinkRealTime.target.getscope

More About

“Nonobservable Signals” on page 5-172
“Target Scope Usage” on page 5-22
“Host Scope Usage” on page 5-59

“File Scope Usage” on page 5-79



Simulink Real-Time Scope Usage

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Target Scope Usage

5-22

There can be no more than nine target scopes in a model, whether created by using a
real-time Scope block or using the run-time interface. Each target scope can contain
up to 10 signals.

The combined number of target scopes and Video Display blocks in the model cannot
exceed nine.

With one graphical target scope active on the target computer, the graphical and
numerical formats are displayed. With more than one target scope active, only the
format that the Scope mode parameter specifies is displayed.

For a target scope, logged data (sc.Data and sc.Time) is not accessible over the
command-line interface on the development computer. Logged data is accessible
only when the scope object status (sc.Status) is set to Finished. When the scope
completes one data cycle (time to collect the number of samples), the scope engine
restarts the scope instead of setting sc.Status to Finished.

If you create a scope object, for example, sc = getscope(tg,l) for a target scope,
you cannot get the logged data by typing sc.Data. Instead, you get an error message:

Scope # 1 is of type "Target"! Property Data

is not accessible.

To view data on the development computer while the data is being displayed on the

target computer, define a second scope object with type host. Then synchronize the

acquisitions of the two scope objects by setting TriggerMode for the second scope to
"Scope”.

To display the target scope image in a display window on the development computer
screen, use Simul inkRealTime.target.viewTargetScreen

To save the target scope image to a file, right-click in the display window and then
click Save as image.

See Also

SimulinkRealTime.target.getscope |
SimulinkRealTime.target.viewTargetScreen | Video Display



Target Scope Usage

More About

“Configure Real-Time Target Scope Blocks” on page 5-24

“Create Target Scopes with Simulink Real-Time Explorer” on page 5-30
“Simulink Real-Time Scope Usage” on page 5-20

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Configure Real-Time Target Scope Blocks

5-24

Simulink Real-Time includes a specialized Scope block that you can configure to display
signal and time data on the target computer monitor. Add a Scope block to the model,
select Scope type Target, and configure the other parameters as described in the
following procedure.

Do not confuse Simulink Real-Time Scope blocks with standard Simulink Scope blocks.

This procedure uses the example model ex_slrt_rt_osc (matlab:
open_system(docpath(fullFile(docroot, "toolbox", "Xxpc
"ex_slrt_rt_osc")))).

, "examples®,

1 Inthe Command Window, open ex_slrt_rt_osc.
2 Double-click the block labeled Scope.

The Scope block dialog box opens. By default, the target scope dialog box is
displayed.

3 In the Scope number box, a unique number is displayed that identifies the scope.
This number is incremented each time you add a Simulink Real-Time Scope block.

This number identifies the Simulink Real-Time Scope block and the scope screen on
the development or target computers.

4 From the Scope type list, select Target if it is not already selected. The updated
dialog box is displayed.

5 To start the scope automatically when the real-time application executes, select
the Start scope when application starts check box. The target scope opens
automatically on the target computer monitor.

In Stand Alone mode, this setting is mandatory, because the development
computer is not available to issue a command to start scopes.

6 From the Scope mode list, select Numerical, Graphical redraw, or Graphical
rolling. (The Graphical sliding will be removed in a future release. It behaves
like Graphical rolling.)

If you have a scope type of Target and a scope mode of Numerical, the scope block
dialog box adds a Numerical format box. You can define the display format for the
data. If you choose not to complete the Numerical format box, the Simulink Real-
Time software displays the signal using the default format of %15.6F. This format is
a floating-point format without a label.
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If you select scope mode Numerical, in the Numerical format box, type a label
and associated numeric format type in which to display signals. By default, the entry
format is floating-point without a label, %15.6F. The Numerical format box takes

entries of the format:

"[LabelN] [%width.precision][type] [LabelX]*"

+ LabelN is the label for the signal. You can use a different label for each signal or
the same label for each signal. This argument is optional.

+ width is the minimum number of characters to offset from the left of the screen
or label. This argument is optional.

* precision is the maximum number of decimal places for the signal value. This
argument is optional.

* type is the data type for the signal format. You can use one or more of the

following types.

Type

Description

%e or %E

Exponential format using e or E

%

Floating point

%g Signed value printed in f or e format, depending on which is
smaller
%G Signed value printed in F or E format, depending on which is

smaller

+ LabelX s a second label for the signal. You can use a different label for each
signal or the same label for each signal. This argument is optional.

Enclose the contents of the Numerical format text box in single quotation marks.

For example:

"Foo %15.2F end”

For a whole integer signal value, enter O for the precision value. For example:

"Fool %15.0Ff end”

For a line with multiple entries, delimit each entry with a command and enclose the
entire format character vector in single quotation marks. For example:

"Foo2 %15.6F end,Foo3 %15.6F end2*
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11

12

13

You can have multiple Numerical format entries, separated by a comma. If you
insert a single entry, that entry applies to each signal (scalar expansion). If you enter
N label entries for N+Ksignals, the first N-1 entries apply to the first N-1 signals. The
Nth entry is scalar expanded for the remaining K+1 signals. If you have two entries
and one signal, the software ignores the second label entry and applies the first
entry. You can enter as many format entries as you have signals for the scope. The
format character vector has a maximum length of 100 characters, including spaces,
for each signal.

To display grid lines on the scope, select the Grid check box. This parameter is
applicable only for target scopes with scope modes of type Graphical redraw or
Graphical rolling.

In the Y-Axis limits box, enter a row vector with two elements. The first element is
the lower limit of the y-axis and the second element is the upper limit. If you enter O
for both elements, scaling is set to auto. This parameter is applicable only for target
scopes with scope modes of type Graphical redraw or Graphical rolling.

In the Number of samples box, enter the number of values to be acquired in a data
package.

+ Ifyou select a Scope mode of Graphical redraw, the display redraws the
graph every Number of samples.

If you select a Scope mode of Numerical, the block updates the output every
Number of samples.

+ Ifyou select a Trigger mode other than FreeRun, this parameter can specify the
Number of samples to be acquired before the next trigger event.

In the Number of pre/post samples box, enter the number of samples to save
or skip. To save N samples before a trigger event, specify the value -N. To skip N
samples after a trigger event, specify the value N. The default is O.

In the Decimation box, enter a value to indicate when data is collected. The value 1
means that data is collected at each sample time. A value of 2 or greater means that
data is collected at less than every sample time.

From the Trigger mode list, select one of the following:

* FreeRun or Software Triggering — No extra parameters.
Signal Triggering — enter additional parameters, as required:

+ In the Trigger signal box, enter the index of a signal previously added to the
scope.
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This parameter does not apply if the Add signal port to connect a signal
trigger source check box is selected.

*  (Alternatively) Click the Add signal port to connect a signal trigger
source check box, then connect an arbitrary trigger signal to the port Trigger
signal.

+ Inthe Trigger level box, enter a value for the signal to cross before
triggering.

+ From the Trigger slope list, select one of Either, Rising, or Falling.
+ Scope Triggering — enter additional parameters, as required:
* Inthe Trigger scope number box, enter the scope number of a Scope block.
If you use this trigger mode, add a second Scope block to your Simulink model.

+ To trigger one scope on a specific sample of another scope, enter a value in
Sample to trigger on (-1 for end of acquisition). The default value, O,
indicates that the triggered scope starts on the same sample as the triggering
scope.

The target scope dialog box looks like this figure.
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o

Block Parameters: Scope (xPC)
¥pcscopeblock (mask) (link)

Simulink Real-Time Scope
Configure scope to acquire signal data.
Scope can be of type target, host, or file.

Parameters

Scope number:

Scope type: [Target

Start scope when application starts

Scope mode: [Graphic‘.al redraw

Grid
Y-axis limits:
[0,0]
MNumber of samples:

1000

Mumber of pre/post samples:
0

Decimation:

1

= = = 1

Trigger mode: [ FreeRun

4

[ OK H Cancel H

Help

Apply




Configure Real-Time Target Scope Blocks

14 Click OK.
15 From the File menu, click Save As.
Save the model as ex_slrt_target osc (matlab:

open_system(docpath(fullfile(docroot, "toolbox", "xpc*®
"examples®™, "ex_slrt_target_osc")))).

See Also
Scope

More About

. “Simulink Real-Time Scope Usage” on page 5-20
. “Target Scope Usage” on page 5-22
. “Trigger One Scope with Another Scope” on page 10-19
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Create Target Scopes with Simulink Real-Time Explorer

You can create a target scope on the target computer using Simulink Real-Time Explorer.
These scopes have the full capabilities of the Scope block in Target mode, but do not
persist past the current execution.

Note: For information on using target scope blocks, see “Configure Real-Time Target
Scope Blocks” on page 5-24 and “Target Scope Usage” on page 5-22.

This procedure uses the model xpcosc. You must have already completed the following
setup:

1  Built and downloaded the real-time application to the target computer using
Simulink (83 on the toolbar).

2 Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).
3 Connected to the target computer in the Targets pane (5! on the toolbar).
Set property Stop time to inf in the Applications pane (::3 on the toolbar).

To configure a target scope:

1 In the Scopes pane, expand the xpcosc node.
2 To add a target scope, select Target Scopes and then click the Add Scope
button B on the toolbar.

The new scope appears under node Target Scopes, for example Scope 1.

Select Scope 1 and then click the Properties buttond® on the toolbar.

4 In the Scope Properties workspace, click Signals. You add signals from the
Applications Signals workspace.

5 Inthe Applications pane, expand the real-time application node and then node
Model Hierarchy.

6  Select the model node and then click the View Signals button & on the toolbar.

The Signals workspace opens, showing a table of signals with properties and actions.

7 In the Signals workspace, to add signal Signal Generator to Scopel, drag signal
Signal Generator to the Scopel properties workspace.
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8 Add signal Integratorl to Scope 1 in the same way.

The dialog box looks like this figure.
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Ready

9 To start execution, click the real-time application and then click the Start
button & on the toolbar.

The application starts running. No output appears on the target computer monitor.
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To start Scope 1, click Scope 1 in the Scopes pane and then click the Start Scope
button B on the toolbar.

Output for signals Signal Generator and Integratorl appears on the target
computer monitor.

To stop Scope 1, click Scope 1 in the Scopes pane and then click the Stop Scope
button HE on the toolbar.

The signals shown on the target computer stop updating while the real-time
application continues running. The target computer monitor displays a message like
this message:

Scope: 1, set to state "interrupted”

To stop execution, click the real-time application and then click the Stop
button M on the toolbar.

The real-time application on the target computer stops running, and the target
computer displays messages like these messages:

minimal TET: 0.0000006 at time 0.001250

maximal TET: 0.0000013 at time 75.405500

The target computer screen looks like this figure.



Create Target Scopes with Simulink Real-Time Explorer

4 Simulink Real-Time Target Screen

6: Signal Generator

Simulink Real-Time™
R2017a

—A.484929
4 .6668068

8.88825

=] & [

3.16e—887

You can create a target scope from the scope types list by clicking Add Scope next to
scope type Target Scopes. You can add or remove signals from a target scope while the

scope is either stopped or running.
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To make both workspaces visible at the same time, drag one workspace tab down until

the

icon appears in the middle of the dialog box. Continue to drag the workspace until

the cursor reaches the required quadrant, and then release the mouse button.

To save your Simulink Real-Time Explorer layout, click File > Save Layout. In a later
session, you can click File > Restore Layout to restore your layout.

See Also

SimulinkRealTime.target.viewTargetScreen

More About

“Create Signal Groups with Simulink Real-Time Explorer” on page 5-56
“Configure Target Scopes with Simulink Real-Time Explorer” on page 5-49
“Configure Scope Sampling with Simulink Real-Time Explorer” on page 5-35
“Trigger Scopes with Simulink Real-Time Explorer” on page 5-38

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Configure Scope Sampling with Simulink Real-Time Explorer

You can customize sampling for Simulink Real-Time scopes to facilitate data access to
the running model. You can configure sampling whether you added a Scope block to the
model or added the scope at run time.

This procedure uses the model xpcosc. You must have already completed the procedure
in “Create Target Scopes with Simulink Real-Time Explorer” on page 5-30. Target
execution and scopes must be stopped.

1

2
3

Select Scope 1 and open the Properties pane (ﬁ on the Scopes toolbar).
In the Scope 1 properties pane, click Sampling.

In the Number of Samples box, enter the number of values to be acquired in a data
package, here 250.

If you select a Display mode of Graphical redraw, the display redraws the graph
every Number of Samples.

If you select a Display mode of Numerical, the block updates the output every
Number of Samples.

If you select a Trigger Mode other than FreeRun, this parameter can specify the
number of samples to be acquired before the next trigger event.

In the Decimation box, enter 10 to indicate that data must be collected at every
10th sample time. The default is 1, to collect data at every sample time.

In the Number of pre/post samples box, enter the number of samples to save
or skip. To save N samples before a trigger event, specify the value -N. To skip N
samples after a trigger event, specify the value N. The default is O.

The dialog box looks like this figure.
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6  Start execution (& on the Applications toolbar).
7 Start Scope 1 (® on the toolbar).

Output for signals Signal Generator and Integratorl appears on the target
computer monitor.
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4 Simulink Real-Time Target Screen [E=RE=R=]
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Simulink Real-Time™
R2017a

8 Stop Scope 1 (f§ on the toolbar).

9 Stop execution (M on the Applications toolbar).

More About

“Trigger Scopes with Simulink Real-Time Explorer” on page 5-38
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Trigger Scopes with Simulink Real-Time Explorer

5-38

To facilitate your interaction with the running model, you can configure scope triggering
for Simulink Real-Time scopes. You can configure triggering whether you created the
scope by adding a Scope block to the model or by adding the scope at run time.

The following procedures use the model Xxpcosc. You must have already completed the
procedure in “Create Target Scopes with Simulink Real-Time Explorer” on page 5-30.
Target execution and scopes must be stopped.

In this section...

“Freerun Triggering” on page 5-38
“Software Triggering” on page 5-38
“Signal Triggering” on page 5-41
“Scope Triggering” on page 5-45

Freerun Triggering

In Trigger Mode Freerun, the scope triggers automatically when it is started. It
displays data until it is stopped. By default, Trigger Mode is set to Freerun.

1 Start execution (& on the Applications toolbar).

Select Scope 1 and open the Properties pane (ﬁ on the Scopes toolbar).
In the Scope 1 pane, click Triggering.
Select Trigger Mode Freerun.

Start and stop Scope 1 (Hf and H§ on the toolbar).

O b W N

Signal data is displayed on the target computer monitor when the scope starts and
stops when the scope stops.

6 Stop execution (M on the Applications toolbar).

Software Triggering

In Trigger Mode Software, the scope triggers when you select Scope 1 and then click
the Trigger button £ on the toolbar.



Trigger Scopes with Simulink Real-Time Explorer

Start execution ([ on the Applications toolbar).
Select Trigger Mode Software.

Start Scope 1 ({® on the toolbar).
The Trigger button £ is enabled on the toolbar.
Click the Trigger £ button on the Scopes toolbar.

The current signal data is displayed on the target computer monitor when you click
the button.

Stop Scope 1 (l§ on the toolbar).

The dialog box looks like this figure.
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The target monitor looks like this figure.
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4 Simulink Real-Time Target Screen [E=RE=R=]
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Simulink Real-Time™
R2017a

6 Stop execution (M on the Applications toolbar).

Signal Triggering

In Trigger Mode Signal, the scope triggers when a signal rises or falls through a
specified level.
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AW N

Start execution ([ on the Applications toolbar).

Select Scope 1 and open the Properties pane (ﬁ on the Scopes toolbar).
In the Scope 1 pane, click Triggering.
Select Trigger Mode Signal.

Settings Trigger Signal, Trigger Slope, and Trigger Level appear.

Type the number displayed on the target computer screen for Signal Generator
(here, 5) in the Trigger Signal text box.

Set Trigger Slope to Rising.

Leave Trigger Level as O, indicating that the signal crosses O before Scope 1
triggers.
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-4\ Simulink Real-Time Explorer
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Ready

8  Start Scope 1 (@® on the toolbar).

Signal data is displayed on the target computer monitor, with the rising pulse of
Signal Generator just beyond the left side.
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4 Simulink Real-Time Target Screen

6: Signal Generator

Simulink Real-Time™
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9 Stop Scope 1 (l§ on the toolbar).

10 Stop execution (M on the Applications toolbar).
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Scope Triggering

In Trigger Mode Scope, the scope triggers when another scope triggers. In this
example, Scope 2 triggers when signal-triggered Scope 1 triggers.

1 Start execution (& on the Applications toolbar).

Add scope Scope 2 (8 on the Scopes toolbar).

Open the Signals pane (<= on the Applications toolbar).

Add signal Integrator to Scope 2 in the Signals pane.
In the Scope 2 pane, click Triggering.

o 0 A WODN

Select Trigger Mode Scope.

Settings Trigger scope and Trigger scope sample appear.

N

Set Trigger scope to 1. Press Enter. Scope 2 then triggers when Scope 1 triggers.

8 Leave Trigger scope sample set to 0. Scope 2 triggers on the same sample as
Scope 1.
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9 Explicitly start both Scope 1 and Scope 2 (Hf on the toolbar).

Scope 1 and Scope 2 display signal data on the target computer monitor.

4] Simulink Real-Time Target Screen = & ==
8. 88025 4.18e-887

6.22 x1073 2.508 x183 6.22 x1073

Simulink Real-Time™
R2017a

10 Explicitly stop both Scope 1 and Scope 2 (H§ on the toolbar).

11 Stop execution (M on the Applications toolbar).
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More About

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167

5-48



Configure Target Scopes with Simulink Real-Time Explorer

Configure Target Scopes with Simulink Real-Time Explorer

To facilitate your view of the signal data, you can configure the target scope display. You
can configure the display whether you added a Scope block to the model or added the
scope at run time.

This procedure uses the model xpcosc. You must have already completed the procedure
in “Create Target Scopes with Simulink Real-Time Explorer” on page 5-30. Target
execution and scopes must be stopped.

1

2
3
4

Start execution (& on the Applications toolbar).

Select Scope 1 and open the Properties pane (ﬁ on the Scopes toolbar).
In the Scope 1 pane, click Display.
Select Display mode Redraw and then click in the Y-Limits box.

This value is the default. It causes the scope display to redraw when it has acquired
as many samples as specified in Number of Samples.

Start Scope 1 (R on the toolbar).

Signal data is displayed on the target computer monitor, appearing to move to the
left.

Enter [0,10] in the Y-Limits box and then press Enter. The default setting is
[0,0], which automatically scales the output according to the signal values.

The display changes to show only values at and above the zero line.
Clear the Grid (On/Off) check box. By default, the box is selected.
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The target computer monitor looks like this figure.
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4 Simulink Real-Time Target Screen [E=RE=R=]
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Simulink Real-Time™
R2017a

8 Select Display mode Numerical and then click in the Y-Limits box.

The grid and axes disappear. The target computer monitor displays the signals, color
coded, in the default format of %15.6F (a floating-point format without a label).

9 Select Display mode Rolling and then click in the Y-Limits box.
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The display changes to a display that continuously moves a window along the signal
log. New data enters the display from the right and then moves toward the left.

10 Stop Scope 1 (l§ on the toolbar).
11 Stop execution (M on the Applications toolbar).

See Also

SimulinkRealTime.target.viewTargetScreen
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Configure Target Scopes with MATLAB Language

Creating a scope object allows you to select and view signals using Simulink Real-Time
functions instead of the Simulink Real-Time user interface.

This procedure uses the Simulink model xpcosc. To do this procedure, you must have
already built the real-time application forxpcosc and downloaded it to the default target
computer. It describes how to trace signals with target scopes.

1

Start running your real-time application. Type:
tg = slrt;

start(tg)

To get a list of signals, type:

tg.-ShowSignals = "on

The Command Window displays a list of the target object properties for the available
signals. For example, the signals for the model xpcosc are:

Target: TargetPCl

Connected = Yes
Application = Xpcosc
Scopes =1
NumSignals =7
ShowSignals = on
Signals =
INDEX VALUE Type BLOCK NAME LABEL
0 0.000000 DOUBLE Gain
1 0.000000 DOUBLE Gainl
2 0.000000 DOUBLE Gain2
3 0.000000 DOUBLE Integrator
4 0.000000 DOUBLE Integratorl
5 0.000000 DOUBLE Signal Generator
6 0.000000 DOUBLE Sum

3 Create a scope to be displayed on the target computer. For example, to create a scope

with an identifier of 1 and a scope object name of scl, type:
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scl = addscope(tg, "“target”, 1)

Simulink Real-Time Scope

Application = Xpcosc

Scopeld =1

Status = Interrupted

Type = Target

NumSamples = 250
NumPrePostSamples =0

Decimation =1

TriggerMode = FreeRun
TriggerSignal = -1

TriggerLevel = 0.000000
TriggerSlope = Either
TriggerScope =1

TriggerSample =0

DisplayMode = Redraw (Graphical)
YLimit = Auto

Grid = on

Signals = no Signals defined

4  Add signals to the scope object. For example, to add Integratorl and Signal
Generator, type:

addsignal(scl,[4,5])

Simulink Real-Time Scope

Application = Xpcosc
Scopeld =1
Status = Interrupted
Type = Target
Grid = on
Signals = 4 : Integratorl
5 : Signal Generator

The target computer displays the following messages:
Scope: 1, signal 4 added

Scope: 1, signal 5 added
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After you add signals to a scope object, the signal values are not shown on the target
display until you start the scope.

5 Start the scope. For example, to start the scope scl, type:

start(scl)

The target display plots the signals after collecting each data package. During this
time, you can observe the behavior of the signals while the scope is running.

6  Stop the scope. Type:

stop(scl)

The signals shown on the target computer stop updating while the real-time
application continues running. The target computer displays the following message:

Scope: 1, set to state “interrupted”

7  Stop the real-time application. In the Command Window, type:

stop(tg)

More About
. “Monitor Signals with MATLAB Language” on page 5-8
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Create Signal Groups with Simulink Real-Time Explorer

When testing a complex model with many signals, you frequently must select signals

for tracing or monitoring from multiple parts and levels of the model hierarchy. You can
make this task easier by using Simulink Real-Time Explorer to create a signal group and
save it to disk.

This procedure uses the model xpcosc. You must have already completed the following

setup:

1 Built and downloaded the real-time application to the target computer using
Simulink (85 on the toolbar).

2 Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).

3 Connected to the target computer in the Targets pane (3! on the toolbar).
To create a signal group:
1 In the Applications pane, expand the real-time application node and right-click

node Groupings.
2 Click New Signal Group.

The Add New Signal Group Item dialog box appears.

3 In the Add New Signal Group Item dialog box, enter a name in the Name text box,
for example signalgroupl.sig. In the Location text box, enter a folder for the
group file.

4 Click OK.

A new signal group appears, along with its Signal Group workspace.

5 In the Applications pane, expand the real-time application node and then expand
node Model Hierarchy.

6  Select the model node and then click the View Signals button = on the toolbar.

The Signals workspace opens, showing a table of signals with properties and actions.

7 In the Signals workspace, to add signal Signal Generator to signalgroupl.sig,
drag signal Signal Generator to the signalgroupl.sig properties workspace.

8 Add signal Integratorl to signalgroupl.sig in the same way.

Press Enter, and then click the Save button E on the toolbar.
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When you are monitoring a signal group, you can change the output format of the
group by selecting one of the options in the Format column. See“Signal Group

Monitoring Formats” on page 5-15.

4\ Simulink Real-Time Explorer
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Signals are defined within a particular real-time application. To open a signal group from
the File > Open > Group menu, you must first select an application.
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To remove signals from the signal group, select the signal items in the group list and
click Delete Signals.

To remove the signal group, navigate to the signal group under Groupings > Signals,
right-click the signal group, and click Remove.

To make both workspaces visible at the same time, drag one workspace tab down until

the “ 7 icon appears in the middle of the dialog box. Continue to drag the workspace until
the cursor reaches the required quadrant, and then release the mouse button.

To save your Simulink Real-Time Explorer layout, click File > Save Layout. In a later
session, you can click File > Restore Layout to restore your layout.

More About

. “Monitor Signals with Simulink Real-Time Explorer” on page 5-5

. “Create Target Scopes with Simulink Real-Time Explorer” on page 5-30
. “Create Host Scopes with Simulink Real-Time Explorer” on page 5-64

. “Create File Scopes with Simulink Real-Time Explorer” on page 5-87

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Host Scope Usage

Simulink Real-Time supports as many host scopes as the target computer resources
can support. Each host scope can contain as many signals as the target computer
resources can support.

To clarify your model functionality, consider adding signal labels. If you define signal
labels, the host scope displays the labels, highlighted with pointed brackets, instead of
the signal names. If you do not define signal labels, the host scope displays the short
name of the signal.

Use host scopes to log signal data triggered by an event while your real-time
application is running. The host scope acquires the first N samples into a buffer. You
can retrieve this buffer into the scope object property sc.Data. The scope then stops.
Restart the scope manually.

The number of samples N to log after triggering an event is equal to the value that you
entered in the Number of samples parameter.

Select the type of trigger event in the Scope block dialog box by setting Trigger Mode
to Signal Triggering, Software Triggering, or Scope Triggering.

The target computer transfers data to the development computer for display in the
host scope viewer. Because of this latency, the host scope display lags a target scope
display during real-time application execution.

More About

“Configure Real-Time Host Scope Blocks” on page 5-60

“Create Host Scopes with Simulink Real-Time Explorer” on page 5-64
“Simulink Real-Time Scope Usage” on page 5-20

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Configure Real-Time Host Scope Blocks

5-60

Simulink Real-Time includes a specialized real-time Scope block that you can configure
to display signal and time data on the development computer monitor. Add a Scope block
to the model, select Scope type Host, and configure the other parameters as described
in the following procedure.

* Do not confuse Simulink Real-Time Scope blocks with standard Simulink Scope
blocks.

* To clarify your model functionality, consider adding signal labels. If you define signal
labels, the host scope displays the labels, highlighted with pointed brackets, instead of
the signal names. If you do not define signal labels, the host scope displays the short
name of the signal.

This procedure uses the example model ex_slrt_rt_osc (matlab:
open_system(docpath(fullfile(docroot, "toolbox®, "Xxpc
"ex_slrt_rt_osc")))).

, "examples®,

In the Command Window, open ex_slrt_rt_osc.
2 Double-click the block labeled Scope.

The Scope block dialog box opens. By default, the target scope dialog box is
displayed.

3 Inthe Scope number box, a unique number is displayed that identifies the scope.
This number is incremented each time that you add a Simulink Real-Time scope.

This number identifies the Simulink Real-Time Scope block and the scope screen on
the development or target computers.

From the Scope type list, select Host. The updated dialog box is displayed.

5 To start the scope automatically when the real-time application executes, select the
Start scope when application starts check box. You can then open a host scope
viewer from Simulink Real-Time Explorer.

In Stand Alone mode, this setting is mandatory because the development computer
is not available to issue a command to start scopes.

6 In the Number of samples box, enter the number of values to be acquired in a data
package.
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In the Number of pre/post samples box, enter the number of samples to save
or skip. To save N samples before a trigger event, specify the value -N. To skip N
samples after a trigger event, specify the value N. The default is O.

In the Decimation box, enter a value to indicate when data is collected. The value 1
means that data is collected at each sample time. A value of 2 or greater means that
data is collected at less than every sample time.

From the Trigger mode list, select one of the following:

FreeRun or Software Triggering — No extra parameters.

Signal Triggering — enter additional parameters, as required:

In the Trigger signal box, enter the index of a signal previously added to the
scope.

This parameter does not apply if the Add signal port to connect a signal
trigger source check box is selected.

(Alternatively) Click the Add signal port to connect a signal trigger
source check box, then connect an arbitrary trigger signal to the port Trigger
signal.

In the Trigger level box, enter a value for the signal to cross before
triggering.

From the Trigger slope list, select one of Either, Rising, or Falling.

Scope Triggering — enter additional parameters, as required:

In the Trigger scope number box, enter the scope number of a Scope block.
If you use this trigger mode, add a second Scope block to your Simulink model.

To trigger one scope on a specific sample of another scope, enter a value in
Sample to trigger on (-1 for end of acquisition). The default value, O,
indicates that the triggered scope starts on the same sample as the triggering
scope.

The host scope dialog box looks like this figure.
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o

Block Parameters: Scope (xPC)

¥pcscopeblock (mask) (link)

Simulink Real-Time Scope
Configure scope to acquire signal data.
Scope can be of type target, host, or file.

Parameters

Scope number:

Scope type: [HDEII

Start scope when application starts
MNumber of samples:

1000

Mumber of pre/post samples:
0

Decimation:

1

Trigger mode: [ FreeRun

[ OK ] [ Cancel

/|

Help

Apply

10 Click OK.

11 From the File menu, click Save As.
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Save the model as ex_slrt_host_osc (matlab:
open_system(docpath(fullfile(docroot, "toolbox®, "xpc*”
"examples™, "ex_slrt_host osc")))).

See Also

Scope

More About

. “Simulink Real-Time Scope Usage” on page 5-20
. “Host Scope Usage” on page 5-59

“Create Host Scopes with Simulink Real-Time Explorer” on page 5-64
“Trigger One Scope with Another Scope” on page 10-19
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Create Host Scopes with Simulink Real-Time Explorer

5-64

You can create a host scope on the target computer with Simulink Real-Time Explorer.
These scopes have the full capabilities of the Scope block in Host mode, but do not
persist past the current execution.

For information on using host scope blocks, see “Configure Real-Time Host Scope Blocks”
on page 5-60 and “Host Scope Usage” on page 5-59.

This procedure uses the model ex_slrt_sf car (matlab:
open_system(docpath(fullfile(docroot, "toolbox”,
"ex_slrt_sf car")))).

Xpc®, "examples-®,

Set Up Model

Before creating a host scope, perform these steps:

1 Build and download ex_slrt_sf _car to the target computer with Simulink (&5 on

the toolbar).

2 Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).
Connect to the target computer that is in the Targets pane (arq on the toolbar).
Set property Stop time to inf in the Applications pane (Ef} on the toolbar).

Configure Host Scope

1 In the Scopes pane, expand the ex_slrt_sf _car node.

2 To add a host scope, select Host Scopes, and then click the Add Scope
button & on the toolbar.

Expand Scope 1, and then click the Properties button el on the toolbar.

To display the host scope signals, in the Scope Properties pane, click Signals.

4 In the Applications pane, expand the real-time application node, and then the node
Model Hierarchy.

5 Double-click the ex_slrt_sf car > transmission > Torque Converter node.

The Torque Converter signal list opens.
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To add signal turbine to Scopel, drag signal turbine from the Torque
Converter signal list to the Scopel properties workspace.

To make the Scopel properties visible below the Torque Converter signal list,

drag the Torque Converter tab down until the

way as described in step 6.

icon appears.

Double-click transmission ratio and add signal Product to Scope 1 in the same

4\ Simulink Real-Time Explorer

File Edit View Window Help
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]
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Ready
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View Host Scope

1

Select Scope 1, and then click the View Scope button Hll on the toolbar.

The host scope viewer opens as a separate tab. The signals that you add to the scope
appear at the top right of the viewer. The labels appear in pointed brackets because
these signals are labeled signals.

To start Scope 1, click Scope 1 in the Scopes pane, and then click the Start Scope
button B on the toolbar.

To start execution, click the real-time application, and then click the Start
button & on the toolbar.

The real-time application starts running. The host scope on the target computer
transfers data to the host scope on the development computer.
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4\ Simulink Real-Time Explorer
File Edit  View Window Help
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4 To stop Scope 1, click Scope 1 in the Scopes pane, and then click the Stop Scope
button H§ on the toolbar.
5 To stop execution, click the real-time application, and then click the Stop
button M on the toolbar.

See Also
Scope
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More About

“Host Scope Usage” on page 5-59

“Configure Real-Time Host Scope Blocks” on page 5-60

“Configure the Host Scope Viewer” on page 5-69

“Create Signal Groups with Simulink Real-Time Explorer” on page 5-56
“Configure Scope Sampling with Simulink Real-Time Explorer” on page 5-35
“Trigger Scopes with Simulink Real-Time Explorer” on page 5-38

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Configure the Host Scope Viewer

You can customize the viewer for each host scope to facilitate your interaction with the
running model.

This procedure uses the model xpcosc. You must have already completed the procedure
in “Create Host Scopes with Simulink Real-Time Explorer” on page 5-64. Target
execution and scopes must be stopped.

1

In the Signals workspace, to add signal Integrator to host scope Scopel, drag
signal Integrator to the Host Scope Viewer display.

Start execution (& on the Applications toolbar).

To start Scope 1, click the Start button i on the Host Scope Viewer toolbar.

To trigger Scope 1, click the Trigger button £ on the Host Scope Viewer toolbar.

To trigger a capture interactively using the Trigger button § , first set the scope
Trigger Mode to Software or Scope.

In the Simulink Real-Time Host Scope Viewer, right-click anywhere in the axis area
of the viewer and then click Edit.

The Host Scope Viewer display parameter buttons become enabled on the toolbar.

Adjust the Host Scope Viewer display using:

Auto Scale |E| — To scale the display to accommodate the top and bottom of the
Y-axis.

Axes Scroll ﬂ — To move the content up and down and right and left relative
to the axes. The axes scroll as required.

Axes Zoom ‘@& — To stretch and compress the X-axis and Y-axis.
Zoom In [--JL — To zoom in on the current center of the display.

Zoom Out [:J]\ — To zoom out from the current center of the display.

the mouse button, the display zooms in upon the selected area.
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Data Cursor .l,,_ — To display data values using a set of cross-hairs in the
display.

Data is displayed as the pair x-value,y-value, indicating the value at that
point on the display. You can drag the center of the cross hairs and observe the
value at each point.

Legends — To toggle display of the signal names.

Y-Axes Scale Display — To show the scale of the Y-axis.
7 To stop Scope 1, click the Stop button Hf on the Host Scope Viewer toolbar.
8 Stop execution (M on the Applications toolbar).

More About

. “Trigger Scopes with Simulink Real-Time Explorer” on page 5-38
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Trace Signals with Simulink External Mode

You can use Simulink external mode to establish a communication channel between your
Simulink block diagram and your real-time application. The block diagram becomes a
user interface to your real-time application. Simulink scopes can display signal data from
the real-time application, including from models referenced inside a top model. You can
control which signals to upload through the External Signal & Triggering dialog box (see
“Select Signals to Upload” (Simulink Coder) and “Control External Mode Operations”
(Simulink Coder)).

Note: Do not use Simulink external mode while Simulink Real-Time Explorer is running.
Use only one interface or the other.

This procedure uses the model xpcosc. Xpcosc contains a Simulink Scope block.

In the Command Window, type xXpcosc.

2 In the Simulink Editor, from the Code menu, select External Mode Control
Panel.

3 Inthe External Mode Control Panel dialog box, click the Signal & Triggering
button.

4 In the External Signal & Triggering dialog box, set the Source parameter to
manual.

5 Set the Mode parameter to normal. In this mode, the scope acquires data
continuously.

6 Select the Arm when connecting to target check box.
7 In the Delay box, enter O.
8 In the Duration box, enter the number of samples for which external mode is to log

data, for example 1000.

The External Signal & Triggering dialog box looks like this figure.
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xpeosc: External Signal & Triggering @
Signal selection
Trigger |  Selected | Block i Path Select all
X Scope ¥pcosc/Scope
Clear all
or
off

Trigger Signal
Go To Block

Trigger options

Source: [manual '] Mode: [normal - | Duration: 1000 Delay: 0

Arm when connecting to target

Trigger signal
Path: Port: |1 Element: |any
Direction: |rising Level: |0 Hold-off: |0

[ OK ” Cancel ][ Help Apply

9 Click Apply, and then Close.
10 In the External Mode Control Panel dialog box, click OK.
11 In the Simulink toolbar, increase the simulation stop time to, for example, 50.

12 From the File menu, select Save As and enter a file name. For example, enter
ex_slrt_ext_osc, and then click OK.

13 In the Simulink Editor, click Simulation > Mode > External. A check mark
appears next to the menu item External, indicating that Simulink external mode is
activated.

14 If a scope window is not displayed for the Scope block, double-click the Scope block.
15 Build and download the model to the target computer.
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16

17

On the toolbar, click the Connect To Target button &> .

The current Simulink model parameters are downloaded from the development
computer to the real-time application.

To start the simulation, click the Run button | ®J on the toolbar.

The real-time application begins running on the target computer. The Scope window
displays plotted data.

o o)

4] Scope =1 e 5

File Tools View Simulation Help ¥

@-0® =-aQa- - F&-

Ready Offset=8.8 |T=10.000

To stop the simulation, click the Stop button ™ on the toolbar.
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Inspect Simulink® Real-Time™ Signals with Simulation Data
Inspector

5-74

This example shows how to use Simulation Data Inspector (SDI) to log signal data from
the real-time application. You can select signals for display from models referenced at
arbitrary levels within a model hierarchy.

* Simulation Data Inspector (SDI) and the third-party calibration tools (Vector
CANape® and ETAS® Inca) are mutually exclusive. If you use SDI to view signal
data, you cannot use the calibration tools. If you use the calibration tools, you cannot
use SDI to view signal data.

* The real-time application sometimes generates data faster than the kernel can
transmit it to the development computer, causing gaps in the output. If gaps occur,
reduce the number of signals being inspected or decrease the sample rate.

This example uses the model xpcosc (matlab:open_system(fullfile(matlabroot, 'toolbox’',
'rtw', 'targets', 'xpc', 'xpcdemos', 'xpcosc'))).

In this example, you control the model from Simulink® Real-Time™ Explorer. You can
also access Simulation Data Inspector by using external mode.

Make sure that you have started the target computer and established communication
between the development and target computers.

Open Xpcosc.

On the toolbar, increase the simulation stop time to, for example, 10 seconds.

In the model, select the signals Signal Generator and Integratorl.

B W NN —

On the toolbar, click the arrow next to the Simulation Data Inspector button,
and then select Log Selected Signals. A faint Simulation Data Inspector icon
appears next to each signal.

(8]

Build the model and download it to the target computer.
6 Click Tools > Simulink Real-Time.

7 In Simulink Real-Time Explorer, start the real-time application. The Simulation
Data Inspector button glows in Simulink Editor, indicating that Simulation Data
Inspector has data available for viewing.

8 Click the Simulation Data Inspector button.
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9 In Simulation Data Inspector, select the signals Integratorl:1 and
SignalGenerator:1. Simulation Data Inspector displays plotted data.

4\ Simulation Data Inspector - untitled* [re] [ e

VISUALIZE
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10. Stop the real-time application.
11. After the simulation, use the toolbar buttons to explore the data. For example, to view

the simulation between seconds 0.02 and 0.04, in Simulation Data Inspector, click the
Zoom in Time button. Drag the cursor over the range from 0.02 to 0.04.
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12. To save the Simulation Data Inspector session as a -.mat file, click Save.

More About

. “Simulation Data Inspector in Your Workflow” (Simulink)
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External Mode Usage

When setting up signal triggering (Source set to signal), explicitly specify the element
number of the signal in the Trigger signal:Element box. If the signal is a scalar,
enter a value of 1. If the signal is a wide signal, enter a value from 1 to 10. When
uploading Simulink Real-Time signals to Simulink scopes, do not enter Last or Any
in this box.

The Direction:Holdoff value does not affect the Simulink Real-Time signal
uploading feature.
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Signal Logging Basics

5-78

Signal logging acquires signal data during a real-time run and stores it on the target
computer. After you stop the real-time application, you transfer the data from target
computer to development computer for analysis. You can plot and analyze the data, and
later save it to a disk on the development computer.

Simulink Real-Time signal logging samples at the base sample time. If you have a model
with multiple sample rates, add Simulink Real-Time scopes to the model to sample
signals at the required sample rates.

*  The Simulink Real-Time software does not support logging data with decimation.

*  Simulink Real-Time Explorer works with multidimensional signals in column-major
format.

*  Some signals are not observable.
You can log signals using the following methods:

*  Outports in the model
* File scope blocks in the model
+ File scopes created using Simulink Real-Time Explorer

* File scopes created using MATLAB language

More About

. “Configure File Scopes with Simulink Real-Time Explorer” on page 5-91

. “Log Signal Data with Outport Blocks and Simulink Real-Time Explorer” on page
5-99

. “Log Signal Data with Outport Block and MATLAB Language” on page 5-105
. “Nonobservable Signals” on page 5-172

. “Simulink Real-Time Scope Usage” on page 5-20

. “Target Scope Usage” on page 5-22

. “Host Scope Usage” on page 5-59

. “File Scope Usage” on page 5-79

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167
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File Scope Usage

* Simulink Real-Time supports eight file scopes. Each file scope can contain as many
signals as the target computer resources can support.

* You can have at most eight files open on the target computer at the same time.
* The largest single file that you can create on the target computer is 4 GB.

+ A fully qualified folder name can have a maximum of 248 characters, including the
drive letter, colon, and backslash.

+ A fully qualified file name can have a maximum of 260 characters: The file part can
have at most 12 characters: eight for the file name, one for the period, and at most
three for the file extension. A file name longer than eight characters is truncated to
six characters followed by "~1".

+ Do not write data to the private folder on your target computer. It is reserved for
Simulink Real-Time internal use.

+ If you enter just the file name, the file appears in folder C:\. To put the file in a
folder, create the folder separately using the target computer command line or the
SimulinkRealTime.fileSystem.mkdir command.

* You can configure the scope to generate multiple, dynamically named files in one
session.

+ Before starting the scope, copy previously acquired data to the development computer.
When the file scope starts, the software overwrites previously acquired data in files
of the specified name or name pattern. A partially overwritten file or a file that is
opened but left unwritten loses its original contents.

* You cannot read a file that was written during real-time execution until execution has
completed.

+ After real-time execution, the file scope software generates a signal data
file on the target computer, even if it is running in Stand Alone mode.
To access the contents of the signal data file that a file scope creates,
use the SimulinkRealTime. fileSystem object from a development
computer Command Window. To view or examine the signal data, use the
SimulinkRealTime.utils.getFileScopeData utility and the plot function.
Saving signal data to files lets you recover signal data from a previous run in the
event of system failure.

* The signal data file can quickly increase in size. To gauge the growth rate for the file,
examine the file size between runs. If the signal data file grows beyond the available
space on the disk, the signal data is corrupted.
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The file scope acquires data and writes it to the file named in the FileName
parameter. The scope writes data samples into a memory buffer of size given by the
Number of Samples parameter. It copies data from the memory buffer into the file
in blocks of size given by the WriteSize parameter.

The Number of samples parameter works with the autorestart setting.

+ Autorestart is on — When the scope triggers, the scope starts collecting data into
a memory buffer. A background task examines the buffer and writes data to the
disk continuously, appending new data to the end of the file. When the scope
reaches the number of samples that you specified, it starts collecting data again,
overwriting the memory buffer. If the background task cannot keep pace with data
collection, data can be lost.

Autorestart is off — When the scope triggers, the scope starts collecting data into
a memory buffer. It stops when it has collected the number of samples that you
specified. A background task examines the buffer and writes data to the disk
continuously, appending the new data to the end of the file.

When real-time execution stops without an error, both the Lazy and Commi t settings
of the Mode box have the same result. Both settings cause the model to open a

file, write signal data to the file, and close that file at the end of the session. The
differences are in when the software updates the FAT entry for the file.

+ In Commit mode, the FAT entry and the actual file size are updated during each
file write operation.

* In Lazy mode, the FAT entry and the actual file size are updated only when the
file is closed and not during each file write operation.

Lazy mode is faster than Commit mode. However, if the target computer enters an
error state, the system can stop responding before the file is closed. In Lazy mode, the
actual file size can be lost, even though the file was written. You can lose an amount
of data equivalent to the setting of the WriteSize parameter.

Select the type of trigger event in the Scope block dialog box by setting Trigger Mode
to Signal Triggering, Software Triggering, or Scope Triggering.

The number of samples N to log after triggering an event is equal to the value that you
entered in the Number of Samples parameter.
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See Also

File System | SimulinkRealTime.fileSystem.mkdir |
SimulinkRealTime.utils_getFileScopeData

More About

. “Configure Real-Time File Scope Blocks” on page 5-82

. “Create File Scopes with Simulink Real-Time Explorer” on page 5-87

. “Log Signal Data into Multiple Files” on page 5-95

. “Simulink Real-Time Scope Usage” on page 5-20

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167
. “Using SimulinkRealTime.fileSystem Objects” on page 11-5
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Configure Real-Time File Scope Blocks
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Simulink Real-Time includes a specialized Scope block that you can configure to save
signal and time data to a file in the target computer file system. Add a Scope block to the
model, select Scope type File, and then configure the other parameters as described in
the following procedure.

Do not confuse Simulink Real-Time Scope blocks with standard Simulink Scope blocks.

This procedure uses the example model ex_slrt_rt_osc (matlab:
open_system(docpath(fullFile(docroot, "toolbox®, "Xxpc
"ex_slrt_rt_osc")))).

, "examples”,

1 Inthe Command Window, open ex_slrt_rt_osc.
2 In the Simulink Editor, double-click the block labeled Scope.

The Scope block dialog box opens. By default, the target scope dialog box is
displayed.

3 In the Scope number box, a unique number is displayed that identifies the scope.
This number is incremented each time you add a Simulink Real-Time scope.

This number identifies the Simulink Real-Time Scope block and the scope screen on
the development or target computer.

4 From the Scope type list, select File. The updated dialog box opens.

S  Caution: Before starting the scope, copy previously acquired data to the development
computer. When the file scope starts, the software overwrites previously acquired
data in files of the specified name or name pattern. A partially overwritten file or a
file that is opened but left unwritten loses its original contents.

To start the scope automatically when the real-time application executes, select the
Start scope when application starts check box.

In Stand Alone mode, this setting is mandatory because the development computer
is not available to issue a command to start scopes.

6 In the Number of samples box, enter the number of values to be acquired in a data
package.

The Number of samples parameter works with the autorestart setting.
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+ Autorestart is on — When the scope triggers, the scope starts collecting data into
a memory buffer. A background task examines the buffer and writes data to the
disk continuously, appending new data to the end of the file. When the scope
reaches the number of samples that you specified, it starts collecting data again,
overwriting the memory buffer. If the background task cannot keep pace with
data collection, data can be lost.

Autorestart is off — When the scope triggers, the scope starts collecting data into
a memory buffer. It stops when it has collected the number of samples that you
specified. A background task examines the buffer and writes data to the disk
continuously, appending the new data to the end of the file.

In the Number of pre/post samples box, enter the number of samples to save
or skip. To save N samples before a trigger event, specify the value -N. To skip N
samples after a trigger event, specify the value N. The default is O.

In the Decimation box, enter a value to indicate how often data is collected, in units
of sample time. The value 1 indicates that data is collected at each sample time.
Values of 2 or more indicates that data is collected at less than every sample time.

From the Trigger mode list, select one of the following:

From the Trigger mode list, select one of the following:

FreeRun or Software Triggering — No extra parameters.
+ Signal Triggering — enter additional parameters, as required:

+ In the Trigger signal box, enter the index of a signal previously added to the
scope.

This parameter does not apply if the Add signal port to connect a signal
trigger source check box is selected.

*  (Alternatively) Click the Add signal port to connect a signal trigger
source check box, then connect an arbitrary trigger signal to the port Trigger
signal.

+ In the Trigger level box, enter a value for the signal to cross before
triggering.

* From the Trigger slope list, select one of Either, Rising, or Falling.

Scope Triggering — enter additional parameters, as required:
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10

11

12

13

* In the Trigger scope number box, enter the scope number of a Scope block.
If you use this trigger mode, add a second Scope block to your Simulink model.

+ To trigger one scope on a specific sample of another scope, enter a value in
Sample to trigger on (-1 for end of acquisition). The default value of O
causes the triggering scope and the triggered scope to start simultaneously.

In the Filename box, enter a name for the file to contain the signal data.
By default, the target computer writes the signal data to C:\data.dat.

A fully qualified file name can have a maximum of 260 characters: The file part can
have at most 12 characters: eight for the file name, one for the period, and at most
three for the file extension. A file name longer than eight characters is truncated to
six characters followed by "~1".

From the Mode list, select either Lazy or Commit.

With the Commit mode, each file write operation simultaneously updates the FAT
entry for the file. The file system maintains the actual file size after each write. With
the Lazy mode, the FAT entry is updated only when the file is closed.

If your system stops responding, you lose WriteSize bytes of data.

In the WriteSize box, enter the block size, in bytes, of the data chunks. This
parameter specifies that a memory buffer of length Number of samples is written to
the file in chunks of size WriteSize. By default, this parameter is 512 bytes. Using a
block size that is the same as the disk sector size improves performance.

If your system stops responding, you lose WriteSize bytes of data.

To have the file scope collect data up to Number of samples and then start over
again reading new data, select the AutoRestart check box.

To have the file scope collect data up to Number of samples and then stop, clear
the AutoRestart check box.

If the named signal data file exists when the file scope starts, the Simulink Real-
Time software overwrites the old data with the new signal data.

Setting this check box enables the following parameters: Dynamic file name
enabled and Max file size in bytes (multiple of WriteSize).

The file scope dialog box looks like this figure.



Configure Real-Time File Scope Blocks

b

Block Parameters: Scope (xPC) @
¥pcscopeblock (mask) (link)

Simulink Real-Time Scope
Configure scope to acquire signal data.
Scope can be of type target, host, or file.

Parameters

Scope number:

i [}
Scope type: [File v]

Start scope when application starts
MNumber of samples:

1000 i

Mumber of pre/post samples:

0 g
Decimation:

1 g

Trigger mode: | FreeRun - ]

Filename:

data.dat

Mode: |Lazy v
WriteSize:

512 i

[] AutoRestart

[ OK H Cancel ][ Help Apply
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14 Click OK.
15 From the File menu, click Save As.
Save the model as ex_slrt_file_osc (matlab:

open_system(docpath(fullfile(docroot, "toolbox", "xpc*®
"examples®, “ex_slrt_file_osc")))).

See Also
Scope

More About

. “Simulink Real-Time Scope Usage” on page 5-20
. “File Scope Usage” on page 5-79
. “Trigger One Scope with Another Scope” on page 10-19
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Create File Scopes with Simulink Real-Time Explorer

You can create a file scope on the target computer using Simulink Real-Time Explorer.
These scopes have the full capabilities of the Scope block in Fi le mode, but do not
persist past the current execution.

Note: For information on using file scope blocks, see “Configure Real-Time File Scope
Blocks” on page 5-82 and “File Scope Usage” on page 5-79.

This procedure uses the model xpcosc. You must have already completed the following
setup:

1

4

Built and downloaded the real-time application to the target computer using
Simulink (3 on the toolbar).

Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).
Connected to the target computer in the Targets pane (sg on the toolbar).

Set property Stop time to inf in the Applications pane ({2 on the toolbar).

To configure a file scope:

In the Scopes pane, expand the xpcosc node.

To add a file scope, select File Scopes, and then click the Add Scope button B on
the toolbar.

Expand Scope 1, and then click the Properties button I on the toolbar.

In the Scope Properties pane, click Signals.

Add signals from the Applications Signals workspace.

In the Applications pane, expand both the real-time application node and the node
Model Hierarchy.

Select the model node and then click the View Signals button & on the toolbar.

In the Signals workspace, to add signal Signal Generator to Scopel, drag signal
Signal Generator to the Scopel properties workspace.

Add signal Integratorl to Scope 1 in the same way.
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10
11

12
13

14

15

16

17

18

In the Scope Properties pane, click File.
Enter a name in the File name text box, for example scopel.dat.

To have the file scope collect data up to Number of samples and then start over
again reading new data, select the AutoRestart check box.

Leave the Dynamic File Mode check box cleared.

To start execution, click the real-time application and then click the Start
button & on the toolbar.

Caution: Before starting the scope, copy previously acquired data to the development
computer. When the file scope starts, the software overwrites previously acquired
data in files of the specified name or name pattern. A partially overwritten file or a
file that is opened but left unwritten loses its original contents.

To start Scope 1, click Scope 1 in the Scopes pane, and then click the Start Scope
button HR on the toolbar.

To stop Scope 1, click Scope 1 in the Scopes pane, and then click the Stop Scope
button H§ on the toolbar.

For file scopes, before adding or removing signals, stop the scope first.

To stop execution, click the real-time application, and then click the Stop
button M on the toolbar.

To view the file that you generated, in the Targets pane, expand the target
computer and then double-click File System.

Select C:\. The dialog box looks like this figure.



Create File Scopes with Simulink Real-Time Explorer
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] ] B v % TargetPCl/xpcosc/Scope 1 (Properties) v X Instrument Panels
4 TargetPClixpeosc & Scope Properties
- -
g Properti
$ rt.:pe ies ~) File
I Groupings
4 Model Hierarchy File name: scopel.dat
i] XpPCosc
File mode: Lazy | |
[¥] AutoRestart
[Z] Dynamic File Mode
Write Size: 512 (Bytes)
Max write file size: 536870912 (Bytes)
g |Pmparﬁes ~ o x
A=
e
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Host Scopes Signal ID Signal Name
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-
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Ready

19 To retrieve the file from the target computer, select the file in the target computer
File System pane. Drag it to the MATLAB Current Folder pane or to a Windows
Explorer window.

You can create a file scope from the list of scope types by clicking Add Scope next to
scope type File Scopes.
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To rename file SCOPEL.DAT, right-click the file name, select Rename, type the new
name in the text box, and then click Enter.

To delete file SCOPE1.DAT, right-click the file name and select Delete.

To make both workspaces visible at the same time, drag one workspace tab down until

the "= icon appears in the middle of the dialog box. Continue to drag the workspace until
the cursor reaches the required quadrant, and then release the mouse button.

To save your Simulink Real-Time Explorer layout, click File > Save Layout. In a later
session, you can click File > Restore Layout to restore your layout.

More About

. “Log Signal Data into Multiple Files” on page 5-95

. “Configure File Scopes with Simulink Real-Time Explorer” on page 5-91

. “Using SimulinkRealTime.fileSystem Objects” on page 11-5

. “Create Signal Groups with Simulink Real-Time Explorer” on page 5-56

. “Configure Scope Sampling with Simulink Real-Time Explorer” on page 5-35
. “Trigger Scopes with Simulink Real-Time Explorer” on page 5-38

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167



Configure File Scopes with Simulink Real-Time Explorer

Configure File Scopes with Simulink Real-Time Explorer

You can configure your file scopes to facilitate data logging. You can configure a file scope
whether you added a Scope block to your model or added the scope at run time.

This procedure uses the model xpcosc. You must have already completed the procedure
in “Create File Scopes with Simulink Real-Time Explorer” on page 5-87. Target execution
and scopes must be stopped.

1

2
3

Select Scope 1, and then open the Properties pane (ﬁ on the Scopes toolbar).
In the Scope 1 Properties pane, click File.

Enter a name in the File name text box, for example scope2.dat.

File names on the target computer are limited to eight characters in length, not
counting the file extension. If the name is longer than eight characters, the software
truncates it to six characters and adds '~1' to the end of the file name.

If you enter just the file name, the file appears in folder C:\. To put the file in a
folder, create the folder separately using the target computer command line or
MATLAB language.

A fully qualified file name can have a maximum of 260 characters: The file part can
have at most 12 characters: eight for the file name, one for the period, and at most
three for the file extension. A file name longer than eight characters is truncated to
six characters followed by "~1".

If a file with this name exists when you start the file scope, the file scope overwrites
the old data with the new data.

Select File mode Commit.

The default File mode is Lazy. When real-time execution stops without an error,
both the Lazy and Commit settings of the Mode box have the same result. Both
settings cause the model to open a file, write signal data to the file, and close that file
at the end of the session. The differences are in when the software updates the FAT
entry for the file.

* In Commit mode, the FAT entry and the actual file size are updated during each
file write operation.

* In Lazy mode, the FAT entry and the actual file size are updated only when the
file is closed and not during each file write operation.
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10

11
12

Lazy mode is faster than Commit mode. However, if the target computer enters an
error state, the system can stop responding before the file is closed. In Lazy mode,
the actual file size can be lost, even though the file was written. You can lose an
amount of data equivalent to the setting of the WriteSize parameter.

To have the file scope collect data up to Number of samples and then start over
again reading new data, select the AutoRestart check box.

Leave the Dynamic File Mode check box cleared.
Leave Write Size set to the default value of 512.

Using a block size that is the same as the disk sector size improves performance.

Leave Max write file size set to the default value, which is a multiple of Write
Size.

Start execution (b on the Applications toolbar).

Caution: Before starting the scope, copy previously acquired data to the development
computer. When the file scope starts, the software overwrites previously acquired
data in files of the specified name or name pattern. A partially overwritten file or a
file that is opened but left unwritten loses its original contents.

Start Scope 1(@® on the Scopes toolbar). Let it run for up to a minute.
Stop Scope 1 ({§ on the Scopes toolbar).

Stop execution (M on the Applications toolbar).
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13 To retrieve the file from the target computer, select the file in the target computer
File System pane. Drag it to the MATLAB Current Folder pane or to a Windows
Explorer window.
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To rename file SCOPE2.DAT, right-click the file name, select Rename, type the new
name in the text box, and then click Enter.

To delete file SCOPE2 .DAT, right-click the file name and select Delete.

See Also
SimulinkRealTime.fileSystem.mkdir

More About

. “Log Signal Data into Multiple Files” on page 5-95
. “Using SimulinkRealTime.fileSystem Objects” on page 11-5

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Log Signal Data into Multiple Files

You can acquire signal data to store in multiple, dynamically named files on the target
computer. You can then examine one file while the scope continues to acquire data to
store in other files. To acquire data for multiple files, add a file scope to the real-time
application, and then configure that scope to log signal data to multiple files.

Using model xpcosc, complete the setup tasks in “Create File Scopes with Simulink
Real-Time Explorer” on page 5-87.

O b WON —

10

In Simulink Real-Time Explorer, in the Scopes pane, expand the xpcosc node.

Select File Scopes and expand node File Scopes.

Expand Scope 1 and then click the Properties button BT on the toolbar.
In the Scope Properties pane, click File.
Select the AutoRestart check box.

When you select the AutoRestart box, the file scope collects data up to Number of
samples and then starts over again reading new data. Setting AutoRestart enables
the following parameters: Dynamic file name enabled and Max file size in bytes
(multiple of WriteSize).

Select the Dynamic File Mode check box.

To enable the file scope to create multiple log files based on the same name, in the
File name box, enter a name like scopel <%>.dat.

This sequence directs the software to create up to nine log files, scopel_1.dat to
scopel_9.dat, on the target computer file system.

You can configure the file scope to create up to 99999999 files (<%%%%%%%%> . dat).
The length of a file name, including the specifier, cannot exceed eight characters.

In the Max write file size box, enter a value to limit the size of the signal log files.
This value must be a multiple of the Write Size value. For example, if the write size
is 512, enter 4096 to limit each log file size to 4096 bytes.

To start execution, click the real-time application and then click the Start
button & on the toolbar.

Cavution: Before starting the scope, copy previously acquired data to the development
computer. When the file scope starts, the software overwrites previously acquired
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11

12

13

14

data in files of the specified name or name pattern. A partially overwritten file or a
file that is opened but left unwritten loses its original contents.

To start Scope 1, click Scope 1 in the Scopes pane and then click the Start Scope
button B on the toolbar.

Let Scope 1 run for up to a minute.

To stop Scope 1, click Scope 1 in the Scopes pane and then click the Stop Scope
button HE on the toolbar.

To stop execution, click the real-time application and then click the Stop

button M on the toolbar.

To view the files that you generated, in the Targets pane, expand the target
computer, and then double-click File System.

Select C:\. The dialog box looks like this figure.
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Ready

The software creates a log file named SCOPE1_1.DAT and writes data to that file.
When the size of the first file reaches 4096 bytes (Max write file size), the software

5-97



5 Signals and Parameters

5-98

closes the first file and creates the second file, SCOPE1_2_DAT. When the size of the
second file reaches 4096 bytes, the software creates the third file, the fourth file, and
S0 on.

If the real-time application continues to collect data after the software closes
SCOPE1_9.DAT, the software reopens SCOPE1_1.DAT, SCOPE1_2.DAT, and so on,
overwriting the existing contents.

15 Drag each file from the target computer File System pane to the MATLAB Current
Folder pane or to a Windows Explorer window.

See Also

File System

More About

. “File Scope Usage” on page 5-79

. “Using SimulinkRealTime.fileSystem Objects” on page 11-5

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167
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Log Signal Data with Outport Blocks and Simulink Real-Time
Explorer

To use Simulink Real-Time Explorer for signal logging, add an Outport block to your
Simulink model. Activate logging on the Data Import/Export pane in the Configuration
Parameters dialog box.

To access the data log that the real-time application creates when it is running on the
target computer, use Real-Time Application Properties.

The example begins with the model ex_slrt_rt_osc (matlab:
open_system(docpath(fullfile(docroot, "toolbox®, "xpc®, "examples”®,
"ex_slrt_rt_osc")))). The final configured model is ex_slrt_outport_osc
(matlab: open_system(docpath(fullfile(docroot, "toolbox®", "xpc”,
"examples®™, "ex_slrt_outport_osc")))):

nooo num(s)
> " >
0o SigGen den(s) Xt
Signal Transfer Fon M | Scopel
Generator
SigGen -
g +— (1)
Tutorial model ready Ot
to build target application
-

Target Scope
Id: 1

Scopa (xPC)

The logged outputs are the signals connected to Simulink Outport blocks. The model has
one Outport block, with index 1. This Outport block shows the signals leaving the block
labeled Mux.

In this section...

“Data Logs” on page 5-100

“Configure the Model for Data Logging” on page 5-101
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In this section...

“Log the Data” on page 5-101
“Download and Plot the Data” on page 5-101

Data Logs

Simulink Real-Time stores logged data in four data logs that you can access on the
development computer by using Real-Time Application Properties. In the following list,
tg is the name of the Simul inkReal Time.target object that you use to communicate
with the target computer.

+ tg.TimeLog — Time or T-vector, specified as a vector of double. To turn on, in the
Data Import/Export pane, set the Time model parameter.

+ tg.OutputlLog — Output or Y-vector, specified as a matrix. To turn on, in the Data
Import/Export pane, set the Output model parameter.

+ tg.TETLog — Task-execution-time vector, specified as a vector of double. To turn
on, in the Simulink Real-Time Options pane, set the Log Task Execution Time
model parameter.

+ tg.Statelog — State or X-vector, specified as a matrix. To turn on, in the Data
Import/Export pane, set the State model parameter.

Turn on logging for only the data that you are interested in.

Each Outport block has an associated column vector in tg.OutputLog. You can access
the data that corresponds to a particular Outport block by specifying the column vector
for that block. For example, to access the data that corresponds to Outport 2, use
tg.outputlog(:,2).

To download part of the logs, use the target object method
SimulinkRealTime.target.getlog.

Note:

* The data logging variables tout, xout, yout, and logsout are available only when
you use Simulink to simulate the model in non-real-time.

*  You cannot use Simulation Data Inspector to create a data log on the target computer.
You can log only signals that are connected to an Outport block.
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Configure the Model for Data Logging

6

Click Simulation > Model Configuration Parameters.

To allow Simulink to log signals, in the Data Import/Export pane, check that
the Time and Output check boxes are selected. These check boxes are selected by
default.

To plot the task execution time, in the Code Generation > Simulink Real-Time
Options pane, check that the Log Task Execution Time parameter is selected.
This check box is selected by default.

To create a buffer for the signals that you are logging, set Signal logging buffer
size in doubles to the required value.

The default value of 100000 units is large enough for this model.

From the File menu, click Save as.

Enter ex_slrt_outport_osc (matlab:
open_system(docpath(fullfile(docroot, "toolbox®, "xpc-,
"examples®™, "ex_slrt_outport osc")))). Click Save.

Click OK.

Log the Data

1

2
3

In the Simulink Editor, on the toolbar, click the Build Model button .

Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).

To connect to the target computer in the Targets pane, click the Connect button
5! on the toolbar.

To start execution, click the real-time application, and then on the toolbar, click the
Start button B

To stop execution, click the real-time application, and then on the toolbar, click the
Stop button M.

Download and Plot the Data

1

Download and plot the logged times and output values from the target computer. In
the Command Window, type:
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tg = slrt;

timelog = tg.TimelLog;
outputlog = tg.OutputlLog;
plot(timelog, outputlog)

l Figure 1 . . ._.

File Edit View Insert Tools Desktop Window Help o
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2 Download and plot the task execution times for the target computer. In the
Command Window, type:
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tetlog = tg.-TETLog;
plot(timelog, tetlog)

o i

zlﬁgurel =nae [é]
File Edit View Insert Tools Desktop Window Help o
NEEL K AAUDEL 2|08 aD
-7
T XJ]ﬂ T T T T T T T T T
ﬁ - =
5 - -

The plot shown is the result of a real-time execution.

3 In the Command Window, type:

5-103



5 Signals and Parameters

tg-AvgTET

ans =
5.7528e-006

The percentage of CPU performance is the average TET divided by the sample time.

Task execution time (TET) measures how long it takes the kernel to run for one base-rate

time step. For a multirate model, use the profiler to find out what the execution time is
for each rate.

See Also

Real-Time Application Properties | SimulinkRealTime.target.getlog

More About

. “Simulate Simulink Model with MATLAB Language”
. “Log Signal Data with Outport Block and MATLAB Language” on page 5-105

“Display and Filter Hierarchical Signals and Parameters” on page 5-167
. “Signal Logging Buffer Size” on page 5-112
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Log Signal Data with Outport Block and MATLAB Language

To use MATLAB language for signal logging, add an Outport block to your Simulink
model. Activate logging by using MATLAB commands.

To access the data log that the real-time application creates when it is running on the
target computer, use Real-Time Application Properties.

The example begins with the model ex_slrt_rt_osc (matlab:
open_system(docpath(fullfile(docroot, “toolbox®, *xpc®, "examples-®,
"ex_slrt_rt_osc")))). The final configured model is ex_slrt_outport_osc
(matlab: open_system(docpath(fullfile(docroot, "toolbox®", "xpc”,
"examples®™, "ex_slrt_outport _osc")))):

DGDGD O . numis) |—|

» > >
SigGen den(s) HfrFne
Signal Transfer Fcn TR N Scopel
Genarator
SigGen -
g +— (1)
Tutorial model ready Chutl

to build target application

Y

Target Scope
Id: 1

Scopa (xPC)

The logged outputs are the signals connected to Simulink Outport blocks. The model has
one Outport block, with index 1. This Outport block shows the signals leaving the block
labeled Mux.

In this section...

“Data Logs” on page 5-106

“Configure the Model for Data Logging” on page 5-107
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In this section...

“Log the Data” on page 5-107

“Download and Plot the Data” on page 5-108

Data Logs

Simulink Real-Time stores logged data in four data logs that you can access on the
development computer by using Real-Time Application Properties. In the following list,
tg is the name of the Simul inkReal Time. target object that you use to communicate
with the target computer.

+ tg.TimeLog — Time or T-vector, specified as a vector of double. To turn on, set the
SaveTime model parameter.

* tg.OutputLog — Output or Y-vector, specified as a matrix. To turn on, set the
SaveOutput model parameter.

+ 1tg.TETLog — Task-execution-time vector, specified as a vector of double. To turn on,
set the RL32LogTETMod i Fier model parameter.

+ tg.StatelLog — State or X-vector, specified as a matrix. To turn on, set the
SaveState model parameter.

Turn on logging for only the data that you are interested in.

Each Outport block has an associated column vector in tg.OutputLog. You can access
the data that corresponds to a particular Outport block by specifying the column vector
for that block. For example, to access the data that corresponds to Outport 2, use
tg.outputlog(:,2).

To download part of the logs, use the target object method
SimulinkRealTime. target.getlog.

Note:

* The data logging variables tout, xout, yout, and logsout are available only when
you use Simulink to simulate the model in non-real-time.

*  You cannot use Simulation Data Inspector to create a data log on the target computer.
You can log only signals that are connected to an Outport block.
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Configure the Model for Data Logging

1

Open model ex_slrt_rt_osc.

mdl = "ex_slrt_rt _osc”;
open_system(mdl);

Check that signal data and task execution time are being logged.
get_param(mdl, "SaveTime")

ans =

on
get_param(mdl, "SaveOutput®)

ans =

on

get_param(mdl, "RL32LogTETModifier™)
ans =

on

These parameters are set to "on" by default.

Check that Signal logging buffer size in doubles is set to a value large enough to
accommodate the number of signals that you are logging.

get_param(mdl, "RL32LogBufSizeModifier”™)
ans =
100000

The default value of 100000 units is large enough for this model.

Save the model under a new name.

save_system(mdl, "ex_slrt_outport_osc");

Log the Data

1

Build the real-time application.
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rtwbuild(mdl);

2 Start execution.

tg = slrt;
tg.stoptime = 1;
start(tg);

3  Stop execution.

stop(tg);

Download and Plot the Data

1 Download and plot the logged times and output values from the target computer. In
the Command Window, type:

tg = slrt;

timelog = tg.TimelLog;
outputlog = tg.OutputlLog;
plot(timelog, outputlog)
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2 Download and plot the task execution times for the target computer. In the
Command Window, type:

tetlog = tg-TETLog;
plot(timelog, tetlog)
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The plot shown is the result of a real-time execution.

3 In the Command Window, type:
tg.AvgTET

ans =
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5.7528e-006
The percentage of CPU performance is the average TET divided by the sample time.

Task execution time (TET) measures how long it takes the kernel to run for one base-rate

time step. For a multirate model, use the profiler to find out what the execution time is
for each rate.

See Also

Real-Time Application Properties | Simul inkRealTime.target.getlog

More About
. “Simulate Simulink Model with MATLAB Language”

. “Log Signal Data with Outport Blocks and Simulink Real-Time Explorer” on page
5-99

. “Signal Logging Buffer Size” on page 5-112
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Signal Logging Buffer Size

5-112

Your real-time application sets aside a buffer for data logging. You specify the buffer size
in the Code Generation > Simulink Real-Time Options pane of the Configuration
Parameters dialog box. Set Signal logging buffer size in doubles to a value large
enough to accommodate the logged signals.

The default buffer size is 100000 units (800000 bytes). Specify only the number of units
that you need. Memory dedicated to data logging is not available for scopes and other
Simulink Real-Time features.

The Simulink Real-Time software calculates the number of samples N for a signal using
this formula:

N = Buffer size in doubles / Logged signals

In this equation, Logged signals, the number of logged signals, breaks down as
follows:

+ 1 for time

+ 1 for task execution time

+ 1 for each logged output

+ 1 for each logged state

The scopes copy the last N samples from the log buffer to the target object logs
(tg-TimelLog, tg.OutputlLog, tg.Statelog, and tg. TETLOQ).
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Configure File Scopes with MATLAB Language

This procedure shows how to trace signals with file scopes using the Simulink model
Xpcosc. You must have already built and downloaded the real-time application for this
model. It also assumes that you are using a serial link.

Note: The signal data file can quickly increase in size. To gauge the growth rate of the
file, examine the file size between runs. If the signal data file grows beyond the available
space on the disk, the signal data is corrupted.

1 Create a target object tg that represents target computer TargetPC1l. Type:

tg = SimulinkRealTime.target("TargetPC1")

2 To get a list of signals, type:

tg-ShowSignals

= "on"

The Command Window displays a list of the target object properties for the available
signals. For example, these signals are part of the model xpcosc:

Target: TargetPCl

Connected
Application

Scopes
NumSignals
ShowSignals
Signals
INDEX VALUE
0 0.000000
1 0.000000
2 0.000000
3 0.000000
4 0.000000
5 0.000000
6 0.000000

= Yes

= Xpcosc

=1

=7

= on

Type BLOCK NAME LABEL
DOUBLE Gain

DOUBLE Gainl

DOUBLE Gain2

DOUBLE Integrator
DOUBLE Integratorl
DOUBLE Signal Generator
DOUBLE  Sum
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3 Start running your real-time application. Type:

start(tg)

4 Create a scope to be displayed on the target computer. For example, to create a scope
with an identifier of 2 and a scope object name of sc2, type:

sc2 = addscope(tg, "file", 2)

No name is initially assigned to Fi leName. After you start the scope, Simulink Real-
Time assigns a name for the file to acquire the signal data. This name typically
consists of the scope object name, Scopeld, and the beginning letters of the first
signal added to the scope.

sc2 =

Simulink Real-Time Scope

Application = Xpcosc
Scopeld =2

Status = Interrupted
Type = File
NumSamples = 250
NumPrePostSamples =0
Decimation =1
TriggerMode = FreeRun
TriggerSignal = -1
TriggerLevel = 0.000000
TriggerSlope = Either
TriggerScope =2
TriggerSample =0
FileName = unset
WriteMode = Lazy
WriteSize = 512
AutoRestart = off
DynamicFileName = off
MaxWriteFileSize = 536870912

Signals no Signals defined

5 Add signals to the scope object. For example, to add Integratorl and Signal
Generator, type:

addsignal (sc2, [4,5])

sc2 =
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Simulink Real-Time Scope

Application = Xpcosc

Scopeld =2

Status = Interrupted

Type = File

FileName = unset

WriteMode = Lazy

WriteSize = 512

AutoRestart = off

DynamicFileName = off

MaxWriteFileSize = 536870912

Signals = 4 : Integratorl
5 : Signal Generator

The target computer displays the following messages:
Scope: 2, signal 4 added

Scope: 2, signal 5 added

After you add signals to a scope object, the file scope does not acquire signal values
until you start the scope.

Cavution: Before starting the scope, copy previously acquired data to the development
computer. When the file scope starts, the software overwrites previously acquired
data in files of the specified name or name pattern. A partially overwritten file or a
file that is opened but left unwritten loses its original contents.

Start the scope. For example, to start scope sc2, type:

start(sc2)

The Command Window displays a list of the scope object properties. Fi leName is
assigned a default file name to contain the signal data for the file scope. This name
typically consists of the scope object name, Scopeld, and the beginning letters of the
first signal added to the scope.

Application= xpcosc

Scopeld =2
Status = Pre-Acquiring
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Type = File
FileName = c:\sc2lnteg.dat
Mode = Lazy
WriteSize = 512
AutoRestart= off
DynamicFileName = off
MaxWriteFileSize = 536870912
Signals = 4 : Integratorl
5 : Signal Generator

7  Stop the scope. Type:

stop(sc2)
8 Stop the real-time application. In the Command Window, type:

stop(tg)

See Also

plot | SimulinkRealTime.fileSystem |
SimulinkRealTime.utils._getFileScopeData

More About

. “Using SimulinkRealTime.fileSystem Objects” on page 11-5
. “Monitor Signals with MATLAB Language” on page 5-8
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Tune Parameters with Simulink Real-Time Explorer

You can use Simulink Real-Time Explorer to change parameters in your real-time
application while it is running or between runs. You do not need to rebuild the Simulink
model, set the Simulink interface to external mode, or connect the Simulink interface
with the real-time application.

This procedure uses the model xpcosc.

Set Up Host Scope

Before tuning parameters, do the following:

1

o 0 A WODN

10

11

Build and download model xpcosc to the target computer with Simulink (#3 on the
toolbar).

Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).
Connect to the target computer that is in the Targets pane (3! on the toolbar).
Set property Stop time to inf in the Applications pane (E} on the toolbar).

In the Scopes pane, expand the xpcosc node.

To add a host scope, select Host Scopes, and then click the Add Scope
button BB on the toolbar.

In the Applications pane, expand the real-time application node, and then the node
Model Hierarchy.

Double-click the xpcosc node.
To add signal Signal Generator to Scopel, drag signal Signal Generator from
the xpcosc signal list to the Scopel properties workspace.

Add signal Integratorl to Scopel in the same way.

Expand Scope 1, and then click the Properties button ET on the toolbar.

To display the host scope signals, in the Scope Properties pane, click Signals.
To open the host scope display, select Scope 1, and then click the View Scope
button Bl on the toolbar.

See “Create Host Scopes with Simulink Real-Time Explorer” on page 5-64.
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Initial Values

1 To view the initial parameter values, in the Applications pane, expand both the
real-time application node and node Model Hierarchy.

2 Select the model node, and then click the View Parameters button E_I on the
toolbar.

Start Scope 1(@® on the toolbar).

4 Start execution (& on the toolbar).
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4\ Simulink Real-Time Explorer E@
File Edit View Window Help
G E@ B RER A, AR hTE &S o i gy BB
Targets - Ix ) I TargetPCl/xpcosc/Scope 1 (Host Scope Viewer) ~ X |Palette - 0 x
# & om E D'Q SYS! 4 Instruments = |
® Pointer

4 MATLAB Session
I 5= TargetPCl &
I Bm TargetPC2 &
I B TargetPC3 &

&) Knob

L NumericEntry
o slider
= SwitchLED
L& NumericalUpDownEnt
(Al GaugeAngular
o Gaugelinear

@ LED .
4 = Jll‘ = »
Applications 0 x Panels > 1 x
- d L] :\;,; = |E| Instrument Panels
4 TargetPCl/ixpcosc &
.:&}Properties
I Groupings
4 Model Hierarchy [ xpcosc (TargetpCl) ‘ - %
%] xpeosc -
Contents of: xpcosc (only) Fulte o
Name Block Name Full Path Value .
H Gan Gain xpeosc 1000000.000000 | _
H Gain Gainl xpeosc 400000000
\EJ Gain Gain2 XpCosc 1000000.000000 Properties -0 x
Scopes + 0 x \E:I InitialCondition Integrator Xprosc g 0.000000 . g: 2]
moEfmEn ‘|' SRR - -
4 TargetPClixpcosc .Output - 0 x
4 Host Scopes
4 |Scope 1
EProperties
Target Scopes
File Scopes

Ready

Updated Values

To update a parameter value:

1 In the Applications pane, expand both the real-time application node and node

Model Hierarchy.
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Select the model node, and then click the View Parameters button ﬁ_—l on the
toolbar.

The Parameters workspace opens, showing a table of parameters with properties and
actions.

To change the value of the Gain for block Gainl to 100, type 100 into the Value
box, and then press Enter.

To revert the Gain for block Gainl to its previous value, click the Revert button @

Click the Apply parameter value(s) changes button BE‘&

Simulink Real-Time Explorer looks like this figure.
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4\ Simulink Real-Time Explorer E@
File Edit View Window Help
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4 MATLAB Session ] 4 * ED'”:'
| 5- TargetPCL & ntegratorl: et nol ) -
I Bm TargetPC2 & Signal Generator:1 i NumericEntry
%k Slider
I TargetPC3 &
B Terg = SwitchLED

L& NumericalUpDownEnt
(Al GaugeAngular

o Gaugelinear

@ LED

4 m 5
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Applications 0 x
B MG EH
4 TargetPCl/ixpcosc &
.;‘;?Properties
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“ M"dfl Hierarchy [}}| xpeosc (TargetPCL) | > £
%] xpeosc
Contents of: xpcosc (only) o
Name Block Name Full Path Value
2] Gain Gain Xpeosc ¥ 1000000.000000 | _
‘m Gain Gainl xpeosc % @ 100.000000
H Gain Gain2 xpeosc 1000000.000000
Scopes T 1 x ‘E:l InitialCondition Integrator xpcosc 0.000000
mrmEf@mD J Ee—— n :
4 TargetPCl/xpcosc .Output - x
4 Host Scopes
4 |Scope 1
ﬂProperties
Target Scopes
File Scopes

Ready

Instrument Panels

Properties

% 3l

5 Stop Scope 1 (f§ on the toolbar).
6 Stop execution (M on the toolbar).

Simulink Real-Time does not support parameters of multiword data types.

To make both workspaces visible at the same time, drag one workspace tab down until

the © 7 icon appears in the middle of the dialog box. Continue to drag the workspace until
the cursor reaches the required quadrant, and then release the mouse button.
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To save your Simulink Real-Time Explorer layout, click File > Save Layout. In a later
session, you can click File > Restore Layout to restore your layout.

More About

. “Create Host Scopes with Simulink Real-Time Explorer” on page 5-64

. “Configure Real-Time Host Scope Blocks” on page 5-60

. “Create Parameter Groups with Simulink Real-Time Explorer” on page 5-123
. “Display and Filter Hierarchical Signals and Parameters” on page 5-167

. “Nonobservable Parameters” on page 5-174
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Create Parameter Groups with Simulink Real-Time Explorer

When testing a complex model composed of many reference models, you tune parameters
from multiple parts and levels of the model. To do so, create a parameter group.

This procedure uses the model xpcosc. You must have already completed the following
setup:

1

Built and downloaded the real-time application to the target computer using
Simulink (83 on the toolbar).

Run Simulink Real-Time Explorer (Tools > Simulink Real-Time).

Connected to the target computer in the Targets pane (5! on the toolbar).

To create a parameter group:

1

In the Applications pane, expand the real-time application node, and then right-
click the Groupings node.

Click New Parameter Group.

In the Add New Parameter Group Item dialog box, enter a name in the Name text
box (for example, ParamGroupl.par). In the Location text box, enter a folder for
the group file.

Click OK. A new parameter group appears, along with its Parameter Group
workspace.

In the Applications pane, expand both the real-time application node and the node
Model Hierarchy.

Select the model node, and then click the View Parameters button E_l on the
toolbar.

The Parameters workspace opens, showing a table of parameters with properties and
actions.

In the Parameters workspace, to add parameter Amplitude to ParamGroupl.par,
drag parameter Ampl itude to the ParamGroupl.par properties workspace.

Add parameter Frequency to ParamGroupl.par in the same way.

Press Enter, and then click the Save button E on the toolbar.
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Parameters are defined within a particular real-time application. To open a parameter
group from the File > Open > Group menu, you must first select an application.

To remove parameters from the parameter group, select the parameter items in the
group list and click Delete Parameters.

To remove the parameter group, navigate to the parameter group under Groupings >
Parameters, right-click the parameter group, and click Remove.
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To make both workspaces visible at the same time, drag one workspace tab down until

the © 7 icon appears in the middle of the dialog box. Continue to drag the workspace until
the cursor reaches the required quadrant, and then release the mouse button.

To save your Simulink Real-Time Explorer layout, click File > Save Layout. In a later
session, you can click File > Restore Layout to restore your layout.

More About

. “Tune Parameters with Simulink Real-Time Explorer” on page 5-117

. “Display and Filter Hierarchical Signals and Parameters” on page 5-167

5-125



5 Signals and Parameters

Tune Parameters with MATLAB Language

5-126

You use the MATLAB functions to change block parameters. With these functions, you do
not need to set the Simulink interface to external mode. You also do not need to connect
the Simulink interface with the real-time application.

You can download parameters to the real-time application while it is running or between
runs. You can change parameters in your real-time application without rebuilding the
Simulink model and change them back to their original values. using Simulink Real-
Time functions.

Note:

Simulink Real-Time does not support parameters of multiword data types.

Parameter access by parameter index will be removed in a future release. Access
parameters by parameter name instead.

Method names are case-sensitive and must be complete. Property names are not case-
sensitive and do not need to be complete, as long as they are unique.

This procedure uses the Simulink model xpcosc. You must have already created and
downloaded the real-time application to the default target computer.

1

In the Command Window, type:

tg = slrt;

start(tg)

The target computer displays the following message:

System: execution started (sample time: 0.001000)
Display a list of parameters. Type:

tg.ShowParameters = “on”
The ShowParameters command displays a list of properties for the target object.

Target: TargetPCl
Connected = Yes



Tune Parameters with MATLAB Language

Application= xpcosc

NumParameters =7
ShowParameters = on
Parameters =
VALUE TYPE SI1ZE PARAMETER NAME BLOCK NAME
1000000 DOUBLE Scalar Gain Gain
400 DOUBLE Scalar Gain Gainl
1000000 DOUBLE Scalar Gain Gain2
0 DOUBLE Scalar InitialCondition Integrator
0 DOUBLE Scalar InitialCondition Integratorl
4 DOUBLE Scalar Amplitude Signal Generator
20 DOUBLE Scalar Frequency Signal Generator

Change the gain. For example, to change the Gainl block, type:

pt = setparam(tg, “Gainl®, “Gain®, 800)
The setparam method returns a structure that stores the source information, the

previous value, and the new value.

When you change parameters, the changed parameters in the target object are
downloaded to the real-time application. The development computer displays the
following message:

pt =
Source: {"Gainl-"

Oldvalues: 400
NewValues: 800

"Gain"}

The real-time application runs. The plot frame updates the signals for the active
scopes.

Stop the real-time application. In the Command Window, type:

stop(tg)

To reset to the previous values, type:

pt = setparam(tg, pt-Source{l}, pt.Source{2}, pt.OldValues)
pt =
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Source: {"Gainl® “Gain"}
Oldvalues: 800
NewValues: 400

More About

. “Nonobservable Parameters” on page 5-174
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Tune Parameters with Simulink External Mode

You use Simulink external mode to connect your Simulink model to your real-time
application. The model becomes a user interface to your real-time application. You set up
the Simulink interface in external mode to establish a communication channel between
your Simulink model and your real-time application.

In Simulink external mode, when you change parameters in the Simulink model,
Simulink downloads those parameters to the real-time application while it is running.
You can change parameters in your program without rebuilding the Simulink model to
create a new real-time application.

Note: Simulink Real-Time does not support parameters of multiword data types.

After you download your real-time application to the target computer, you can connect
your Simulink model to the real-time application. This procedure uses the Simulink
model Xpcosc. You must have already built and downloaded the real-time application for
that model.

1 In the Simulink editor, click Simulation > Mode > External. A check mark
appears next to the menu item External, and Simulink external mode is activated.

2 (Click the Run button (») on the toolbar.

The real-time application begins running on the target computer, and the target
computer displays the following message:
System: execution started (sample time: 0.000250)

3 From the Simulation block diagram, double-click the block labeled Gainl

4 In the Block Parameters: Gainl parameter dialog box, the Gain text box, enter 800.
Click OK.

When you change a MATLAB variable and click OK, the changed parameters in the
model are downloaded to the real-time application.

5 From the Simulation menu, click Disconnect from Target.

The Simulink model is disconnected from the real-time application. If you then
change a block parameter in the Simulink model, the real-time application does not
change.
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6 Inthe Command Window, type:

tg = slrt("TargetPC1")

stop(tg)
More About
. “Nonobservable Parameters” on page 5-174
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Save and Reload Parameters with MATLAB Language

After you have a set of real-time application parameter values, save those values to a file
on the target computer. You can then later reload these parameter values to the same
real-time application.

You can save parameters from your real-time application while the real-time application
1s running or between runs. You can save and restore parameters in your real-time
application without rebuilding the Simulink model. Load parameters to the same model

from which you save the parameter file. If you load a parameter file to a different model,
the behavior is undefined.

You save and restore parameters with the target object methods saveparamset and
loadparamset.

Requirements:

* You have a real-time application object named tg.
* You have assigned tg to the target computer.
*  You have downloaded a real-time application to the target computer.

* You have parameters to save.

In this section...

“Save the Current Set of Real-Time Application Parameters” on page 5-131
“Load Saved Parameters to a Real-Time Application” on page 5-132

“List Parameter Values Stored in a File” on page 5-132

Save the Current Set of Real-Time Application Parameters

To save a set of parameters to a real-time application, use the saveparamset

method. This example uses the model ex_slrt_outport_osc (matlab:
open_system(docpath(fullFile(docroot, "toolbox®, "xpc", "examples”®,
"ex_slrt_outport_osc")))). The real-time application can be stopped or running.

1 Identify the set of parameter values that you want to save.

2 Select a descriptive file name for the parameters. For example, use the model name
in the file name.
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3 Inthe Command Window, type:

tg = slrt;
saveparamset(tg, “ex_slrt_outport_osc_paraml®)

The Simulink Real-Time software creates a file named
ex_slrt_outport_osc_paraml in the current folder of the target computer, for
example, C:\ex_slrt_outport_osc_ paraml

Load Saved Parameters to a Real-Time Application

To load a set of saved parameters to a real-time application, use the loadparamset
method.

Load parameters to the same model from which you save the parameter

file. If you load a parameter file to a different model, the behavior is

undefined. This example uses the model ex_slrt_outport_osc (matlab:
open_system(docpath(fullfile(docroot, "toolbox", "xpc", "examples”®,
"ex_slrt_outport_osc")))).

This section assumes that you have a parameters file saved from an earlier run of
saveparamset (see “Save the Current Set of Real-Time Application Parameters” on
page 5-131).

1  From the collection of parameter value files on the target computer, select the one
that contains the parameter values you want to load.

2 Inthe Command Window, type:

tg = slirt;
loadparamset(tg, "ex_slrt_outport_osc_paraml®)

The Simulink Real-Time software loads the parameter values into the real-time
application.

List Parameter Values Stored in a File

To list parameters and their values, load the file for a real-time application, and then
turn on the ShowParameters target object property.

You must have a parameters file saved from an earlier run of saveparamset (see “Save
the Current Set of Real-Time Application Parameters” on page 5-131).
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1  Stop the real-time application. In the Command Window, type:

stop(tg)
2 Load the parameter file. Type:

tg = slirt;

loadparamset(tg, “ex_slrt_outport_osc_paraml®);
3 Display a list of parameters. Type:

tg.ShowParameters = “on

The Command Window displays a list of parameters and their values for the target

object.
More About
. “Load a parameter set from a file on the designated target file system”
. “Tune Parameters with Simulink Real-Time Explorer” on page 5-117
. “Tune Parameters with MATLAB Language” on page 5-126
. “Tune Parameters with Simulink External Mode” on page 5-129
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Tunable Block Parameters and MATLAB Variables
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To change the behavior of a real-time application, you can tune Simulink Real-Time
tunable parameters. In Simulink external mode, you can change the parameters directly
in the block or indirectly by using MATLAB variables. Simulink Real-Time Explorer and
MATLAB language enable you to change parameter values and MATLAB variables as
your real-time application is executing.

Note: Simulink Real-Time does not support parameters of multiword data types.

Tunable Parameters

Simulink Coder defines two kinds of tunable parameters that can be modified during
execution: block parameters and MATLAB variables.

Block Parameters

A tunable block parameter is a literal expression that you reference in a Simulink block
dialog box.

Suppose that you assign the value 5/2 to the Amplitude parameter of a Signal
Generator block. Amplitude is a tunable parameter.

MATLAB Variables

A tunable MATLAB variable is a variable in the MATLAB workspace that you reference
in a Simulink block dialog box.

Suppose that you enter A in the Amplitude parameter of a Signal Generator block.
Variable A is a tunable parameter.

You can tune the values of MATLAB variables that are grouped in a parameter
structure. For example:

Assign a parameter structure that contains the field Ampl to variable A.
2 Enter A.Ampl in the Amplitude parameter of a Signal Generator block.

3 Change the amplitude of the signal generator by tuning the value of A.Ampl in the
MATLAB workspace during simulation.
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Inlined Parameters

To optimize execution efficiency, you can change the Default parameter behavior
option from Tunable to Inlined in the Signals and Parameters pane of the
Optimization node.

You cannot tune inlined block parameters. However, you can define a tunable MATLAB
variable or Simul ink_Parameter object, enter it in the parameter in the block dialog
box, and tune the variable or object.

For more information about inlined parameters, see “Default parameter behavior”
(Simulink).
Tuning in External Mode

In external mode, Simulink Real-Time connects your Simulink model to your real-time
application. The block diagram becomes a user interface for the real-time application.

You can change a block parameter value during execution in the block dialog box. When
you click OK, Simulink transfers the new value to the real-time application.

You can also change a tunable MATLAB variable during execution in the MATLAB
workspace. You must then explicitly command Simulink to transfer the data by pressing
Ctrl+D or clicking Simulation > Update Diagram.

Tuning with Simulink Real-Time Explorer

During real-time execution, Simulink Real-Time Explorer becomes a user interface for
the real-time application.

To access a block parameter value, navigate to the block in the Explorer model hierarchy.
You can change the value in a text entry box in the parameter window. When you apply

the new value, Simulink Real-Time transfers the new value to the real-time application.

You can access a tunable MATLAB variable at the top level of the model hierarchy.
Change it the same way as you would a tunable block parameter.

You can also use Simulink Real-Time Explorer instrument panels to tune block
parameters and MATLAB variables.
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Tuning with MATLAB Language

To change the values of tunable block parameters and MATLAB variables during
execution, use the Simulink Real-Time command setparam. The following code
examples use the model xpcosc.

To change a block parameter value, use a nonempty block path and the parameter name.
For example, to change the amplitude of the signal generator:

tg = slirt;
setparam(tg, °“Signal Generator®, “Amplitude®, 4.57)

To change a tunable MATLAB variable, use the variable name. For example, to change
the amplitude of the signal generator via the parameter structure field A.Ampl:

tg = slrt;
setparam(tg, “A.Ampl®, 4.57)

See Also

SimulinkRealTime.target.getparam | SimulinkRealTime.target.setparam

More About
. “Tune Inlined Parameters with Simulink Real-Time Explorer” on page 5-137
. “Default parameter behavior” (Simulink)

. “Specify Source for Data in Model Workspace” (Simulink)

. “Nonobservable Parameters” on page 5-174

. “Tune and Experiment with Block Parameter Values” (Simulink)

. “Share and Reuse Block Parameter Values by Creating Variables” (Simulink)
. “Block Parameter Representation in the Generated Code” (Simulink Coder)

. “Configure Block Parameter Tunability for Rapid Prototyping” (Simulink Coder)
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Tune Inlined Parameters with Simulink Real-Time Explorer

This procedure describes how you can tune inlined parameters through the Simulink
Real-Time Explorer.

Note: Simulink Real-Time does not support parameters of multiword data types.

The following procedure starts with the Simulink model Xpcosc and produces the model
ex_slrt_inlined_osc (matlab: open_system(docpath(fullfile(docroot,
“toolbox™, *©

xpc®, "examples®, "ex_slrt_inlined_osc")))).

Configure Model to Tune Inlined Parameters
1 Inthe Command Window, type Xxpcosc. The model is displayed in the Simulink
Editor.

2 Select the blocks containing the parameters that you want to tune. For example, this
procedure makes the Amplitude parameter of the Signal Generator block tunable.
To represent the amplitude, use the variable A.

3 Double-click the Signal Generator block, and then enter A for the Amplitude
parameter. Click OK.

4 Inthe Command Window, assign a constant to that variable. For example, type:
A =4

The value is displayed in the MATLAB workspace.
5 From the Simulink Editor, click Simulation > Model Configuration Parameters.

6 In the Configuration Parameters dialog box, select the Signals and Parameters
node under Optimization.

7 In the right pane, set Default parameter behavior to Inlined.
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e c ion P xpcosc/C

(Active)

% Commonly Used Parameters

= All Parameters

= e ]

Select:
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Data Import/Export
Optimization
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Hardware Implementation
Model Referencing
Simulation Target
4 Code Generation
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Symbols
Custom Code
Simulink Real-Time Options
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> Coverage
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Code generation

Default parameter behavior: [7] nline invariant signals
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Help
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8 Click Configure.

The Model Parameter Configuration dialog box opens. The MATLAB workspace

contains

9 Select the line that contains your constant. Click Add to table.

the constant you assigned to A.
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P

ﬂ Model Pararneter Configuration: xpcosc E \EI

Description

Define the global ftunable) parameters for your model. These parameters will affect the generated code by enabling access to parameters

Source list Glohal dunable) parameters

|T'-'1P~TLP~B workspace V| Mame Storage class Storage tvpe qualifier

SimulinkGlobal {Auta) L
1A
Mame
1 _

Refresh list I ety

Ready ok || cancet || Hew |

-

Add the remaining global parameters that you want to tune.
10 Click Apply, and then click OK.
11 In the Configuration Parameters dialog box, click Apply, and then OK.

12 Save the model. For example, save it as ex_slrt_inlined_osc (matlab:
open_system(docpath(fullfile(docroot, "toolbox", "xpc*
"examples®, "ex_slrt_inlined_osc")))).

13 Build and download the model to your target computer.

5-139



5 Signals and Parameters

5-140

Initial Value

1

Select the real-time application in the Applications pane (for example,
ex_slrt_inlined_osc).

To start execution, click the real-time application, and then click the Start
button & on the toolbar.

To start Scope 1, click Scope 1 in the Scopes pane, and then click the Start Scope
button B on the toolbar.

In the Applications pane, expand both the real-time application node and the
Model Hierarchy node.

Select the model node, and then click the View Parameters button E_I on the
toolbar. The Parameters workspace opens, showing a table of parameters with
properties and actions.
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4\ Simulink Real-Time Explorer =2 =R ===
File Edit  View Window Help
ARSI = = I A= ol W RNt A o =N =R e | I N =
Targets - x Il TargetPC1/xpcosc/Scope 1 (Host Scope Viewer) + X |Palette 0 x
X Ba & [ D{)‘- 2Q | Qin mE F 4 Instruments =1
4 MATLAB Session ® Pointer
I 5w TargetPC1 & — Integratorl:1 '_ Knob ] 4
I B TargetPC2 & Signal Generator:1 i ;\‘Jdn;erlcEntry
I Bm TargetPC3 & L

L& NumericalUpDownEnt
. GaugeAngular

# Gaugelinear

@ LED .

4 m ] »

Panels ~ X

Instrument Panels

Applications
>mG = E
4 TargetPCl/xpcosc &
{3 Properties
I Groupings
4 Model Hierarchy
%] xpcosc
[ #pcosc (TargetPCl) | - X
Contents of: xpcosc (only) Filter "
Name Block Name Full Path Value Is Edited|
\EJ A Model Parameters  xpcosc g 4.000000 False
Scopes >0 x
MIrEf@m
4 TargetPCl/xpcosc < m »
4 Host Scopes -
OQutput > I x

I |Scope 1
Target Scopes
File Scopes

Ready

Properties > X

[CER
@=L

Updated Value

1 To change the value of MATLAB variable A to 2, type 2 into the Value box, and then

press Enter.

To revert the value of A to its previous value, click the Revert button @

Click the Apply parameter value(s) changes button EE&

The dialog box looks like this figure.
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4\ Simulink Real-Time Explorer

File Edit  View Window
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3 To stop Scope 1, click Scope 1 in the Scopes pane, and then click the Stop Scope
button H§ on the toolbar.
4 To stop execution, click the real-time application, and then click the Stop
button M on the toolbar.

More About
. “Tune Inlined Parameters with MATLAB Language” on page 5-143
. “Display and Filter Hierarchical Signals and Parameters” on page 5-167

. “Nonobservable Parameters” on page 5-174
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Tune Inlined Parameters with MATLAB Language

This procedure describes how you can tune inlined parameters through the

MATLAB interface. You must have already built and downloaded the model
ex_slrt_inlined_osc (matlab: open_system(docpath(fullfile(docroot,
"toolbox", "xpc®, "examples®, "ex_slrt_inlined osc")))). The model must
already be running.

Note: Simulink Real-Time does not support parameters of multiword data types.

You can tune inlined parameters using a parameter ID.

* To get the ID of the inlined parameter that you want to tune, use the getparamid
function. For the block_name parameter, leave a blank (" 7).

* To set the new value for the inlined parameter, use the setparam function.
1  Save the following code in a MATLAB file. For example, change_inlineA.

tg = slrt; %Create Simulink Real-Time object
pid = getparamid(tg, ", "A"); %Get parameter ID of A

iT isempty(pid) %Check value of pid.
error("Could not find A");
end

setparam(tg, pid, 100); %If pid is valid, set parameter value.
2 Execute that MATLAB file. Type:

change_inlineA
3 To see the new parameter value, type:

tg.ShowParameters = “on”

The tg object information is displayed, including the parameter lines:
NumParameters = 1
ShowParameters = on

Parameters = INDEX VALUE TYPE SIZE PARAMETER NAME BLOCK NAME
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0 100 DOUBLE Scalar A

More About

. “Nonobservable Parameters” on page 5-174
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Tune Parameter Structures with Simulink Real-Time Explorer

In this section...

“Create Parameter Structure” on page 5-145

“Tune Parameters in a Parameter Structure” on page 5-147

“Save and Load Parameter Structure” on page 5-150

“Replace Block Parameters with Parameter Structure Fields” on page 5-146

To reduce the number of workspace variables you must maintain and avoid name

conflicts, you can group closely related parameters into structures (see “Organize Related
Block Parameter Definitions in Structures” (Simulink)).

In this example, the initial model Xxpcosc has four parameters that among them

determine the shape of the output waveform.

Block Parameter Structure Field Initial Value
Expression

Signal Generator [Freq spkp.sg_freq 20

Gain Gain spkp.g_gain 100072

Gainl Gain spkp.gl_gain 2*0.2*1000

Gain2 Gain spkp.g2_gain 100072

Create Parameter Structure

Open xpcosc in a working folder.
Open Tools > Model Explorer.
Select the Base Workspace node.

In the Name column, type the name spk

N O 0 A ODN —

In the Value field, type as one line:

Click the Add Simulink Parameter button L=,

p.

In the Storage class field, select ExportedGlobal.

struct("sg_freq®,20, "g2_gain®,1000"2, ...

gl gain®,2*0.2*1000, "g _gain®

,100072)
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Maodel Explorer

The field values duplicate the literal values in the dialog boxes. To change the field
values, in row spkp, click the Value cell and click the Edit button .

==]=]
EO 4 &R EHMN-H-& @ &=
Search: by Name + Name: @, Search
Model Hierarchy E = Contents of: Base Workspace (only) Filter Contents Simulink.Parameter: spkp
4 Simulink Root = . 2
T | GV Sonpests ooy e W < i
: *peosc Name Value DataType Min Max Dimensions Unit P struct M
[ spkp  <1x1 struct> struct  [1 [1 [11] e, TR Complexity: [ real
I ———————————
spkp.Value E Maximum: [ ]
Field Value
25 sq_freq 20 tions
H 92_gain 1000000 =
H g1_gain 400 JoriedGiobal b
H g_gain 1000000
DeEscripoons
< <] 2 Revert | [ Hep ||
Contents Search Results p Apply
8 Click Apply.

Replace Block Parameters with Parameter Structure Fields

1
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In the Signal Generator block, replace the value of parameter Frequency with
spkp.sg_freq.

In the Gain block, replace the value of parameter Gain with spkp.g_gain.
In the Gainl block, replace the value of parameter Gain with spkp.gl_gain.
In the Gain2 block, replace the value of parameter Gain with spkp.g2_gain.
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Tune Parameters in a Parameter Structure

Build and download the model to your target computer.
Open Tools > Simulink Real-Time.

In the real-time application properties, set the Stop Time parameter to InF.

B W N —

Create and configure a host scope:

a In the Model Hierarchy node, right-click the model and open View Signals.
b Add a host scope ().

¢ Drag the signals Integratorl and Signal Generator to the scope.
d  Start the scope @®).

e View the scope (El).

5 In the Model Hierarchy node, right-click the model and open View Block
Parameters.

6 Open the Values text box for spkp(1) .gl_gain.
7 Start the real-time application (&).
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4\ Simulink Real-Time Explorer
File Edit View Window Help
S EH kB RE A R E S & ¥ a g HE
Targets - 0 x = TargetPCl/ex_slrt_osc_struct/Scope 1 (Host Scope Viewer) | v X |Palette > x
,_g a! 4 Instruments =
4 MATLAB Session ‘ Eom:er
4 Su TargetPCl & - hno -
W Properties i SI:menc Y
5 File System “ SvluitecthED E
I 8w TargetPC2 & —
b B TargetPCi . % NumericalUpDownEnt
g ¢\ GaugeAngular
of Gaugelinear
@ LED
M HexadecimalDisplay
U GaugeFluidLevel
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S Seone T
< | n ] v
Applications * 1 x Panels ~ 1 x
> | & € f Instrument Panels
4 TargetPCl/ex_sirt_osc_struct &
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i] ex_slrt_osc_struct
Name Block Name Full Path Value
@ iakopiing Integrator  ex_slri_osc_struct % - 0.000000
l:@ InitialCondition Integrator  ex_slri_osc_struct ¥ 0.000000
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ng Amplitude Signal Ger  ex_slrt_osc_struct 4000000
seiliE © ; m o oo |ﬁ:| spkp(l)sg_freq Model Par  ex_slri_osc_struct 20.000000
m i
. : [ spkplllg2_gein Model Par  ex_slrt_osc_struct 1000000.000000
4 TargetPCl/ex_sirt_osc_struct kn(1).ql .
4 HEH  =pkel )gl_gain Model Par  ex_slrt_osc_struct 400.000000
ost Scopes
I Scopel [B] spkpillg gain Model Par ex_slrt_osc_struct 1000000.000000
Target Scopes
File Scopes < n :
Output - 1%
Ready

8 In the Values text box for spkp(1) .gl_gain, change the value to 800, click outside

the box, and click the Apply parameter value(s) changes button EE&
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4\ Simulink Real-Time Explorer
File Edit View Window Help
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9 Stop the real-time application (I).
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Save and Load Parameter Structure

1 In Model Explorer, right-click row spkp.

2 Click Export selected and save the variable as ex_slrt_osc_struct.mat.

To load the parameter structure when you open the model, add a load command to the
PreLoadFcn callback. To remove the parameter structure from the workspace when you

close the model, add a clear command to the CloseFcn callback. For more information,
see “Model Callbacks” (Simulink).

More About

. “Organize Related Block Parameter Definitions in Structures” (Simulink)
. “Display and Filter Hierarchical Signals and Parameters” on page 5-167
. “Model Callbacks” (Simulink)

5-150



Tune Parameter Structures with MATLAB Language

Tune Parameter Structures with MATLAB Language

In this section...

“Create Parameter Structure” on page 5-151
“Replace Block Parameters with Parameter Structure Fields” on page 5-152

“Tune Parameters in a Parameter Structure” on page 5-152

“Save and Load Parameter Structure” on page 5-154

To reduce the number of workspace variables you must maintain and avoid name
conflicts, you can group closely related parameters into structures (see “Organize Related
Block Parameter Definitions in Structures” (Simulink)).

In this example, the initial model xpcosc has four parameters that among them
determine the shape of the output waveform.

Block Parameter Structure Field Initial Value
Expression

Signal Generator [Freq spkp.sg_freq 20

Gain Gain spkp.g_gain 100012

Gainl Gain spkp.-gl_gain 2*0.2*1000

Gain2 Gain spkp.g2_gain 100072

Create Parameter Structure
1 Open xpcosc in a working folder.
2 To create a parameter structure, in the MATLAB Command Window, enter:

kp = struct(...
“sg_freq®, 20, ...
"g2_gain®,1000"2,
“gl_gain®, 2*0.2*1000,
"g_gain®,1000M"2)
kp =
struct with Ffields:

sg_freq: 20
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g2_gain: 1000000
gl gain: 400
g_gain: 1000000

3 To make the parameter structure tunable on the target computer:

spkp = Simulink.Parameter(kp);
spkp.StorageClass = "ExportedGlobal”;
spkp.Value

ans =
struct with fields:

sg_Tfreq: 20
g2_gain: 1000000
gl_gain: 400
g_gain: 1000000

Replace Block Parameters with Parameter Structure Fields

1 Inthe Signal Generator block, replace the value of parameter Frequency with
spkp.sg_freq.

2 Inthe Gain block, replace the value of parameter Gain with spkp.g_gain.

w

In the Gainl block, replace the value of parameter Gain with spkp.gl _gain.
4 In the Gain2 block, replace the value of parameter Gain with spkp.g2_gain.

Tune Parameters in a Parameter Structure

1 Build and download the model to the target computer.

rtwbuild("xpcosc*®)
2 Set stop time to inf.
tg = sirt;
tg.StopTime = inf;
3 Sweep the Gain value of the Gainl block from 200 to 800.
start(tg);
for g = 200 : 200 : 800

setparam(tg, °“spkp-gl gain®, g);
pause(1);



Tune Parameter Structures with MATLAB Language

end
stop(tg);

4  Plot the results.
time = tg.TimelLog;

output = tg.OutputLog;
plot(time, output);

File Edit View Inset Tools Desktop Window Help k]

A I A ED )

10 T T T T T T T T T

E_ .
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Save and Load Parameter Structure
To save the parameter structure spkp for later use, type:
save("ex_slrt_osc_struct.mat®, “spkp”);

To load the parameter structure when you open the model, add a load command to the
PreLoadFcn callback. To remove the parameter structure from the workspace when you
close the model, add a clear command to the CloseFcn callback. For more information,
see “Model Callbacks” (Simulink).

More About

. “Organize Related Block Parameter Definitions in Structures” (Simulink)
. “Model Callbacks” (Simulink)

5-154



Define and Update Inport Data

Define and Update Inport Data

In this section...

“File Dependencies” on page 5-155
“Map Inport to Use Square Wave” on page 5-155
“Update Inport to Use Sawtooth Wave” on page 5-158

You can create root-level input ports and use Root Inport Mapper to define input
data. You can update the input data without rebuilding the model by using MATLAB
language.

File Dependencies

This procedure depends on the following files:

+ ex_slrt_inport_osc (matlab: open_system(docpath(fullfile(docroot, 'toolbox', 'xpc',
'examples', 'ex_slrt_inport_osc"))) — Damped oscillator that takes its input data from
input port Inl and sends its muxed output to output port Outl.

+ ex_slrt_inport_square.mat (matlab: load(docpath(fullfile(docroot, 'toolbox', 'xpc',
'‘examples', 'ex_slrt_inport_square.mat')))) — One second of output from a Signal
Generator block that is configured to output a square wave.

+ ex_slrt_inport_sawtooth.mat (matlab: load(docpath(fullfile(docroot, 'toolbox’,
'xpc', 'examples', 'ex_slrt_inport_sawtooth.mat')))) — One second of output from a
Signal Generator block that is configured to output a sawtooth wave.

Before starting this procedure, navigate to a working folder.

Map Inport to Use Square Wave

1 Openex_slrt_inport_osc and save it to a working folder.

2 Load ex_slrt_inport_square.mat and assign square to a temporary workspace
variable for use with Root Inport Mapper.
waveform = square;

3 Double-click input port Inl.

4 Clear Interpolate data, and then click Connect Input.
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5 In Root Inport Mapper, click From Workspace and select variable waveform. Clear
the other variables.

6 Inthe Save to text box, enter a name such as
ex_slrt_inport_waveform_osc.mat, and then click OK.

7 Select map to model option Port order and, in the Options menu, select Update
Model.

8 Click Map to Model.

9 To update the model with the mapped input data, select scenario waveform, and
then click Mark for Simulation.

1% untitled - Root Inport Mapperex_sirt_inport_osc* EI@
@ Block Name © Signal Name
' 5 (EE Y ‘ @ D \
[ 1 E = | Generate MATLAB Script
= Eé © Block Path O Port Order =
Open  Save From From From Signals Options ~ Map to Mark for *| Run Script
- Spreadsheet MAT-File \Werkspace - O, Custom | slexCustomMappingMyCustc | - Model Simulation
FILE LINK SCENARIO MAP TO MODEL MODEL SCRIPT a
SCENA... MAPMO... ©  MAPPING SUMMARY
# waveform PortOrder @
Total Scenario 0 19 0y W] %] 10:49:53am 113117
Datasets 1 Not Mapped Mapped Warnings Erors
Marked For @ waveform
Simulation:
& waveform - ex_sirt_inport_waveform_osc.mat Mode: Port Order
Status Scenario Signal Port Block Name Mapped Signal
Q 1 In1 waveform.getElement(1)
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10 Click Save.
Save the scenario under a name such as
ex_slrt_inport_waveform_scenario.mldatx.

11 Close the Root Inport Mapper. In the Inl block parameters dialog box, click OK.

12 To display the output of the Mux block with Simulation Data Inspector, right-click
the output signal and select Log Selected Signals.

You can now save, build, download, and execute the real-time application. Display the
output with Simulation Data Inspector.
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<4\ Simulation Data Inspector - untitled™ EI

VISUALIZE

A New £ Import . s a o0
G L % gaq O D) =
pen
e . Q E@ s S T il SHARE RESOURCES
Save v 1 Preferences - in - - ~ - = =
FILE RUNS | ZOOM & PAN MEASURE & TRACE VIEWS ry
Q 1 B Mux[1] W Mux2]
Inspect Compare
—— 8
2 Filter Signals
+ Run 2: ex_slrt_inport_osc
[
—

v Mux:1[1]

Name Muc:1[2

Line — -2

Units

Data Type double . Jr wﬁ )TA W )TJ 'ff‘ 'TJ »‘ wr
Sample Time 0.00025

Madel ex_sirt_inport_osc

Block Name Mux @

Block Path ex_sirt_inport_osc/Mux

Port 1 <=

Dimensions [2]

Fhannal . 0 0.1 0.2 03 0.4 0.5 06 0.7 08 0.9

Update Inport to Use Sawtooth Wave

You can update the inport data to use a different data file without rebuilding the real-
time application. The ex_slrt_inport_osc.mldatx file must be in the working folder.

1 Load ex_slrt_inport_sawtooth.mat, and then assign sawtooth to the
temporary variable that you used with Root Inport Mapper.
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load(docpath(fullfile(docroot, "toolbox®", "xpc®, “examples®,
"ex_slrt_inport_sawtooth_mat®)));
waveform = sawtooth;

Create an application object.

app_object = SimulinkRealTime._Application("ex_slrt_inport_osc");
Update the application object.

updateRootLevel InportData(app_object);
Download the updated object to the target computer and execute it.
tg = slirt;

load(tg, "ex_slrt_inport_osc");
start(tg);

Plot the output.

plot(tg.TimelLog, tg.OutputLog);
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(@ Figure1 el

File Edit View Insert Tools Desktop Window Help k.
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More About

. “Define and Update Inport Data with MATLAB Language” on page 5-161
“Specify Data for Root-Level Input Ports” (Simulink)
“Create Signal Data for Root Inport Mapping” (Simulink)
“Inport Data Mapping Limitations” on page 5-166

“Inspect Simulink® Real-Time™ Signals with Simulation Data Inspector” on page
5-74
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Define and Update Inport Data with MATLAB Language

In this section...

“File Dependencies” on page 5-161
“Map Inport to Use Square Wave” on page 5-161
“Update Inport to Use Sawtooth Wave” on page 5-163

You can create root-level input ports and use the MATLAB language to define input data
and to update the input data without rebuilding the model.

File Dependencies

This procedure depends on the following files:

ex_slrt_inport_osc (matlab: open_system(docpath(fullfile(docroot, 'toolbox', 'xpc',
'examples', 'ex_slrt_inport_osc')))) — Damped oscillator that takes its input data from
input port Inl and sends its muxed output to output port Outl.

ex_slrt_inport_square.mat (matlab: load(docpath(fullfile(docroot, 'toolbox', 'xpc',
'examples', 'ex_slrt_inport_square.mat')))) — One second of output from a Signal
Generator block that is configured to output a square wave.

ex_slrt_inport_sawtooth.mat (matlab: load(docpath(fullfile(docroot, 'toolbox’,
'xpc', 'examples', 'ex_slrt_inport_sawtooth.mat')))) — One second of output from a
Signal Generator block that is configured to output a sawtooth wave.

Before starting this procedure, navigate to a working folder.

Map Inport to Use Square Wave

1

Open ex_slrt_inport_osc.

open_system(docpath(fullfile(docroot, "toolbox", "xpc", "examples”,...
"ex_slrt_inport_osc")));
save_system("ex_slrt_inport_osc”, "H:\workdir\ex_slrt_inport_osc.slx");

Load ex_slrt_inport_square.mat, and then assign square to a temporary
workspace variable.

load(docpath(fullfile(docroot, "toolbox®, "xpc®, "examples”,
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"ex_slrt_inport_square.mat®)));
waveform = square;

Open ex_slrt_inport_osc/Inl.
load_system("ex_slrt_inport_osc/Inl");
Turn off inport data interpolation.

set_param("ex_slrt_inport_osc/Inl", "Interpolate”, "off");

Set external input variable.

set_param("ex_slrt_inport_osc", "External Input®, "waveform®);

Load external input data.

set_param(“ex_slrt_inport_osc", "LoadExternal Input®,“on®);

You can now build, download, and execute the real-time application.

rtwbuild("ex_slrt_inport_osc”);
start(tg);

Plot the output.

plot(tg-TimelLog, tg-OutputLog);
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Update Inport to Use Sawtooth Wave

You can update the inport data to use a different data file without rebuilding the real-
time application. The ex_slrt_inport_osc.mldatx file must be in the working folder.
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Load ex_slrt_inport_sawtooth.mat, and then assign sawtooth to the
temporary variable that you used with Root Inport Mapper.

load(docpath(fullfile(docroot, "toolbox®, "xpc®, "examples”,
"ex_slrt_inport_sawtooth.mat")));
waveform = sawtooth;

Create an application object.
app_object = SimulinkRealTime.Application("ex_slrt_inport_osc");
Update the application object.

updateRootLevel InportData(app_object);

Download the updated object to the target computer and execute it.

tg = slirt;
load(tg, "ex_slrt_inport_osc");
start(tg);

Plot the output.

plot(tg.-TimelLog, tg.OutputLog);
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More About

. “Define and Update Inport Data” on page 5-155
“Specify Data for Root-Level Input Ports” (Simulink)
“Create Signal Data for Root Inport Mapping” (Simulink)
“Inport Data Mapping Limitations” on page 5-166

“Inspect Simulink® Real-Time™ Signals with Simulation Data Inspector” on page
5-74
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Inport Data Mapping Limitations

In Simulink Real-Time, you cannot:
* Interpolate inport data. Simulink Real-Time ignores the Inport block parameter
Interpolate data.

+ Create data at run time for each time step by using the input u = UT(t) for
MATLAB functions or expressions.

* Import complex values, buses, arrays of buses, or asynchronous function-call signals
into top-level input ports.

+ Create MATLAB time expressions for root inports.

More About

. “Define and Update Inport Data” on page 5-155
. “Specify Data for Root-Level Input Ports” (Simulink)
. “Create Signal Data for Root Inport Mapping” (Simulink)
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Display and Filter Hierarchical Signals and Parameters

In this section...

“Hierarchical Display” on page 5-167
“Filtered Display” on page 5-168
“Grouped Display” on page 5-170

In Simulink Real-Time Explorer, the default view of the signal and parameter lists shows
the signals and parameters only at the level that you selected. You can display signals
and parameters for the current level and below and filter the display to show only the
items that you are interested in.

Hierarchical Display

To show signals and parameters from the current level and below, navigate to the

hierarchical level that you are interested in. Click the Contents of button (=] on the
toolbar).

The contents of the top level of ex_slrt_sf _car are shown in the figure.
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Filtered Display

To restrict display to signals or parameters with a particular characteristic, use the
Filter text box that is on the toolbar. If you display only one level, the filter applies only
to that level.

5-168



Display and Filter Hierarchical Signals and Parameters

Explorer supports filtering by values in the following columns:

Signals — Signal Name, Signal Label, Full Path
* Parameters — Name, Block Name, Full Path

For example, to restrict the display of signals and parameters to the shift_logic
subsystem, select column Signal Name. Type shift_logic into the Filter text box.
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Grouped Display

To group signals and parameters by columns, right-click the column head and select
Group By This Column. To remove the grouped display, right-click the column head
and select Remove Grouping.

Explorer supports grouping by the following columns:

+ Signals — Signal Name, Signal Label, Full Path, Test Point, Dimensions
+ Parameters — Name, Block Name, Full Path, Dimensions
For example, to group signals by name, right-click the Signal Name column and select

Group By This Column. To group parameters by name, right-click the Name column
and select Group By This Column.



Display and Filter Hierarchical Signals and Parameters

4\ Simulink Real-Time Explorer
File Edit View Window

Do ER 4 & ERE 2

Targets ~ o=
! \

X G Gn
4 MATLAB Session
4 5u TargetPCl &
2 Properties
< File System
I Bm TargetPCZ &
I Bw TargetPC3 &

‘Appllcaiiuns > x

bE@<EH
4 TargetPCl/ex sirt_sf car @
%Pmper{ies
I Groupings
4 Model Hierarchy
I i] ex_slrt_sf_car

‘Scopes A x\

PR f @

4 TargetPCl/ex_slrt_sf car
Host Scopes
Target Scopes
File Scopes

Ready

Help
Aoy TR T S e &SRB B
€ exsirt_sf car (TargetPC1) | ~ X |Palette -0 x
Contents of: ex_sirt_sf car {and below) Filter 4 Instruments -
® Pointer
Monitar Signal Name Signal Label ~ Full Path  Monitoring Value Test Point  Refresh Speed  Inc * U Knob
~ | engine + impeller inertia 1 item(s) NumericEntry
v engine torque 1 item(s) = o Slicler 3
] & SwitchLED
v/ final drive ratiol 1 item(s) [# NumericalUpDownEnt
{wﬁnaldriue ratio? 1 item(s) (A GaugeAngular
. »l Gaugelinear
v) FromWs I item(s) @ o
\.r‘gaar,shle.ﬁrst 1 item(s) @ HexadecimalDisplay
- . | GaugeFluidLevel
v gear statefourth 1 items) B NomericTicnlav e
\_"gaar_s!ate.se(ond 1 item(s) ‘
: Panels *Ix
) state.third 1 ite;
Y, gear_state-thir item(s) Instrument Panels
v) impeller 1 item(s)
y ’@e}(}lﬂjﬁ(ﬂr (TalgetPCl]l * X
E] Contents of: ex_slrt_sf_car (and below) Fulter ®
Name Block Name Full Path Value Is Edite +
\_"Cnlumn]ndm( 3 item(s)
\_f‘Gain 2 ifem(s)
>) InitialCondition I item(s)
Y‘Inpuﬂfalus 1 item(s)
\_"I\r 1 item(s)

i x
<) Kfactor 1 iternis) [Properties =
v) LowerSaturationLimit 1 item(s)

v) N20 I iemn(s)
v Rfd 1itemis)
v) RowIndex 3 item(s)
Cutput - 0 x

5-171



5 Signals and Parameters

Nonobservable Signals

5-172

You cannot monitor, trace, or log the following types of signals from the development
computer:

Signals within referenced models. To access these signals, make them test points.
Virtual or bus signals (including signals from bus and virtual blocks). To access these
signals, insert nonvirtual source blocks and observe their outputs. For example:
To access a virtual signal, add a unit Gain block (a Gain block with gain 1.0) and
observe its output.
* To access a virtual bus, add a unit Gain block to each individual signal.

Signals that you have optimized by setting the signal storage reuse configuration
parameter.

Signals that you have optimized with block reduction optimization. To access these
signals, make them test points.

Blocks that buffer their input signals to make them contiguous. Examples include the
To Workspace block and some S-function blocks.

If you connect a signal to the input port of such a block and to a real-time Scope block,
the Scope block cannot access the signal.
To observe such a signal, add a unit Gain block before the input to the Scope block.
Signals of complex or multiword data types.
If a block name consists only of spaces, Simulink Real-Time Explorer does not display
a node for signals from that block. To reference such a block:
* Provide an alphanumeric name for the block

Rebuild and download the model to the target computer.
*  Reconnect the MATLAB session to the target computer.

See Also

Gain

More About

“Nonvirtual and Virtual Blocks” (Simulink)
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“Virtual Signals” (Simulink)

“Signal storage reuse” (Simulink)

“Block reduction” (Simulink)
“Nonobservable Parameters” on page 5-174

“Internationalization Issues” on page 5-175
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Nonobservable Parameters

+  Simulink Real-Time does not support parameters of multiword data types.

*  You cannot tune parameters during execution that change the model structure, for
example by adding a port. To change these parameters, you must stop execution,
change the parameter, and rebuild the real-time application.

More About
. “Nonobservable Signals” on page 5-172

. “Internationalization Issues” on page 5-175
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Internationalization Issues

Simulink Real-Time inherits the internationalization support of the products it depends
upon: Simulink, Simulink Coder, and Embedded Coder®. Signal and parameter names
that include Unicode® characters are displayed as expected in Simulink Real-Time

Explorer and at the MATLAB command line. In particular, when you use host scopes to
observe signals, the non-ASCII signal names are displayed as expected.

Third-party code, such as parsers for vendor configuration files, sometimes does not
support cross-locale, cross-platform internationalization. For such code, files and folders
must be given locale-specific names. For example, when parsing a configuration file on
an English-locale machine, name the file and enclosing folder with English-locale-specific
names.

The Simulink Real-Time kernel does not support international (non-ASCII) characters. It
generates messages in English using ASCII characters. When interacting with the kernel
through the target computer keyboard, you identify signals and parameters by numerical
ID, not by names.

When you use target scopes to observe signals, the kernel replaces a signal label that
includes non-ASCII characters with the numerical ID. It replaces each non-ASCII
character in the block path (hierarchical signal name) with the character ?.

For example, assume that the signal with ID 1 appears in an English-language and a
Japanese-language version of the same model. In the English-language version, the
signal label is inputl and the block path is block1l/block?2. In the Japanese-language
version, the signal label is A 51 and the block pathis 7OY 21/70Y 2.

* In single scope mode, the numerical portion of the screen contains this character
vector for the English-language version:

inputl: blockl/block2
It contains this character vector for the Japanese-language version:
1: ?2?272?21/7?7?77?72

* In multiscope mode, the signal label above the scope contains this character vector for
the English-language version:

inputl

It contains this character vector for the Japanese-language version:
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More About

. “Nonobservable Signals” on page 5-172

. “Nonobservable Parameters” on page 5-174
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Execution Modes

6-2

The Simulink Real-Time kernel has three mutually exclusive execution modes. You can
execute the real-time application in one non-real-time mode and in two real-time modes.

Interrupt mode — To use this real-time mode, on the Simulink Real-Time Options
pane in the Configuration Parameters dialog box, set Execution mode to Real -
Time.

In this mode, the scheduler implements real-time single-tasking and multitasking
execution of single-rate or multirate systems, including asynchronous events
(interrupts). This implementation allows you to interact with the target computer
while the real-time application is executing at high sample rates.

Polling mode — To use this real-time mode:

Use multicore target computer hardware.

2 In Simulink Real-Time Explorer, check that the Multicore CPU target setting is
set to "on" for the target computer that you intend to use.

3 On the Simulink Real-Time Options pane in the Configuration Parameters
dialog box, set Execution mode to Real-Time.

4  Enable polling by setting the TLCOptions setting —axpcCPUClockPoll to a
nonzero value.

In this mode, the kernel executes real-time applications at sample times close to the
limit of the CPU. Using polling mode with high-speed and low-latency I/O boards

and drivers allows you to achieve real-time application sample times that you cannot
achieve using interrupt mode. Because polling mode disables interrupts on the
processor core where the model runs, it imposes restrictions on the model architecture
and on target communication.

Freerun mode — To use this non-real-time mode, in the Configuration Parameters
dialog box:
1 On the Simulink Real-Time Options pane, set Execution mode to Freerun.

2 On the Solver pane, clear the check box for Treat each discrete rate as a
separate task.

In this mode, the real-time application thread does not wait for the timer. The kernel
runs the application as fast as possible. If the real-time application has conditional
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code, the time between each execution can vary. Multirate models cannot be executed
in Freerun execution mode.

Interrupt Mode

When you set Execution mode to Real-Time on the Simulink Real-Time Options
pane in the Configuration Parameters dialog box, interrupt mode is the real-time
execution mode set by default. This mode provides the greatest flexibility. Choose this
mode for real-time applications that execute at the given base sample time without
overloading the CPU.

In interrupt mode, the scheduler implements real-time single-tasking and multitasking
execution of single-rate or multirate systems, including asynchronous events (interrupts).
Also, background tasks like target communication or updating the target display run in
parallel with sample-time-based model tasks. This implementation allows you to interact
with the target system while the real-time application is executing at high sample rates.
Interaction is made possible by an interrupt-driven real-time scheduler responsible for
executing the various tasks according to their priority. The base sample time task can
interrupt other tasks (larger sample time tasks or background tasks). Execution of the
interrupted tasks resumes when the base sample time task completes operation. This
capability gives a quasiparallel priority execution scheme.

In interrupt mode, the kernel is close to optimal for executing code on a PC-compatible
system. However, using interrupt mode introduces an overhead, or latency, that reduces
the minimal possible base sample time. The overhead is the sum of various factors
related to the interrupt-driven execution scheme, such as interrupt controller latency,
interrupt handler latency, and CPU latency. The overhead is referred to as overall
interrupt latency.

The overall latency of interrupt mode is equivalent to a Simulink model containing a
hundred nontrivial blocks. At least 5% of headroom is required because the CPU must
also service lower priority tasks. This requirement can cause additional cache misses and
therefore nonoptimal execution speed.

Polling Mode

Polling mode for the kernel is designed to execute real-time applications at sample times
close to the limit of the CPU. Polling mode with high-speed and low-latency I/O boards
and drivers allows you to achieve smaller sample times for real-time applications. You
cannot achieve these smaller sample times using the interrupt mode of the Simulink
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Real-Time software. You can only run a model in polling mode on a multicore processor
with the MulticoreSupport target setting set to "on".

Polling mode has two main uses:

+  Control systems — Control system models of average model size and I/O complexity
that are executed at small sample times (Ts = 10-50 pus).

+ DSP systems — Sample-based DSP system models of average model size and I/O
complexity that are executed at high sample rates (Fs = 20—-100 kHz). DSP models
mainly process audio and speech data.

Polling mode for the kernel does not have the latency that interrupt mode does. It is
sometimes seen as a “primitive” or “brute force” real-time execution scheme. When a real-
time application executing in interrupt mode at a given sample time overloads the CPU,
switching to polling mode is often the only alternative.

In interrupt mode, when a CPU has finished executing the real-time code, it cedes the
rest of its execution time to the operating system. The operating system can use this time
to execute other tasks, such as background or I/O tasks. When the next execution step is
scheduled, the timer generates an interrupt, and Simulink Real-Time executes the next
step.

In polling mode, however, when the CPU has finished executing the real-time code, the
CPU does not cede time to other tasks. Instead, it does not do anything besides checking
(polling) the time value to determine whether it is time to run the next execution step.
Once this time arrives, it executes the next step and the process continues.

The latency associated with interrupts is not incurred because no timer interrupts are
involved on this core. However, one core of the target computer is occupied with running
the base rate, irrespective of how long it takes to run the actual real-time task.

The polling execution scheme does not depend on interrupt sources to notify the code to
continue calculating the next model step. The base rate of the real-time code is executed
on one core of the multicore processor, timed by the polling loop. Background tasks and
model tasks other than the base rate task are executed on the other cores. For efficiency,
put only the most critical code into the base rate task.

If you use Simulink Real-Time concurrent execution to execute your model, you can have
multiple base rate tasks. The CPU scheduler arbitrarily selects one of these tasks to run
in the polling loop.

Before considering polling mode, do the following:
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*  Optimize the model execution speed — To find possible speed optimizations using
alternative blocks, use Performance Advisor or the profiler. If the model contains
continuous states, discretizing these states reduces model complexity significantly.
You can avoid a costly fixed-step integration algorithm. If continuous states cannot be
discretized, use the integration algorithm with the lowest order that still produces the
required numeric results.

*  Use the fastest available CPU — Use the CPU with the highest clock rate available
for a given target computer form factor. For the desktop form factor, use a CPU with a
clock rate above 3 GHz. For a model of a mobile system (e.g., PC/104 form factor), use
a CPU with a clock rate above 1 GHz.

*  Use the lowest latency I/O modules and drivers available — Many real-time
applications communicate with I/O modules over a PCI bus. Each register access
introduces a comparably high latency time. Using the lowest latency I/O modules and
drivers available is crucial.

+  Consider running less critical code at a slower rate, taking advantage of the
multitasking capabilities of Simulink Real-Time.

Set Polling Mode

Polling mode is an alternative to the default interrupt mode of the kernel. The kernel on
the bootable media created by the UI allows running the real-time application in either
mode without using another boot disk.

By default, the real-time application executes in interrupt mode. To switch to polling
mode, you enable polling using a TLCOptions setting.

The following example uses Xpcosc.

1 Open Simulink Real-Time Explorer.
2 Select the Properties pane for the target computer that you intend to use.

3 In the Target settings section, check that the Multicore CPU parameter is
selected.

4 Open model xpcosc.

5 In the Configuration Parameters dialog box, on the Simulink Real-Time Options
pane, set Execution mode to Real-Time.

6 Inthe Command Window, type:

set_param("xpcosc”, "TLCOptions®, "-axpcCPUClockPoll=1")

7 Build and download the real-time application.
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After you have downloaded the real-time application, the target display shows the
execution mode. If you want to execute the real-time application in interrupt mode again,
either remove the setting or assign O to the setting:

set_param("xpcosc”, "TLCOptions®,"")
set_param("xpcosc”, "TLCOptions”, "-axpcCPUClockPoll1=0%)

Rebuild and download the real-time application.
Restrictions on Multicore Processors

Polling mode runs only on a multicore processor target computer with multicore
processing enabled. For more information, see “Multicore Processor Configuration” on
page 9-12.

Polling mode disables interrupts on the core where the base rate task is running.
Background tasks and model tasks other than the base rate task are inactive on this
core. Tasks for Ethernet communication, target display updates, and UDP transfers run
on the other cores. Interrupts are still enabled on cores other than the one running the
polling task.

See Also

SimulinkRealTime.utils.minimumSampleTime | Target Settings Properties |
TLCOptions Properties

More About

. “Set Configuration Parameters”
. “Execution mode”

. “Performance Optimization”

. “Real-Time Application Execution Produces CPU Overloads” on page 24-5
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Execution with User Interface Models

You can use the Simulink interface to create a custom user interface (UI) for your real-
time application. First, create a user interface model with the Simulink interface. Then,

add-on products like Simulink 3D Animation™ or Altia® Design (a third-party product).
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Simulink Real-Time Interface Blocks to Simulink Models

7-2

In this section...

“Simulink User Interface Model” on page 7-2
“Creating a Custom Graphical Interface” on page 7-3
“To Target Block” on page 7-4

“From Target Block” on page 7-6

“Creating a Real-Time Application Model” on page 7-8
“Marking Block Parameters” on page 7-8

“Marking Block Signals” on page 7-10

Simulink User Interface Model

A user interface model is a Simulink model containing Simulink blocks from add-

on products and interface blocks from the Simulink Real-Time block library. This

user interface model can connect to a custom graphical interface using Simulink 3D
Animation or Altia products. The user interface model runs on the development computer
and communicates with your real-time application running on the target computer using
To Target and From Target blocks.

The user interface allows you to change parameters by downloading them to the target
computer, and to visualize signals by uploading data to the development computer.

Simulink 3D Animation — The Simulink 3D Animation product enables you to display

a Simulink user interface model in 3-D. It provides Simulink blocks that communicate
with Simulink Real-Time interface blocks. These blocks then communicate to a graphical
interface. This graphical interface is a virtual reality modeling language (VRML) world
displayed with a web browser using a VRML plugin.

Altia Design — Altia also provides Simulink blocks that communicate with Simulink
Real-Time interface blocks. These blocks then communicate with Altia's graphical
interface or with a web browser using the Altia ProtoPlay plugin.
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Development

Creating a Custom Graphical Interface

The Simulink Real-Time block library provides Simulink interface blocks to connect
graphical interface elements to your real-time application. The steps for creating your

own custom user interface are:

computer
S )
Simulink
instrumentation model
User interface Target
blocks computer
4
Real-time
application
4 N\
4 N\
Parameters
Simulink Real-Time - J
interface blocks - ~
- Signals
g J
\_ J N\
J
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1 In the Simulink real-time application model, decide which block parameters and
block signals that you want to access through user interface control and display
devices.

2 Tag the block parameters in the Simulink model that you want to be connected to a
control device. See “Marking Block Parameters” on page 7-8.

3 Tag the signals in Simulink model that you want to be connected to a display device.
See “Marking Block Signals” on page 7-10.

4 Inthe MATLAB interface, run the function
SimulinkRealTime.utils.createlnstrumentationModel to create the user
interface template model. This function generates a new Simulink model containing
only the Simulink Real-Time interface blocks (To Target and From Target) defined
by the tagged block parameters and block signals in the real-time application model.

5 To the user interface template model, add Simulink interface blocks from add-on
products (Simulink 3D Animation, Altia Design).
You can connect Altia blocks to the Simulink Real-Time To PC Target interface
blocks. Connect the To Target blocks on the left to control devices.

You can connect Altia and Simulink 3D Animation blocks to the Simulink Real-
Time From Target interface blocks. Connect the From Target blocks on the right
to the display devices.

You can position these blocks to your liking.

6  Start both the real-time application and the Simulink user interface model that
represents the application.

To Target Block

This block behaves as a sink and usually receives its input data from a control device.
The purpose of this block is to write a new value to a specific parameter in the real-time
application.
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Development

computer
- A
Simulink
instrumentation model
Control Target
device block computer
4 I
Real-time
application
~N
To Target w
block ) Parameter
) - 4
J

This block 1s implemented as a MATLAB S-function. The block only changes a parameter
on the real-time application when the input value differs from the value that existed at
the last time step. This block uses the parameter downloading feature of the Simulink
Real-Time command-line interface. This block is available from the slrtlib/Displays
and Logging block sublibrary. See To Target for further configuration details.
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Note: The use of To Target blocks requires a connection between the development and
target computers. Opening a model that contains these blocks or copying them to another
model takes longer than normal without a connection between the development and
target computers.

From Target Block

This block behaves like a source. Typically, you connect its output to the input of a
display device.
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Development

computer
~
Simulink
instrumentation model
Display device Target
block computer
4 )
Real-time
application
( )
From Target ( Signal
block
J

Because only one numerical value per signal is uploaded during a time step, the number
of samples of a scope object is set to 1. The block uses the capability of the Simulink Real-
Time command-line interface and is implemented as a MATLAB S-function. This block 1s
available from the slrtlib/Displays and Logging sublibrary. See From Target for
further configuration details.
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Note: The use of From Target blocks requires a connection between the development
and target computers. Opening a model that contains these blocks or copying them to
another model takes longer than normal without a connection between the development
and target computers.

Creating a Real-Time Application Model

A real-time application model is a Simulink model that describes your physical system,
a controller, and its behavior. You use this model to create a real-time application and
to select the parameters and signals that you want to connect to a custom graphical
interface.

See “Marking Block Parameters” on page 7-8 and “Marking Block Signals” on page
7-10 for descriptions of how to mark block properties and block signals.

Marking Block Parameters

Tagging parameters in your Simulink model allows the function
SimulinkRealTime.utils.createlnstrumentationModel to create To Target
interface blocks. These interface blocks contain the parameters you connect to control
devices in your user interface model.

After you create a Simulink model, you can mark the block parameters. This procedure
uses the model xpctank as an example.

Tip: The xpctank model blocks and signals contain placeholder tags illustrating the
syntax. Replace these tags with your new tags or add the new tags using the multiple
label syntax.

1 Open a Simulink model. For example, in the MATLAB Command Window, type

xpctank
2 Point to a Simulink block, and then right-click.
3 From the menu, click Properties.

A Block Properties dialog box opens.

4 In the Description box, delete the existing tag and enter a tag to the parameters for
this block.
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For example, the SetPoint block is a constant with a single parameter that selects
the level of water in the tank. Enter the tag:

XPCTag(1l)=water_level;

The tag has the following syntax:

xXPCTag(l, . . . index_n)= label 1 . . . label n;

For single dimension ports, the following syntax is also valid:

XPCTag=1abel ;

index_n -- Index of a block parameter. Begin numbering parameters with an
index of 1.
Iabel n -- Name for a block parameter that is connected to a To Target block in

the user interface model. Separate the labels with a space, not a comma.

label _1...l1abel_n must consist of the same identifiers as C/C++ used to name
functions, variables, and so forth. Do not use names like -foo0.

Repeat steps 1 through 3 for the remaining parameters you want to tag.

For example, for the Controller block, enter the tag:

XPCTag(1,2,3)=upper_water_level lower_water_level
pump_Fflowrate;

For the PumpSwitch and ValveSwitch blocks, enter the following tags respectively:

XPCTag(2)=pump_switch;
XPCTag(1l)=drain_valve;

To create the To Target blocks in a user interface model for a block with four
properties, use the following syntax:

XPCTag(1,2,3,4)=1abel_1label_2label_3label_4;

To create the To Target blocks for the second and fourth properties in a block with at
least four properties, use the following syntax:

XPCTag(2,4)=label_1 label_2;
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6 From the File menu, click Save as. Enter a file name for your model. For example,
enter

Xpctankl

If you have not already marked block signals, your next task is to mark block signals,
and then to create the user interface template model. See “Marking Block Signals” on
page 7-10 and “Creating a Custom Graphical Interface” on page 7-3.

Marking Block Signals

Tagging signals in your Simulink model allows the function
SimulinkRealTime.utils._createlnstrumentationModel to create From Target
interface blocks. These interface blocks contain the signals you connect to display devices
in your user interface model.

After you create a Simulink model, you can mark the block signals. This procedure uses
the model xpctankl (or Xxpctank) as an example. See “Creating a Real-Time Application
Model” on page 7-8.

Tip: The xpctank model blocks and signals can contain placeholder tags illustrating the
syntax. Replace these tags with your new tags or add the new tags using the multiple
label syntax.

You cannot select signals on the output ports of virtual blocks, such as Subsystem and
Mux blocks. Also, you cannot select signals on software-triggered signal output ports.

1 Open a Simulink model. For example, in the MATLAB Command Window, type:
Xpctank
or

Xpctankl
2 Point to a Simulink signal line, and then right-click.

3 From the menu, click Properties.

A Signal Properties dialog box opens.

4 Select the Documentation tab.
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In the Description box, enter a tag to the signals for this line.

For example, the block labeled TankLevel is an integrator with a single signal that
indicates the level of water in the tank. Replace the existing tag with the tag:

XPCTag(1l)=water_level;

The tag has the following format syntax:
xPCTag(l, . . . index_n)=label 1 . . . label n;

For single dimension ports, the following syntax is also valid:

XPCTag=label:

+ Index_n — Index of a signal within a vector signal line. Begin numbering signals
with an index of 1.

+ label _n — Name for a signal that is connected to a From Target block in the
user interface model. Separate the labels with a space, not a comma.

label _1...l1abel_n must consist of the same identifiers as C/C++ uses to name
functions, variables, and so forth. Do not use names like -foo0.

To create the From Target blocks in a user interface model for a signal line with four
signals (port dimension of 4), use the following syntax:

XPCTag(1,2,3,4)=1abel_1 label 2 label 3 label 4;

To create the From Target blocks for the second and fourth signals in a signal line
with at least four signals, use the following syntax:

XPCTag(2,4)=label_1 label 2;

Note: Only tag signals from nonvirtual blocks. Virtual blocks are only graphical

aids (see “Nonvirtual and Virtual Blocks” (Simulink)). For example, if your model
combines two signals into the inputs of a Mux block, do not tag the output signal
from the Mux block. Instead, tag the source signal from the output of the originating
nonvirtual block.

From the File menu, click Save as. Enter a file name for your model. For example,
enter

Xpc_tankl
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If you have not already marked block parameters, your next task is to mark them. See
“Marking Block Parameters” on page 7-8. If you have already marked block signals,
return to “Creating a Custom Graphical Interface” on page 7-3 for additional

guidance on creating a user interface template model.
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Control Real-Time Application at Target Computer Command Line

The Simulink Real-Time software provides a set of commands that you can use to
interact with the real-time application after it has been loaded to the target computer.
Using these commands, you can start and stop execution, configure and control the
scopes for that application, and tune parameters.

These commands are useful with standalone real-time applications that are not
connected to the development computer. You type commands directly from a keyboard
attached to the target computer. As you start to type, a command window appears on the
target computer screen.

The target computer commands are case-sensitive, but the arguments are not. For more
information, see “Target Computer Commands”.

To read the target computer console log, call
SimulinkRealTime.utils.getConsolelLog.

Trace Signals at Target Computer Command Line

After you have built and downloaded a real-time application to the target computer, you
can use target computer commands to create and configure scopes.

To add signals to a scope, you must specify the signals by signal number. For more
information, see “Find Signal and Parameter Indexes” on page 8-5.

1 To start the real-time application, in the command line, type:

start

2 To add a target scope (scope 2), type:

addscope 2

The Simulink Real-Time software adds another scope graphic to the target computer
monitor. The command window displays a message to indicate that the new scope
has registered.

Scope 2, created, type is target
3 To add a signal (0) to the new scope, type:

addsignal 2=0
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10

The command window displays a message to indicate that the new signal has
registered.

Scope 2, signal 0 added

You can add more signals to the scope.

To start scope 2, type:

startscope 2

The target scope 2 starts and displays the signals you added in the default format
(graphical).

If you add a target scope from the target computer, you must start that scope
manually. If a target scope is in the model, starting the real-time application starts
that scope automatically.

To collapse scope 2 into an icon, type:

hide Scope 2

To expand scope 2 from an icon, type:

show Scope 2

To check the value of signal 0O, type:

sO

The command window displays a message to show the value of signal 0.

SO has value 5.1851
To stop scope 2, type:

stopscope 2

To change the number of samples (to 1000) to acquire in scope 2, type:

numsamples 2=1000

You must stop the scope before changing a scope parameter.

To start scope 2, type:

startscope 2
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11

12

The target scope 2 starts and displays the signal values with the updated sample
count.

To stop scope 2, type:

stopscope 2

To stop the real-time application, type:

stop

Tune Parameters at Target Computer Command Line

After you have built and downloaded a real-time application to the target computer, you
can use target computer commands to tune parameters.

To tune parameters, you must specify them by parameter number. For more information,
see “Find Signal and Parameter Indexes” on page 8-5.

1

To check the frequency of the signal generator (parameter 6) of the model xpcosc,
type:

p6

The command window displays a message to indicate that the new parameter has
registered.

p[6] is set to 20.00000
To change the frequency of the signal generator, type:

setpar 6=30

The command window displays a message to indicate that the new parameter has
registered.

p[6] is set to 30.00000

The target computer command setpar does not work for vector parameters.

To change the stop time to 1000, type:

stoptime = 1000
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The parameter changes are made to the real-time application but not to the target
object. When you type a Simulink Real-Time command in the MATLAB Command
Window, the target computer returns the current properties of the target object.

Alias Commands at Target Computer Command Line

You can use target computer command-line variables to tag (or alias) unfamiliar
commands, parameter indexes, and signal indexes with more descriptive names.

1

To create the aliases on and off for a parameter (7) that controls a motor, type:

setvar on = p7 =1
setvar off = p7 = 0

The target computer command window is activated when you start to type, and a
command line opens.

To run a command sequence, type the variable name. For example, to turn on the
motor, type:

on

The parameter P7 is changed to 1, and the motor turns on.

Find Signal and Parameter Indexes

To find signal and parameter indexes using MATLAB language:

1
2

Build and download the model to the target computer.
At the Command Line, type:

tg = sirt

Target: TargetPCl
Connected
Application

Yes
Xpcosc

Scopes = No Scopes defined
NumSignals =7
ShowSignals = off
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7
off

NumParameters
ShowParameters

3 To display signal numbers, type:

tg.ShowSignals="on"

Target: TargetPCl
Connected
Application

Yes
Xpcosc

Scopes = No Scopes defined
NumSignals =7
ShowSignals = on
Signals = INDEX VALUE BLOCK NAME
(0] 0.000000 Gain
1 0.000000 Gainl
2 0.000000 Gain2
3 0.000000 Integrator
4 0.000000 Integratorl -
5 0.000000 Signal Generator .
6 0.000000 Sum
NumParameters =7
ShowParameters = off

Use the Signals INDEX number in target computer commands such as addsignal.

4 To display parameter numbers, type:

tg.ShowParameters="on"

Target: TargetPCl

Connected = Yes

Application = Xpcosc

NumParameters =7

ShowParameters = on

Parameters = INDEX VALUE . . . PARAMETER NAME
0 1000000 . . . Gain
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1 400 . . . Gain

2 1000000 . . . Gain .
3 0 . . . InitialCondition .
4 0 . . . InitialCondition .
5 4 - - - Amplitude

6 20 . - . Frequency

Use the Parameters INDEX number in target computer commands such as setpar.

See Also

SimulinkRealTime.utils.getConsolelog

Related Examples

. “Target Computer Commands”
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Improve Performance of Multirate Model

9-2

In this section...

“Generate Baseline” on page 9-2
“Perform Real-Time Checks” on page 9-6
“Final Validation” on page 9-9

Required Products: Simulink, Simulink Real-Time

Other Requirements:

*  One Windows development computer with an Ethernet card

* One target computer

*  One crossover cable for communication between the development and target
computers

Performance Advisor detects blocks and parameter settings that can reduce performance.
It determines the lower limit on sample time that does not produce a CPU overload.

This example uses model ex_slrt_perfadv (matlab:
open_system(docpath(fullFile(docroot, "toolbox", "xpc", "examples”®,
"ex_slrt_perfadv©)))).

In ex_slIrt_perfadv, the configuration parameter Fixed-step size (fundamental
sample time) is set to auto. The sample time is set in the referenced subsystems using
a MATLAB variable, Ts. You can change the base sample time by changing the value of
Ts.

In this section...

“Generate Baseline” on page 9-2

“Perform Real-Time Checks” on page 9-6

“Final Validation” on page 9-9

Generate Baseline

Before you optimize model ex_slrt_perfadv using Performance Advisor, generate a
baseline.
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Open ex_slrt_perfadv.

Set Activity to Execute real-time application.

A WN —

Determine minimum sample time.

From the Analysis menu, click Performance Tools > Performance Advisor.

Under node Performance Advisor, select all of the Baseline checks except

Determining the minimum sample time can be a lengthy process for a large model

with a long execution time.

5 Select node Baseline, and then click Run selected checks.

1) Performance Advisor - ex_slrt_perfady EI@
File Edit Run Settings Help
Activity: [Execule real-time application  ~ | Find: - (.):' E{P
Real-Time Performance Baseline
4 (= Performance Advisor Analysis (~Trs Update Di )
alysis (~Triggers Update Diagram;
a @ Baseli fy: o0 gl
Q System Target File Compatibility Run on real-time hardware to collect execution time measurements and establish a performance baseline.
Profiling Settings
v @ g =ene Run This Check
0 Check Target
v “Real-Time Performance Baseline
X} Result: ) Failed
D (=] ~Determine minimum sample time
-Time erformance baseline could not be created because the target hardware reported one or more CPU overloads when executing the
> [ 3 Real-Tim Perfi basel Id not b d b i get hard ported CPU loads wh i t
[ EE] ~Final validation model. To proceed, increase the model sample time to a suitable value or use the following check to determine the minimum
achievable sample time:

| Model Advisor
L._ﬁ Upgrade Advisor

(4} Code Generation Advisor

For this model, the Real-Time Performance Baseline action fails because running

the real-time application produced a CPU overload on the target computer.

9-3




9 Tuning Performance

9-4

To remove this condition, increase the sample time to a value greater than the

minimum value that does not cause a CPU overload. To find the minimum sample
time, select the Determine minimum sample time check box, and then click Run

this check.

12 Performance Advisor - ex_slrt_perfadv
File Edit Run Settings Help

Activity: [Btecu(e real-time application  * | Find:

- g

4 (2 Performance Advisor
4 @ Baseline
|:| o System Target File Compatibility
|:| o Prefiling Settings
|:| o Check Target
|:| o “~Real-Time Performance Baseline
o “Determine minimum sample time
s D =1 Real-Time
[ EEl ~Final validation

\JJ Model Advisor
(@l Upgrade Advisor

(4} Code Generation Advisor

sample time
Analysis (~Triggers Update Diagram)

Determine the minimum sample time possible for the model. Allow time for multiple executions of the model.
Run This Check

Result: a Passed

Benchmarking the model on the target showed that the minimum achievable sample time was 0.0021875 s. To aveid CPU

overruns, set the model's sample time to a value greater than this.

Passed

[E=5 B =

To avoid the overloads that random variations can cause, set TS to a value above the
lower limit. For example, set it to 0.003 s.

7 Inthe Command Window, type:

Ts = 0.003

8 Save ex_slrt_perfadv and its reference subsystems.
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9 Clear the Determine minimum sample time check box, select the Real-Time
Performance Baseline check box, and then click Run this check.

|2 Performance Advisor - ex_slrt_perfadv

File Edit Run Settings Help

Activity: [Execule real-time application ¥ | Find:

E I3 Performance Advisor
4 [l % Baseline
o System Target File Compatibility
o Profiling Settings
o Check Target
o “Real-Time Performance Baseline
[1 Z] ~Determine minimum sample time
> [ £ Reak-Time
[E1 EZ] ~Final validation

() Model Advisor
(@l Upgrade Advisor

C.ode Generation Advisor

Real-Time Performance Baseline

Analysis (" Triggers Update Diagram)

Run on real-ime hardware to collect executicn time measurements and establish a performance baseline.

Run This Check

Result: o Passed

Created a real-time performance baseline. Target hardware characteristics: 4 cores, Intel{R) Core(TM) i7-3770K CPU @

3.50GHz.

Margin before CPU overload (0% Indicates CPU overload)

BaseRate [0.003 0] 3

Average CPU Usage

T

N EaseRate
[ |Background

m
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Perform Real-Time Checks

To perform the real-time performance checks on model ex_slrt_perfadyv, first create
a baseline (see “Generate Baseline” on page 9-2). Then carry out the following steps
using Performance Advisor.

1 Under node Performance Advisor, select all of the top-level Real-Time checks.

If you have a license for Simscape™ or its related products, such as Simscape
Driveline™ and Simscape Electronics™, clear those checks. There are no Simscape
or related blocks in the model.

2 Select the Real-Time node, and then click Run selected checks.
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12 Performance Advisor - ex_slrt_perfadv

File Edit Run Settings Help

Acﬁvit\;:[Execule real-time application  * | Find:

o

Mb

4 [C3 Performance Advisor
4 [ﬁ Baseline
o System Target File Compatibility
@ Profiling Settings
@ Creck Target
o “Real-Time Performance Baseline
D (=] ~Determine minimum sample time
4 [@ @ Real-Time
& outport Logging
o EtherCAT Synchronous SDO
4 D ] Simscape checks
0 Check for optimal bus virtuality
o Identify blocks using one-based inde
0 Identify lookup table blocks that geng
0 “~Identify blocks that generate expen
o ~Identify questionable fixed-point op
o “~Identify blocks that generate expen
/i\, “Concurrent execution
D (=] ~Final validation

4| 1 3

(£) Model Advisor
@ Upgrade Advisor

(4} Code Generation Advisor

ent
Analysis (“Triggers Update Diagram)
Check if the model can be run concurrently.

Run This Check

Result: & Warning

‘ex_slrt_perfadv’ is a multi-rate model that can run concurrently, but the configuration parameters do not allow it to do so.
To run this model concurrently on a target started with a multi-core kernel. set the Solver checkbox 'Allow tasks to execute

concurrently on target’ and build the model again.

The model is a multirate model running on a multicore target computer, but it is not
configured to use more than one core.

3 Inthe Solver pane under Additional options, select the check box Allow tasks
to execute concurrently on target. Select the same setting for the reference
subsystems ex_slrt_perfadv_refl and ex_slrt_perfadv_ref2.

4 Save ex_slrt_perfadv and its reference subsystems.
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5 Select the Concurrent execution check box, and then click Run this check.

) Performance Advisor - ex_slrt_perfady EI@
File Edit Run Settings Help
Activity: | Execute real-time application ¥ | Find: - g o

Ci ent

4 [E3) Performance Advisor
4 [ﬁ Baseline
o System Target File Compatibility
0 Profiling Settings
0 Check Target
o “Real-Time Performance Baseline
|:| (=] ~Determine minimum sample time
4 [ Reak-Time ‘ex_slrt_perfadv” is a multi-rate model that can run concurrently. The Solver checkbox "Allow tasks to execute concurrently
o Outport Logging on target' is enabled, so the generated code can execute concurrently.
o EtherCAT Synchronous SDO
> [ IE3) Simscape checks
0 Check for optimal bus virtuality
o Identify blocks using one-based inde:
o Identify lookup table blocks that geng
o “~Identify blocks that generate expen
0 ~Tdentify questionable fixed-point opy
o “~Identify blocks that generate expen
o “Concurrent executicn
[[1 EZ] ~Final validation

Analysis (" Triggers Update Diagram)
Check if the medel can be run concurrently.

Result: o Passed

Passed

4| 1 r

(£) Model Advisor
(@I Upgrade Advisor

(4} Code Generation Advisor

6 Toimprove the minimum sample time, select the Determine minimum sample
time check box, and then click Run this check.

The result shows a sample time less than 0.0003 s. To avoid the overloads that
random variations can cause, set TS to a value above the lower limit. For example,
set it to 0.001 s.
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7 In the Command Window, type:

Ts = 0.001

8 Save ex_slrt_perfadv and its reference subsystems.
Final Validation
The final validation check tests whether model ex_slrt_perfadv works after the

actions in “Generate Baseline” on page 9-2 and “Perform Real-Time Checks” on page
9-6.

1 Select the Final validation check box, and then click Run this check.
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12 Performance Advisor - ex_slrt_perfadv
File Edit Run Settings Help

Activity: | Execute real-time application  ~ | Find:

-G

4 [¥] 3 Performance Advisor
4 105 Baseline
@ System Target File Compatibility
@ Profiling Settings
@ Check Target
0 “Real-Time Performance Baseline
[ =] ~Determine minimum sample time
4 L8 Reak-Time
@ outport Logging
@ EtherCAT Synchronous SDO
b [ ) Simscape checks
@ Check for optimal bus virtuality
0 Identify blocks using one-based indexing
0 Identify lookup table blocks that generate expes
@ ~ldentify blocks that generate expensive round
0 “Identify questionable fixed-point operations
0 “Identify blocks that generate expensive fixed-|
0 “Concurrent execution
@ ~Final validation

q | 1 r

(<) Model Advisor
@ Upgrade Advisor

L‘E. Code Generation Advisor

Final
Analysis (~Triggers Update Diagram)

Compare performance against baseline collected in 'Real-Time Performance Baseline'.

Run This Check

Result: 0 Passed

Margin before CPU overload (0% Indicates CPU overload)

BaseRate [0.0030] 273 Modell RI [0.001 0] 94

Model2_R1 [0.001 0]
Modell_R3 [0.003 0] &
Modell_R2 [0.0020] &

Model2 R3 [0.003 0] 74
Modell R4 [0.004 0]
Model2_R4 [0.004 0] 84.:

Average CPU Usage

Baseline
i

— \ /

Final validation checks completed

-
[
e
] o
[

»

m

2 Toinvestigate further improvements, see “Execution Profiling for Real-Time
Applications” on page 9-20.

See Also

matlab: open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples',

'ex_slrt_perfadv'))) | profile_slirt

More About

9-10

“Execution Profiling for Real-Time Applications” on page 9-20
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“Multicore Processor Configuration” on page 9-12
“CPU Overload Options” on page 9-15

“Multicore Programming with Simulink” (Simulink)
“BIOS Settings”

“Multicore Processors”
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Multicore Processor Configuration

9-12

For better performance on your target computer, you can run multirate real-time
applications on multiple cores. Use this capability if your target computer has a
multicore processor and you want to take advantage of it for multirate models. Before
you consider enabling this capability, see “BIOS Settings” for the effects of BIOS settings.

To build and download multirate models on your multicore target computer:

1 Type slrtexplr in the MATLAB Command Window.

2 Inthe Targets pane, expand the target computer node.

3 Click the Target Properties button & in the toolbar or double-click Properties.

4  Check that the Multicore CPU parameter is selected in the Target settings pane.

5 Open your model in Simulink Editor.

6 Add a Rate Transition block to transition between rates.

Note: Multirate models must use Rate Transition blocks. If your model uses other
blocks for rate transitions, building the model generates an error.

7 Select the Ensure data integrity during data transfer check box of the Rate
Transition block parameters.

8 Clear the Ensure deterministic data transfer (maximum delay) check box of
the Rate Transition block parameters. This setting forces the Rate Transition block
to use the most recent data available.

Note: Because this box is cleared, the transferred data can differ from run to run.

9 In Simulink Editor, select View > Model Explorer.

10 In Simulink Model Explorer, right-click in the Model Hierarchy pane and select
Configuration > Add configuration for concurrent execution

11 In the new configuration, select Solver.

12 Check Enable concurrent tasking.

13 Click Configure Tasks.

See Also

Rate Transition
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More About

. “Multicore Programming with Simulink” (Simulink)
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Limits on Sample Time

9-14

The sample time you can assign to your model is limited by the kernel and by the
complexity of your model.

The kernel enforces lower and upper bounds on sample time:

Mode Lower Bound Upper Bound
Interrupt 8e-6s 10 s
Polling 5e-7s 10s

In the Solver node in the Configuration Parameters dialog box, set Fixed-step size to
a value within these bounds. If you set Fixed-step size to a value outside these bounds
and attempt to build and download the real-time application, the application load fails
with an error message.

At run time, if you attempt to set the sample time to a value outside these bounds, the
kernel prints an error message.

Within these bounds, if you specify too short a sample time for the complexity of your
model, the target computer can experience a CPU overload. To address this problem, use
the following procedure:

1 To find the minimum sample time for your model, run
SimulinkRealTime.utils_minimumSampleTime in the Command Window.

2 Change the value of Fixed-step size to a value slightly above the minimum sample
time value.

3 Rebuild and download the model.

See Also

SimulinkRealTime.utils._getConsolelog
SimulinkRealTime.utils_minimumSampleTime

More About

. “Real-Time Application Execution Produces CPU Overloads” on page 24-5

. “Execution Modes” on page 6-2
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CPU Overload Options

In this section...

“Option Behavior” on page 9-15

“Violation of xPCMaxOverloads” on page 9-17
“Violation of xPCMaxOverloadLen” on page 9-18
“Violation of xPCStartupFlag” on page 9-18

Sometimes a real-time application running on the target computer does not have enough
time to complete processing before the next time step. This condition is called a CPU
overload. An overload is registered every time an execution step cannot be executed
because a previous step is running.

For example, assume that your model sample time is 1 ms, but running a particular
model step takes 3.1 ms. This model step causes the kernel to skip three steps and
causes three overloads.

Typically, the Simulink Real-Time kernel halts model execution when it encounters a
CPU overload. However, some real-time applications can tolerate several CPU overloads
without significant loss of data, for example during start up. For such applications, you
can allow a specified number and configuration of CPU overloads. You do this using the
TLCOptions settings XPCMaxOver loads, xPCMaxOverloadLen, and xPCStartupFlag.

Note: Allowing the target computer CPU to overload can cause incorrect results,
especially for multirate models. Use these options only for diagnosis. When your
diagnosis is complete, turn off these options.

Option Behavior

If your real-time application causes a CPU overload, it finishes the current execution
step and ignores timer interrupts. At the end of the execution step, the kernel

compares the CPU overload count to the limits defined by xPCMaxOver loads and
XPCMaxOverloadLen. If the count does not exceed the limits, the application executes at
the next step. Otherwise it stops.

The limits are:
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+ XPCMaxOver loads — Number of acceptable overloads during a real-time application
execution.

When xPCMaxOver loads is set to a value, the Simulink Real-Time software stops
execution with a CPU overload at the next overload within the same application
execution. For example, if xPCMaxOver loads is set to 3, the software stops with a
CPU overload at the fourth overload in the same application execution.

The default value of O means that overloads are registered on the first step.

+  XPCMaxOver loadLen — Number of acceptable overloads, in units of sample time,
within the same execution step.

When xPCMaxOver loadLen is set to a value, the software stops execution with a
CPU overload at the next overload within the same execution step. For example, if
XPCMaxOver loadLen is set to 2, the software stops execution with a CPU overload at
the third overload within the same execution step.

The default value of O means that overloads are registered on the first step.

Specify a value that is less than or equal to the value for xPCMaxOver loads. If
XPCMaxOver load is set to a value, for example 4, and xPCMaxOver loadLen is not
defined, the real-time application stops if one of following occurs:

The cumulative overloads since execution start is greater than 4.
*  One execution step has two overloads.

* XPCStartupFlag — Number of executions of the model at start up.

XPCStartupFlag temporarily disables the timer interrupt during model execution.
After the model finishes the first XPCStartupFlag number of executions, the
software reenables the timer interrupt, which invokes the next execution for the
model.

The default value of 1 means that overloads are ignored on the first step. If
XPCMaxOverloads and xPCMaxOver loadLen are not set, their default setting
governs.

XPCMaxOver loads and xPCMaxOver loadLen both count overloads, but over different
time spans. XPCMaxOverloads counts the CPU overloads that were seen so far in the

real-time application execution. XPCMaxOver loadLen counts the overloads that were

seen within one execution step.
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The three options interact. When the Simulink Real-Time kernel runs the model,

it compares the number of CPU overloads to the values of xPCMaxOverloads and
xPCMaxOver loadLen. When the number of CPU overloads reaches the lower of these
two values, the kernel stops executing the model.

Suppose that you enter the following TLCOptions settings for model Xxpcosc.

set_param(“xpcosc®, "TLCOptions~, "-axPCMaxOverloads=30
-axPCOverLoadLen=2 -axPCStartupFlag=5-")

With these settings, the software ignores CPU overloads for the first five iterations
through the model. After the first five iterations, the software allows up to 30 CPU
overloads, allowing at most two CPU overloads per model step.

You can use the blocks Set Overload Counter and Get Overload Counter to set and track
CPU overload numbers. You can use the Time Stamp Counter block to profile your model

Violation of xPCMaxOverloads

Assume that xPCMaxOver loads is 3 and xPCMaxOverloadLen is 2. The software
tolerates the first three overloads and stops executing at the fourth. The number of
overloads exceeds the maximum number allowed for real-time execution.

xPCMaxQverloads = 3
xPCMaxQverloadlLen =2

Sample time
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Violation of xPCMaxOverloadLen

Assume that xPCMaxOverloads is 3 and XxPCMaxOverloadLen is 1. The software
tolerates the first two overloads and stops executing at the third. The second step
execution is longer than the maximum allowed overload length of one sample time.

xPCMaxQverloads = 3
xPCMaxOverloadLen =1

Sample time

t# =
- ]
© i
& 3
[ 1 ]
Model
steps
|
[

Violation of xPCStartupFlag

Assume that xPCStartupFlag is 3. The kernel ignores CPU overloads for the first three
time steps and stops executing on the first overload in the next time step.

xPCStartupFlag =3

pee)
&
2
Model
steps
|
[

Sample time
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See Also
Get Overload Counter | Set Overload Counter | Time Stamp Counter | TLCOptions
Properties
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Execution Profiling for Real-Time Applications

9-20

You can profile the task execution time and function execution time of your real-time
application running on the target computer. Using that information, you can then tune
its performance.

Profiling is especially useful if the real-time application is configured to take advantage
of multicore processors on the target computer. To profile the real-time application:

1 In the Configuration Parameters for the model, enable the collection of profile data
during execution.

2 Build, download, and execute the model.

3 Call profile_slrt to collect and display the profile data.

Profiling slightly increases the execution time of the real-time application.

In this section...

“Configure Real-Time Application for Profiling” on page 9-20

“Generate Real-Time Application Execution Profile” on page 9-22

Configure Real-Time Application for Profiling

This example shows how to configure model dxpcmds6t for task execution profiling.

Open model dxpcmds6t.

2 In the top model, open the Configuration Parameters dialog box, and select Code
Generation > Verification.

3 Select the Measure task execution time check box.
Task execution time (TET) measures how long it takes the kernel to run for one

base-rate time step. For a multirate model, use the profiler to find out what the
execution time is for each rate.

4 If you also want to profile function execution times, select the Measure function

execution times check box.



Execution Profiling for Real-Time Applications

2 Configuration Parameters: dxpcmds6t/Configuration (Active)

* Commonly Used Parameters | = All Parameters

3

Select:
Solver
Data Import/Export

> Optimization

Diagnostics
Hardware Implementation
Model Referencing
Simulation Target
Code Generation
Report
Comments
Symbols
Custom Code
Simulink Real-Time Options
Verification

> Coverage

HDL Code Generation

Code profiling
Measure task execution time

[T] Measure function execution times

m

< |

9

L}

[ OK ” Cancel H Help Apply

5 Under Code Generation, select Simulink Real-Time Options.

6 Type a value for Number of profiling events (each uses 20 bytes).

By default, the software logs 5000 events for profiling. You can increase or decrease
this number to manage memory usage. When the software logs the specified number
of events or the model stops, the software stops collecting the data. The software
writes the data to current_working folder\xPCTrace.csvV on the target

computer.
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8 Save model dxpcmds6t.

Generate Real-Time Application Execution Profile

This example shows how to generate profile data for model dxpcmds6t using default

settings on a multicore target computer.

@0C ion Parameters: dxpemds6t/C ion (Active) ==
* Commonly Used Parameters ‘ = All Parameters P
Select: Target options
Solver Build for default target computer
Data Import/Export
» Optimization Automatically download application after building
> Diagnostics
Hardware Implementation
Model Referencing Name of Simulink Real-Time object created by build process t
Simulation Target ] P 9
4 Code Generation
Report E
Comments Use default communication timeout
Symbols
Custom Code Execution options
Simulink Real-Time Options
Verification Execution mode [Realf'l'lme ']
> Coverage
» HDL Code Generation
Real-time interrupt source [ﬁmer ']
1/O board generating the interrupt [Nonefother ']
PCI slot (-1: autosearch) or ISA base address -1
Data logging options
Log Task Execution Time
Signal logging data buffer size in doubles 100000
Number of profiling events (each uses 20 bytes) 5000
.‘) OK ] I Cancel ] I Help Apply
7 Click OK.
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This procedure assumes that you have configured the target computer to take advantage
of multiple cores. It also assumes that you previously configured the model for task and
function execution profiling.

Build and download the model.

mdl = “"dxpcmds6t”;
open_system(mdl)
rtwbuild(mdl)

When you include profiling, the Code Generation Report is generated by default. It

contains links to the generated C code and include files. By clicking these links, you can
examine the generated code and interpret the Code Execution Profile Report.
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Code Generation Report EI@
@& Find: 4+ W Match Case
. 1 1 i
Contents Code Generation Report for ‘dxpcmds6t
Summary
Subsystem Report Model Information
Generated Code Author The MathWorks, Inc.
-1 Model files Last Modified By The MathWorks, Inc.
dxpermdsBt.c Model Version 1.25 =
' Tasking Mode MultiTasking
dxpcmdsét.h
dxpcmds6t_private.h Configuration settings at time of code generation
dxpcmds6t_types.h
(-1 Data files Code Information
dxpcmds6t_data.c 1
System sirt.tlc
‘+1 Shared files (11) Target File
[+] Interface files (3) Hardware  Generic->32-bit x86 compatible
Device
(+1 Other files (7) Type
Simulink 8.12 (R2017a) 09-Dec-2016
Referenced Models Coder
d p 1 Version
xpemes_re Timestamp Thu Dec 22 14:05:35 2016
dxpcmds_ref2 of
Generated il
4 m | 3
ok || Help

Execute the real-time application.
tg = slrt;

start(tg)

pause(2)

stop(tg)

Profile the real-time application execution.

profilelnfo.modelname = “dxpcmds6t.mdl®;
profData = profile_slrt(profilelnfo);
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The Execution Profile plot shows the allocation of execution cycles across the four
processors, indicated by the colored horizontal bars.

E Execution Profile E@

File Edit View Inset Tools Desktop Window Help

Dede | bR UDEL- 208 a0

Estimated Execution Time-line

oo
=
oo
(N

Model2_R4 [0.004 0]

T
-
£
£

Model1_R4 [0.004 0]

Model2 R3[0.0030]F B L] 6iPL] G 6P

T
o
(5]
wn
=
wn
(5]
wn
=

Model1_R3 [0.003 0]

Model1 _R2 [0.002 0] |4 4 4 4 4
Model2_R1 [0.001 0] 3 3 3 3 3 3 = 3 3 3
Model1_R1 [0.001 0] 2 2 2 2 2 2 2 2 2 2
Timer Interrupt 1 1 1 1 1 1 1 1 1 1 1 1
1] 0.002 0.004 0.006 0.008 0.01
Time in seconds
Start: |p Range: 0.011853 I

The Code Execution Profiling Report displays model execution profile results for each
task.
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Code Execution Profiling Report

1. Summary
Total time (seconds = 1e-09)
Measured time display options
Profiling data created

2. Profiled Sections of Code

Section
Timer Interrupt

Modell R1[0.0010
Model2 R1[0.0010
Modell R2[0.0020
Modell R370.0030
Model2 B3 [0.003 0
Modell R4[0.0040
Model2 R4 [0.0040

3. Definitions

9-26

Timer frequency (ticks per second)

431946979

('Units', 'Seconds', 'ScaleFactor', '1e-09",

"NumericFormat', '%0.0f)
3.49207e+09
22-Dec-2016 14:07:17

Maximum Average
Turnaround  Turnaround
Time Time
2404 393
58178 53962
62959 62553
268476 267695
552066 537165
1101930 966373
9246 7466
934347 711946

Maximum
Execution
Time
2404
58178
62959
268476
552066
716344
9246

552688

Execution Time: Time between start and end of code section, which excludes preemption time.

Turnaround Time: Time between start and end of code section, which includes preemption time.

Code Execution Profiling Report for dxpcmds6t

Average
Execution
Time

393

267693
537165
715489

7466

545882

Calls

179

178

134

134

B EEEEE B

The code execution profiling report provides metrics based on data collected from real-time simulation. Execution times are calculated from data
recorded by instrumentation probes added to the generated code. See Code Execution Profiling for more information.

OK

) (

Help
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Profile Data Description
Maximum turnaround Longest time between start and end of code section, which
time includes preemption time.

Average turnaround time |Average time between start and end of code section, which
includes preemption time.

Maximum execution time |Longest time between start and end of code section, which
excludes preemption time.

Average execution time |Average time between start and end of code section, which
excludes preemption time.

Calls Number of calls to the code section.

To display the profile data for the generated code section, click the Membrane
button 4 in the Coder Execution Profiling Report.

Close the model.

close_system(mdl,0)

See Also

profile_slirt

More About

. “Multicore Processor Configuration” on page 9-12
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Building Referenced Models in Parallel

9-28

The Simulink Real-Time software allows you to build referenced models in parallel
on a compute cluster. In this way, you can more quickly build and download real-time
applications to the target computer.

The following procedure assumes that you have a functioning Simulink Real-Time
installation on your development computer.

1

Identify a set of worker computers, which can be separate cores on your development
computer or computers in a remote cluster running under Windows.

If you intend to use separate cores on the development computer, install Parallel
Computing Toolbox on the development computer.

If you intend to use computers in a remote cluster:

a Install the following on each cluster computer:

- MATLAB

+ Parallel Computing Toolbox

+ MATLAB Distributed Computing Server™

+  Simulink Real-Time

*  Build compiler
Install the same compiler and compiler version at the same location as on the
development computer.

b Start and configure the remote cluster according to the instructions at
www.mathworks.se/support/product/DM/installation/ver_current.

Run MATLAB on the development computer.
In MATLAB, call the parpool function to open a parallel pool on the cluster.

To configure the compiler for the remote workers as a group, call the pctRunOnAll
function. For example:

pctRunONAII("slrtsetCC(""VisualC™",
""C:\Program Files\Microsoft Visual Studio 9.0"")")

In this configuration, the development computer and the remote workers have
installed Microsoft Visual Studio 9.0 at C:\Program Files\Microsoft Visual
Studio 9.0.


https://www.mathworks.se/support/product/DM/installation/ver_current/

Building Referenced Models in Parallel

7 Build and download your model.

See Also
parpool | pctRunOnAll

More About
“Reduce Build Time for Referenced Models” (Simulink Coder)
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Real-Time Applications and Scopes in
the MATLAB Interface

* “Real-Time Application Objects” on page 10-2

+ “Real-Time Scope Objects” on page 10-6

* “Acquire Signal Data with File Scopes” on page 10-11

* “Acquire Signal Data into Dynamically Named Files” on page 10-13
* “Scope Trigger Configuration” on page 10-15

+ “Pretriggering and Posttriggering of Scopes” on page 10-16

* “Trigger One Scope with Another Scope” on page 10-19

+ “Acquire Gap-Free Data with Two Scopes” on page 10-26
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Real-Time Application Objects

10-2

The Simulink Real-Time software uses a Simul inkRealTime. target object to
represent the target kernel and your real-time application. Use real-time application
object functions to run and control real-time applications on the target computer with
scope objects to collect signal data.

An understanding of the real-time application object properties and functions helps you
to control and test your real-time application on the target computer.

A real-time application object on the development computer represents the interface
to a real-time application and the kernel on the target computer. You use real-time
application objects to run and control the real-time application.

When you change a real-time application object property on the development computer,
information is exchanged with the target computer and the real-time application.

To create a real-time application object:

1  Build a real-time application. The Simulink Real-Time software creates a real-time
application object during the build process.

2 Use the real-time application object function Simul inkRealTime.target. In the
MATLAB Command window, type:

tg = SimulinkRealTime.target

A SimulinkReal Time.target object has properties and functions specific to that
object. The real-time application object functions allow you to control a real-time
application on the target computer from the development computer. You enter real-
time application object functions in the MATLAB window on the development computer,
or you can use MATLAB code scripts. To access the help for these functions from the
command line, use the syntax:

doc SimulinkRealTime.target/function_name

If you want to control the real-time application from the target computer, use target
computer commands (see “Control Real-Time Application at Target Computer Command
Line” on page 8-2).

Create Real-Time Application Objects

To create a real-time application object:



Real-Time Application Objects

Build a real-time application. The Simulink Real-Time software creates a real-time
application object during the build process.

To create a specific real-time application object, or to create multiple real-time
application objects in your system, use the real-time application object function
SimulinkRealTime.target with arguments. For example, to create a real-time
application object for target TargetPC1, in the MATLAB Command Window, type:

tg = SimulinkRealTime.target("TargetPCl")
The resulting real-time application object is tg.

Using this function clarifies which application object is associated with a particular
target computer.

To check a connection between development and target computers, use the target
function SimulinkRealTime.target.ping. For example, type:

ping(tg)

To create a real-time application object for the default target computer, use the

creation function Simul inkRealTime. target without arguments. For example, in
the MATLAB Command Window, type:

tg = SimulinkRealTime.target

The resulting real-time application object is tg.

Note: If you use SimulinkRealTime.target without arguments to create a real-time
application object, use Simulink Real-Time Explorer to configure your target computer.
Doing so clarifies which real-time application object is associated with a particular target
computer.

Display Application Object Properties

To monitor a real-time application, list the real-time application object properties. The
properties include the execution time and the average task execution time.

After you build a real-time application and real-time application object from a Simulink
model, you can list the real-time application object properties. This procedure uses the
default real-time application object name tg as an example.

In the MATLAB window, type:
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tg = slrt;

The current real-time application properties are uploaded to the development
computer. MATLAB displays a list of the real-time application object properties with
the updated values.

The real-time application object properties for TimeLog, StatelLog, OutputlLog, and
TETLoOg are not yet updated.

2 Type:
start(tg)

The Status property changes from stopped to running. The log properties change
to Acquiring.

For a list of real-time application object properties with a description, see
SimulinkRealTime.target.

Set Real-Time Application Object Property Values

You can change a real-time application object property by using the Simulink Real-Time
dot notation on the development computer. (For limitations on target property changes to
sample times, see “Alternative Configuration and Control Methods”.)

With the Simulink Real-Time software, you can use object property syntax to change the
real-time application object properties.

target_object.property _name = new_property_ value

For example, to change the stop time for the real-time application running on target tg,
in the MATLAB window, type:

tg = sirt;
tg.StopTime = 1000

When you change a real-time application object property, the new property value is
downloaded to the target computer. The Simulink Real-Time kernel then receives the
information and changes the behavior of the real-time application.

To get a list of the writable properties, type target_object. The build process assigns
the default name of the real-time application object to tg.
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Get Real-Time Application Object Property Values

You can list a property value in the MATLAB window or assign that value to a MATLAB
variable. With the Simulink Real-Time software, you can use object property syntax.

target_object.property_name

For example, to access the stop time for the real-time application running on target tg,
in the MATLAB window, type:

tg = slrt;
endrun = tg.StopTime

To get a list of readable properties, type target_object. Without assignment to a
variable, the property values are listed in the MATLAB window.

Signals are not real-time application object properties. To get the value of the
Integratorl signal from the model xpcosc, in the MATLAB window, type:

outputvalue = getsignal(tg, 0)

0 is the signal index.

Note: Function names are case-sensitive. Type the entire name. Property names are not
case-sensitive. You do not need to type the entire name, as long as the characters that
you do type are unique for the property.

Use Real-Time Application Object Functions

To run a real-time application object function, use the
function_name(target object, argument_ list) syntax.

Unlike properties, for which partial but unambiguous names are permitted, you must
enter function names in full, in lowercase. For example, to add a target scope with a
scope index of 1, in the MATLAB window, type:

tg = sirt;
addscope(tg, "target”,1)
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Real-Time Scope Objects

10-6

The Simulink Real-Time software uses scope objects to represent scopes on the target
computer. Use scope object functions to view and collect signal data.

The Simulink Real-Time software uses scopes and scope objects as an alternative to
using Simulink scopes and external mode. A scope can exist as part of a Simulink model
system or outside a model system.

* A scope that is part of a Simulink model system is a Scope block. You add a Simulink
Real-Time Scope block to the model, build a real-time application from that model,
and download that application to the target computer.

+ A scope that is outside a model is not a Scope block. For example, if you create a scope
with the Simul inkReal Time.target.addscope function, that scope is not defined
within the model. After the model has been downloaded and initialized, you add this
scope to the model.

This difference affects when and how the scope executes to acquire data.

Scope blocks inherit sample times. A Scope block in the root model or a normal
subsystem executes at the sample time of its input signals. A Scope block in a
conditionally executed (triggered/enabled) subsystem executes whenever the containing
subsystem executes. In the latter case, the scope can acquire samples at irregular
intervals.

A scope that is not part of a model executes at the base sample time of the model. For
signals with a sample time longer than the base sample time, it acquires repeated
identical samples. For example, assume that the model base sample time is 0.001 and
that you dynamically add to the scope a signal whose sample time is 0.005. The scope
acquires five identical samples for this signal at each signal sample time.

Understanding the structure of scope objects helps you to use the MATLAB command-
line interface to view and collect signal data. A scope object on the development computer
represents a scope on the target computer. You use scope objects to observe the signals
from your real-time application during a real-time run or analyze the data after the run
is finished.

To create a scope object:

* Add a Simulink Real-Time Scope block to your Simulink model. To determine
the scope type, set the Scope type parameter. To create a scope on the target
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computer, build and download the model. Use the real-time application object function
SimulinkRealTime.target.getscope to create a scope object on the development
computer.

*  Build and download a model. Use the real-time application object function
SimulinkRealTime.target.addscope to create a scope on the development
computer. To determine the scope type, pass one of the following values as input
parameter: target, host, or File.

Upon creation, the Simulink Real-Time software assigns the required
scope object class for the scope type: Simul inkReal Time. targetScope,
SimulinkReal Time.hostScope, or Simul inkRealTime.fileScope.

A scope object has properties and functions specific to its scope type, as well as properties
and functions in common with the other scopes. The scope object functions allow you to
control scopes on your target computer.

To control the real-time application from a target computer keyboard, use target
computer commands (see “Control Real-Time Application at Target Computer Command
Line” on page 8-2).

Display Scope Obiject Properties for One Scope

To list the properties of a single scope object, scl, in the MATLAB window, type:

tg = slirt;
scl = getscope(tg,1)

MATLAB creates the scope object scl from a previously created scope.
The current scope properties are uploaded to the development computer. MATLAB

displays a list of the scope object properties with the updated values. Because scl is a
vector with a single element, you could also type sc1(1) or sc1([1]).

Note: Only scopes of type host store data in the properties scope_object.Time and
scope_object.Data.

For a list of real-time application object properties with a description, see the target
function SimulinkRealTime. target.
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Display Scope Obiject Properties for Multiple Scopes

To list the properties of the current scope objects associated with the real-time
application object tg, in the MATLAB window, type:

tg = slirt;
getscope(tg)

SimulinkRealTime. target.getscope supports vector arguments. For example, to
list the first and third scopes, type:

getscope(tg, [1,3])
To assign a list of current scopes to a variable, type:
allscopes = getscope(tg)

For a list of real-time application object properties, see the target function
SimulinkRealTime.target.

Set Scope Property Values

With the Simulink Real-Time software, you can use object property syntax to set a single
scope object property.

scope_object.property_name = new_property_value

For example, to change the trigger mode for scope 1, in the MATLAB window, type:
tg = slirt;

scl = getscope(tg, 1);

scl.triggermode = “signal”

You cannot use dot notation to set vector object properties. To assign a property value to
a vector of scopes, use the set function. For example, assume that you have two scopes, 1
and 2. First assign a vector containing these scopes to the variable sc12:

scl2 = getscope(tg, [1,2]);
To set the NumSamples property of these scopes to 300, type:
set(scl2, “NumSamples®, 300);

To get a list of the writable properties, type scope_object.
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Note:

*  You cannot set a property of a vector of scopes to a vector of property values. For
example, you cannot set property NumSamples of vector sc12 to [100,200].

* Function names are case-sensitive. Type the entire name. Property names are not
case-sensitive. You do not need to type the entire name, as long as the characters that
you do type are unique for the property.

Get Scope Property Values

You can list a property value in the MATLAB window or assign that value to a MATLAB
variable. With the Simulink Real-Time software, you can use object property syntax to
get scope property values.

scope_object_vector(index_vector).property_nhame

For example, to get the number of samples from scope 1, in the MATLAB window, type:
tg = sirt;

scl = getscope(tg, 1);
scl.NumSamples

To get the values of vector object properties set using the set function, you can use the
corresponding get function. For example, assume that you have two scopes, 1 and 2,
with a NumSamples property of 300.

First assign a vector containing these scopes to the variable sc12.
scl2 = getscope(tg, [1.,2]);

To get the value of NumSamples for these scopes, type:

get(scl2, “"NumSamples*®)

You get a result like:

ans =
[300]
[300]

Although you cannot use dot notation to set the values of vector object properties, you can
use it to get those values:
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scl2 _NumSamples

You get a result like:

ans =
300

ans =
300

To get a list of readable properties, type scope_object. The property values are listed
in the MATLAB window.

Note: Function names are case-sensitive. Type the entire name. Property names are not
case-sensitive. You do not need to type the entire name, as long as the characters that
you do type are unique for the property.

Use Scope Object Functions

Use the function syntax to run a scope object functions:
function_name(scope_object, argument_list)

Unlike properties, for which partial but unambiguous names are permitted, enter
function names in full, in lowercase. For example, to add signals to the first scope in a
vector of all scopes, in the MATLAB window, type:

allscopes = getscope(tg)
addsignal (allscopes(1), [0,1])
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Acquire Signal Data with File Scopes

You can acquire signal data into a file on the target computer. To do so, you can include a
real-time file scope in your Simulink Real-Time model. Alternatively, after you build the
real-time application and download it to the target computer, you can add a file scope to
that application.

For example, to add a file scope named sc to the real-time application, and to add signal
4 to that scope:

1

In the MATLAB window, type:

sirt;
addscope(tg, “file™)

tg
sc

The Simulink Real-Time software creates a file scope for the real-time application.

To add signal 4, type:

addsignal(sc, 4)

Caution: Before starting the scope, copy previously acquired data to the development
computer. When the file scope starts, the software overwrites previously acquired
data in files of the specified name or name pattern. A partially overwritten file or a
file that is opened but left unwritten loses its original contents.

To start the scope, type:

start(sc)

To start the real-time application, type:

start(tg)

The Simulink Real-Time software adds signal 4 to the file scope. When you start the
scope and the real-time application, the scope saves the signal data for signal 4 to a file,
by default named C:\data.dat.

For more information on file scopes, see “Configure Real-Time File Scope Blocks” on
page 5-82.

To retrieve the file programmatically from the target computer for analysis, see
“Using SimulinkRealTime.fileSystem Objects” on page 11-5.
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* To acquire signal data into multiple files, see “Acquire Signal Data into Dynamically
Named Files” on page 10-13.
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Acquire Signal Data into Dynamically Named Files

You can acquire signal data into multiple, dynamically named files on the target
computer. For example, you can acquire data into multiple files to examine one file while
the scope continues to acquire data into other files.

To acquire data into multiple files, you can include a real-time file scope in your Simulink
Real-Time model. Alternatively, after you build a real-time application and download

it to the target computer, you can add a file scope to that application. You can then
configure that scope to log signal data to multiple files.

For example, configure a file scope named sc to the real-time application. The file scope
has these characteristics:

+ Logs signal data into up to nine files whose sizes do not exceed 4096 bytes.

Creates files whose names contain the character vector file_.dat.

Contains signal 4.
1 Inthe MATLAB window, type:

tg = slirt;
tg.StopTime = Inf;

This parameter value directs the real-time application to run indefinitely.
2 To add a file scope, type:

sc = addscope(tg, "file™);
3 To enable the file scope to create multiple log files, type:

sc.DynamicFileName = "on";

Enable this setting to enable logging to multiple files.

4 To enable file scopes to collect data up to the number of samples, and then start over
again, type:

sc.AutoRestart = "on”";

Use this setting for the creation of multiple log files.
5 To limit each log file size to 4096, type:

sc.MaxWriteFileSize = 4096;
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You must use this property. Set MaxWriteFileSize to a multiple of the WriteSize
property.

6 To enable the file scope to create multiple log files with the same name pattern, type:

sc.Filename = "fTile <\>._.dat";

This sequence directs the software to create up to nine log files, Fille_1.dat to
file_9.dat on the target computer file system.

7 To add signal 4 to the file scope, type:
addsignal(sc, 4);

8 Caution: Before starting the scope, copy previously acquired data to the development
computer. When the file scope starts, the software overwrites previously acquired
data in files of the specified name or name pattern. A partially overwritten file or a
file that is opened but left unwritten loses its original contents.

To start the scope, type

start(sc)
9 To start the real-time application, type

start(tg)

The software creates a log file named file_1.dat and writes data to that file. When
the size of File_1.dat reaches 4096 bytes (value of MaxWriteFileSize), the software
closes the file and creates File_2.dat. When its size reaches 4096 bytes, the software
closes it and creates File_3.dat, and so on.

The software repeats this sequence until it fills the last log file, File_9.dat. If the
real-time application continues to run and collect data after File_9.dat, the software
reopens Fille_1._dat and overwrites the existing contents. It cycles through the other log
files sequentially.

+  For more information on file scopes, see “Configure Real-Time File Scope Blocks” on
page 5-82.

+ To retrieve the file programmatically from the target computer for analysis, see
“Using SimulinkRealTime.fileSystem Objects” on page 11-5.

* To acquire signal data into a single file, see “Acquire Signal Data with File Scopes” on
page 10-11.
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Scope Trigger Configuration

You can configure Simulink Real-Time scopes to acquire data right away, or define
triggers for scopes so that the Simulink Real-Time scopes wait until they are triggered to
acquire data. You can configure Simulink Real-Time scopes to start acquiring data when
a predefined trigger condition is met. The exact condition depends on the trigger mode
that you select.

* Freerun — Acquires data when the scope is started (default).

+ Software — Acquires data in response to a user request, such as a call to
one of the Scope functions (Simul inkRealTime.FileScope.trigger,
SimulinkReal Time_hostScope.trigger, and
SimulinkRealTime.targetScope.trigger) or a call to a C or NET API function
(XPCScSoftwareTrigger, xPCScope . Trigger).

+ Signal — Acquires data when a particular signal has crossed a preset level.

* Scope — Acquires data when another (triggering) scope starts.

You can use several additional properties to refine when a scope starts to acquire data.
For example, if you want the scope to be triggered when another signal crosses a certain
value, use Signal trigger mode. Specify:

* The signal to trigger the scope.

* The trigger level that the signal must cross to trigger the scope to start acquiring
data.

*  Whether the scope is triggered on a rising signal, falling signal, or either one.

The trigger point is the sample at which the scope trigger condition is satisfied. For
signal triggering, the trigger point is the sample at which the trigger signal passes
through the trigger level. At the trigger point, the scope acquires the first sample. By
default, scopes start acquiring data from the trigger point onwards. You can modify this
behavior using pretriggering and posttriggering with the NumPrePostSamples scope
property. See “Pretriggering and Posttriggering of Scopes” on page 10-16.
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Pretriggering and Postiriggering of Scopes

By default, the scope starts acquiring data at the same time as the trigger event (the
trigger point). Sometimes, to observe the values that led to the trigger, you start
acquiring data a given number of samples before the trigger event (pretriggering). Other
times, to observe the system settling after the trigger, you delay acquiring data a given
number of samples after the trigger event (posttriggering).

Use the NumPrePostSamples scope property to specify pretriggering and posttriggering.
A negative value indicates pretriggering and a positive value indicates posttriggering.
For example, suppose that P is the value of NumPrePostSamples for Scope 1 and TP is
the trigger point, the sample where the trigger event occurs.

* P = 0— Scope 1 starts acquiring data immediately at trigger point TP.

Simple triggering (P =0)
TP

First Sample End of
Acquired Acquisition

T

Tri r
Event

* P < 0— Scope 1 starts acquiring data |P| samples before trigger point TP.
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Pre-triggering (P < 0)

First Sample End of
Acquired N AOC]UIISIIIDH
TP
Pl (N+P) i
Trigger
Evont

P > 0 — Scope 1 starts acquiring data P samples after trigger point TP.
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Post-triggering (P> 0)

End of
TP Acquisition
(N+P) :
P N i

e |
1

First éample
Acquired

Tri r
Event
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Trigger One Scope with Another Scope

When you have started two scopes that you want to keep synchronized, you can trigger
one scope with another to acquire data. Set up the first scope with the trigger of your
choice, and then trigger the second scope from the first.

In this setup, Scope 1 triggers Scope 2.

1  Two scope objects are configured as a vector with the command.:

sirt;
addscope(tg, “host®, [1 2]):

2 For Scope 1, set these values:

tg
sc

sc(l)-Scopeld =1
sc(1) -NumSamples = N1
sc(1) -NumPrePostSamples = P1

3 For Scope 2, set these values:

sc(2).Scopeld = 2

sc(2) -NumSamples = N2
sc(2).TriggerMode = "Scope”
sc(2)-TriggerScope = 1

sc(2) -NumPrePostSamples = P2

Because Scope 1 triggers Scope 2, the trigger point TP is the same for both scopes.
However, Scopes 1 and 2 can acquire different samples.

In this section...

“Scope-Triggered Data Acquisition” on page 10-19

“Trigger Sample Setting” on page 10-22

Scope-Triggered Data Acquisition

Some representative relationships between data acquisitions by Scope 1 and Scope 2 are
shown in the figures. P1 and P2 are the values of NumPrePostSamples for Scopes 1 and
2. TP is the trigger point, the sample where a trigger event occurs, for both Scopes 1 and
2. Scope 2 begins acquiring data as described.

* P1 = 0and P2 = 0 — Scope 1 and Scope 2 start acquiring data immediately at
trigger point TP.
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TP Scope 1 Simple triggering (P1 =0)
First Slample End of
Acquired Acquisition

N1

TP Scope 2 Simple triggering (P2 =0)

First Sample End of
Acquired Acquisition

|

Tri r
Event

N2

P1 < Oand P2 > 0— Scope 1 starts acquiring data |P1] samples before trigger
point TP. Scope 2 starts acquiring data P2 samples after trigger point TP.

10-20



Trigger One Scope with Another Scope

Scope 1 Pre-triggering (P1 < 0)

First Sample End of
Acquired Acquisition
| N1 ?
TP ;
L |P1] (N1 +P1)

Scope 2 Post-triggering (P2 > 0)

End of
TP Acquisition

| (N2 + P2) i
P2, N2 |
" First éample
x Acquired

Trigger

Event

P1 > O and P2 < 0— Scope 1 starts acquiring data P1 samples after trigger point
TP. Scope 2 starts acquiring data |P2] samples before trigger point TP.
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Scope 1 Post-triggering (P1 > 0)

A End of
TP uisition
; (N1 +P1) o
L PL N1 §
" First Sample
| Acquired
| Scope 2 Pre-triggering (P2 < 0)
First Sample | End of
Acquired ! Acquisition
| N2 a
1p2y T (N2 +P2) ;
Trigger
Event

Trigger Sample Setting

For additional flexibility in scope triggering, you can use the Scope 2 trigger sample
setting.

sc(2).TriggerSample = range 0 to (N + P1 - 1)
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sc(2).TriggerSample = O (default) — Scope 2 triggers when Scope 1 triggers.
Trigger point TP is the same sample for both scopes.

TP Scope 1 Simple triggering (P1=0)
First Slample End of
Acquired Acquisition

N1

TP Scope 2 Simple triggering (P2 = 0)

First Sample End of
Acquired Acquisition

N2

|

Tri r
Event

sc(2).TriggerSample = ts > 0 — Scope 2 triggers ts samples after Scope 1 is
triggered. Trigger point TP2 for Scope 2 is ts samples after TP1 for Scope 1.
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Scope 2 Delayed triggering (ts > 0)

ts N2

TP1
First Sample End of
Acquired Acquisition
N1
| P2
First Sample End of
! Acquired Acquisition

|

Tri r
Event

Setting sc(2) -TriggerSample to a value ts larger than (N + P - 1) does not
cause an error. It implies that Scope 2 cannot be triggered, because Scope 1 cannot
acquire more than (N + P - 1) samples after TP.

sc(2).-TriggerSample = -1 (special case) — Causes Scope 2 to start acquiring
data from the sample after Scope 1 stops acquiring.
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Scope 2 Special delayed triggering (ts =-1)

TP
irst S End of
First Sample LUl
Aoquireg Aoqwlsmon
i N1
Trager First éample End of

Event Acquired Acquisition

N2
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Acquire Gap-Free Data with Two Scopes

10-26

With two scopes, you can acquire gap-free data. Gap-free data is data that two scopes

acquire consecutively, without overlap. The first scope acquires data up to sample N, then

stops. The second scope begins to acquire data at sample N+1.

In this example, the TriggerMode property of Scope 1 is set to "Software”. This
setting allows Scope 1 to be triggered when it receives the MATLAB command
trigger(scl).

Software Trigger
(initialization)

Scope 1
MumSamples=500
TriggerScope=2
Trignersample= -1

Trigger at
Trigoer at Acquisition End
Acquisition End

Scope 2
MumSamples=500
Triggerscope=1
TriggerZample= -1

To acquire gap-free data with two scopes:

1  Build and download the Simulink model Xpcosc to the target computer.

2 Inthe MATLAB Command Window, assign tg to the target computer and set the
StopTime property to 1. For example:

tg = slirt;
tg.StopTime = 1;

3 Add two host scopes to the real-time application. You can assign the two scopes to a
vector, SC, so that you can work with both scopes with one command.
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sc = addscope(tg, “host", [1 2]);
Add the signals of interest (0 and 1) to both scopes.

addsignal (sc,[0 1]D);

Set the NumSamples property for both scopes to 500 and the TriggerSample
property for both scopes to —1. With this property setting, each scope triggers the
next scope at the end of its 500 sample acquisition.

sc.NumSamples = 500
sc.TriggerSample = -1

Set the TriggerMode property for both scopes to "Scope*®. Set the TriggerScope
property such that each scope triggers the other.

sc.TriggerMode = "Scope”;
sc(1) -TriggerScope = 2;
sc(2) -TriggerScope 1;

Set up storage for time, t, and signal, data acquisition.

1;
zeros(0, 2);

Start both scopes and the model.

T
data

start(sc);
start(tg);

Both scopes receive the same signals, 0 and 1.
Trigger Scope 1 to start acquiring data.
scNum = 1;
trigger(sc(scNum));
Setting scNum to 1 indicates that Scope 1 acquires data first.
Start acquiring data using the two scopes to double buffer the data.
while (1)
% Wait until this scope has finished acquiring 500 samples
% or the model stops (scope is interrupted).
whille ~(strcmp(sc(scNum).Status, “Finished®) ||
strcmp(sc(scNum).Status, "Interrupted”)), end

% Stop buffering data when the model stops.
if strecmp(tg.-Status, “stopped”)
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break
end
% Save the data.
t( end + 1 : end + 500) sc(scNum) .Time;
data(end + 1 : end + 500, :) = sc(scNum).Data;
% Restart this scope.

start(sc(scNum));

% Switch to the next scope.
% Shortcut for if(scNum == 1) scNum = 2;else scNum = 1,end
scNum = 3 - scNum;
end

11 When done, remove the scopes.

% Remove the scopes we added.
remscope(tg,[1 2]);

Following is a complete code listing for the preceding double-buffering data acquisition
procedure. After you download the model (Xpcosc) to the target computer, you can

copy and paste this code into a MATLAB file and run it. Communication between the
development and target computers must be fast enough to transmit the entire set of
samples before the next acquisition cycle starts. In a similar way, you can use more than
two scopes to implement a triple- or quadruple-buffering scheme.

% Assumes model xpcosc.mdl has been built and loaded on the target computer.
% Attach to the target computer and set StopTime to 1 sec.
tg = sirt;
tg.StopTime = 1;
% Add two host scopes.
sc = addscope(tg, “host™, [1 2]);
% [0 1] are the signals of interest. Add to both scopes.
addsignal (sc,[0 1]);
% Each scope triggers next scope at end of a 500 sample acquisition.
sc.NumSamples = 500;
sc.TriggerSample®, -1;
sc.TriggerMode = "Scope”;
sc(1).TriggerScope = 2;
sc(2).TriggerScope = 1;
% Initialize time and data log.
t=[1;
data = zeros(0, 2);
% Start the scopes and the model.
start(sc);
start(tg);
% Start things off by triggering scope 1.
scNum = 1;
trigger(sc(scNum));
% Use the two scopes as a double buffer to log the data.
while (1)
% Wait until this scope has finished acquiring 500 samples
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% or the model stops (scope is interrupted).
while ~(strcmp(sc(scNum).Status, “Finished™) ||
strcemp(sc(scNum) .Status, "Interrupted”)), end
% Stop buffering data when the model stops.
if stremp(tg.Status, “stopped™)
break
end
% Save the data.
t( end + 1 : end + 500)
data(end + 1 : end + 500, :)
% Restart this scope.
start(sc(scNum));
% Switch to the next scope.
scNum = 3 - scNum;
end
% Remove the scopes we added.
remscope(tg,[1 2]);
% Plot the data.
plot(t,data); grid on; legend("Signal 0","Signal 17);

sc(scNum) .Time;
sc(scNum) .Data;
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+  “File System Basics” on page 11-2
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File System Basics

11-2

Simulink Real-Time file scopes create files on the target computer. To

work with these files from the development computer, see File System. The
SimulinkReal Time. fileSystem object allows you to perform file system-like
operations on the target computer file system.

You cannot direct the scope to write the data to a file on the Simulink Real-Time
development computer. When the software has written the signal data file to the target
computer, you can access the contents of the file from the development computer.

The software can write data files to:

Hard drive — The target computer hard drive can be a serial ATA (SATA) or parallel
ATA (PATA)/Integrated Device Electronics IDE) drive. The Simulink Real-Time
software supports file systems of type FAT-12, FAT-16, or FAT-32 only.

Check that the hard drive is not cable-selected and that the target computer BIOS can
detect it. The maximum file size is limited by the file system type (FAT-12, FAT-16, or
FAT-32).

A Simulink Real-Time file scope can access the target computer hard drive, provided
it is formatted with a FAT-12, FAT-16, or FAT-32 file system. Simulink Real-Time
ignores other file systems.

ERAM drive — If the target computer has more than 4 GB of RAM, the kernel
automatically formats the excess memory as an extended RAM (ERAM) drive. The
kernel assigns the ERAM drive the drive letter "H: ". Use the ERAM drive when you
need faster file I/O than you can achieve with other drive types.

The limitations for hard drives also apply to the ERAM drive.

USB drive — To write data files to a USB drive, you must set the USB Support
property in Simulink Real-Time.

Secondary IDE drives — The software supports up to four drives through the
second IDE controller. By default, it works with drives configured as the primary
master. If you want to use a secondary IDE controller, you must configure the
Simulink Real-Time software for it (see “Converting Simulink Real-Time File Format
Content to Double Precision Data” on page 11-9). The software searches for

another drive in the first four ports of the target computer.
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Note: In R2017b, the property Secondary IDE will be removed from the product. The
Secondary IDE option has been removed from Simulink Real-Time Explorer. Install
a SATA hard drive in the target computer.

* 3.5-inch disk drive — Writing data files to a 3.5-inch disk drive is considerably
slower than writing to a hard drive.

There are the following limitations:

* You can have at most eight files open on the target computer at the same time.
+ The largest single file that you can create on the target computer is 4 GB.

* A fully qualified folder name can have a maximum of 248 characters, including the
drive letter, colon, and backslash.

+ A fully qualified file name can have a maximum of 260 characters: The file part can
have at most 12 characters: eight for the file name, one for the period, and at most
three for the file extension. A file name longer than eight characters is truncated to
six characters followed by "~1".

* Do not write data to the private folder on your target computer. It is reserved for
Simulink Real-Time internal use.

You can access signal data files, or other target computer system files, in one of the
following ways:

+ If running the target computer standalone, you can access a file by restarting the
target computer under an operating system such as DOS. You can access the file
through the operating system utilities.

+ If running the target computer linked to a development computer, you can
access the target computer file system from the development computer using a
SimulinkRealTime. fileSystem function.

You can perform file transfer operations using the functions
SimulinkRealTime.copyFileToHost and SimulinkRealTime.copyFileToTarget.

You can perform file system-like tasks using functions

such as SimulinkRealTime.fileSystem. fopen and

SimulinkRealTime. fileSystem. fread on the signal data file. File system functions
work like the corresponding MATLAB file I/O functions.

The SimulinkReal Time.fileSystem class also includes file system utilities that allow
you to collect target computer file system information for the disk and disk buffers.
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This topic focuses primarily on using the Simul inkRealTime. fileSystem functions

to work with target computer data files that you generate from a real-time Scope of type
file.

For an example of how to perform data logging with file scopes, see “Data Logging With a
File Scope”.
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Using SimulinkRealTime.fileSystem Objects

In this section...

“Copying Files from the Target Computer to the Development Computer” on page
11-7

“Copying Files from the Development Computer to the Target Computer” on page
11-7

“Accessing File Systems on a Specific Target Computer” on page 11-8
“Reading the Contents of a File on the Target Computer” on page 11-8
“Removing a File from the Target Computer” on page 11-11

“Getting a List of Open Files on the Target Computer” on page 11-11
“Getting Information About a File on the Target Computer” on page 11-12
“Getting Information About a Disk on the Target Computer” on page 11-13

The FileSystem object enables you to work with the target computer file system from

the development computer. You enter target object functions in the MATLAB window

on the development computer or use scripts. The FileSystem object has functions that

allow you to use

+ SimulinkRealTime.FileSystem.cd to change folders

+ SimulinkRealTime.FfileSystem.dir to list the contents of the current folder

+ SimulinkRealTime.FileSystem.mkdir to make a folder

+ SimulinkRealTime.FileSystem.pwd to get the current working folder path

+ SimulinkRealTime.fileSystem.rmdir to remove a folder

+ SimulinkRealTime.fileSystem.diskinfo to get information about the specified
disk

+ SimulinkRealTime.FileSystem.fclose to close a file (similar to MATLAB
fclose)

+ SimulinkRealTime.FileSystem. fileinfo to get information about a particular
file

+ SimulinkRealTime.FileSystem.filetable to get information about files in the
file system

+ SimulinkRealTime.FfileSystem.fopen to open a file (similar to MATLAB fopen)

+ SimulinkRealTime.FfileSystem.fread to read a file (similar to MATLAB fread)
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+ SimulinkRealTime.fileSystem.fwrite to write a file (similar to MATLAB
fwrite)

+ SimulinkRealTime.FileSystem.getfilesize to get the size of a file in bytes

+ SimulinkRealTime.fileSystem.removefile to remove a file from the target
computer

Useful global functions:

+ SimulinkRealTime.copyFileToHost to retrieve a file from the target computer to
the development computer

+ SimulinkRealTime.copyFileToTarget to place a file from the development
computer on the target computer

+ SimulinkRealTime.utils.getFileScopeData, to interpret the raw data from the
fread function

These procedures assume that the target computer has a signal data file created by a
Simulink Real-Time file scope. This file has the path name C:\data.dat.

There are the following limitations:

* You can have at most eight files open on the target computer at the same time.
+ The largest single file that you can create on the target computer is 4 GB.

* A fully qualified folder name can have a maximum of 248 characters, including the
drive letter, colon, and backslash.

* A fully qualified file name can have a maximum of 260 characters: The file part can
have at most 12 characters: eight for the file name, one for the period, and at most
three for the file extension. A file name longer than eight characters is truncated to
six characters followed by "~1".

* Do not write data to the private folder on your target computer. It is reserved for
Simulink Real-Time internal use.

In this section...

“Copying Files from the Target Computer to the Development Computer” on page
11-7

“Copying Files from the Development Computer to the Target Computer” on page
11-7

“Accessing File Systems on a Specific Target Computer” on page 11-8

“Reading the Contents of a File on the Target Computer” on page 11-8
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In this section...

“Removing a File from the Target Computer” on page 11-11
“Getting a List of Open Files on the Target Computer” on page 11-11
“Getting Information About a File on the Target Computer” on page 11-12

“Getting Information About a Disk on the Target Computer” on page 11-13

Copying Files from the Target Computer to the Development Computer

You can copy a data file from the target computer to the development computer using a
Simul inkReal Time package function on the development computer.

For example, to retrieve a file named data.dat from the target computer C:\ drive
(default):

1 If you have not already done so, in the MATLAB window, type the following to assign
the default SimulinkReal Time. target object to a variable.

tg = slrt;
2 Type

SimulinkRealTime.copyFileToHost(tg, "data.dat™)

This command retrieves the file and saves that file to the variable data. This
content 1s in the Simulink Real-Time file format.

Copying Files from the Development Computer to the Target Computer

You can copy a file from the development computer to the target computer using a
SimulinkRealTime package function on the development computer.

For example, to copy a file named data2.dat from the development computer to the
target computer C:\ drive (default),

1 If you have not already done so, in the MATLAB window, type the following to assign
the default SimulinkRealTime. target object to a variable.

tg = slirt;
2 Type the following to save that file to the variable data.

SimulinkRealTime.copyFileToTarget(tg, "data2.dat")
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Accessing File Systems on a Specific Target Computer

You can access specific target computer files from the development computer for the
SimulinkRealTime.fileSystem object.

Use the Simul inkRealTime. fileSystem creator function. If your system has multiple
targets, you can access specific target computer files from the development computer for
the SimulinkReal Time.fileSystem object.

For example, to list the name of the current folder of target computer "TargetPC1":

1 In the MATLAB window, type a command like the following to assign the
SimulinkRealTime.fileSystem object for the default computer to a variable.

fsys = SimulinkRealTime.fileSystem;
2 Type

dir(fsys)

Alternatively, you can use the Simul inkRealTime.target constructor to construct
a target object for a specific computer, then use that target object as an argument to
SimulinkRealTime.fileSystem.

1 In the MATLAB window, type a command like the following to assign the
SimulinkReal Time.target object for target computer "TargetPCl" to a variable.

tgl = SimulinkRealTime.target("TargetPC1");
2 To assign the SimulinkReal Time. fileSystem object to a variable, type:

fsys = SimulinkRealTime.fileSystem(tgl);
3 Type

dir(fsys)

Reading the Contents of a File on the Target Computer

You can read the contents of a data file from the target computer by using
SimulinkReal Time. fileSystem functions on the development computer. Use this
procedure as an alternative to the method described in “Configure File Scopes with
MATLAB Language” on page 5-113.
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To run a SimulinkReal Time. FileSystem object function, use the
function_name(fs_object, argument_list) syntax. For example, to retrieve the
contents of a file named data.dat from the target computer C:\ drive (default):

1 If you have not already done so, in the MATLAB window, type the following to assign
the Simul inkReal Time . FileSystem object to a variable.

fsys = SimulinkRealTime.fileSystem;
2 Type

h = fopen(fsys, "data.dat”);

This command opens the file data.dat for reading and assigns the file identifier to
h.

3 Type
data2 = fread(fsys,h);

This command reads the file data.dat and stores the contents of the file to data?2.
This content is in the Simulink Real-Time file format.

4 Type

fclose(fsys, h)
This command closes the file data.dat.

Before you can view or plot the contents of this file, you must convert the contents. See
“Converting Simulink Real-Time File Format Content to Double Precision Data” on page
11-9.

Converting Simulink Real-Time File Format Content to Double Precision Data

The Simulink Real-Time software provides the function
SimulinkRealTime.utils.getFileScopeData to convert Simulink Real-Time
file format content (in bytes) to double precision data representing the signals and
timestamps. The SimulinkReal Time.utils.getFileScopeData function takes
in data from a file in Simulink Real-Time format. The data must be a vector of bytes
(uint8). To convert the data to uint8, use a command like the following:

data2 = uint8(data2%);
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This section assumes that you have a variable, data2, that contains data in the Simulink
Real-Time file format (see “Reading the Contents of a File on the Target Computer” on
page 11-8).

1

In the MATLAB window, change folder to the folder that contains the Simulink Real-
Time format file.

Type
new_data2 = SimulinkRealTime.utils.getFileScopeData(data?);

SimulinkRealTime.utils.getFileScopeData converts the format of data2
from the Simulink Real-Time file format to an array of bytes. It also creates a
structure for that file in new_data?2, of which one of the elements is an array of
doubles, data. The data member is also appended with a timestamp vector. The
data is returned as doubles, which represent the real-world values of the original
Simulink signals at the specified times during target execution.

You can view or examine the signal data. You can also plot the data with
plot(new_data2.data).

If you use Simulink Real-Time in StandAlone mode, you can extract the data from the
data file:

First determine the file header size. To obtain the file header size, ignore the first 8
bytes of the file. The next 4 bytes store the header size as an unsigned integer.

After the header size number of bytes, the file stores the signals sequentially as
doubles. For example, assume that the scope has three signals, X, y, and z. Assume
that xX[0] is the value of x at sample 0, X[1] is the value at sample 1, and so forth.
Also assume t[0], t[1] are the simulation time values at samples 0, 1, and so forth.
The file saves the data using the following pattern:

x[0] y[0] z[O0] t[0] x[1] y[1] z[1] t[1] x[2] y[2] z[2] t[2].-.-.
x[NT yIN1 z[N] t[N]

N is the number of samples acquired. The file saves X, y, z, and t as doubles at 8 bytes
each.
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Removing a File from the Target Computer

You can remove a file from the target computer by using Simulink Real-Time functions
on the development computer for the Simul inkRealTime . fileSystem object. If you
have not already done so, close this file first with fclose.

To run a Simul inkRealTime.fileSystem object function, use the
function_name(fs_object, argument_list) syntax. For example, to remove a file
named data2.dat from the target computer C:\ drive (default),

1 If you have not already done so, in the MATLAB window, type the following to assign
the SimulinkReal Time.fileSystem object to a variable.

fsys = SimulinkRealTime.fileSystem;

2 Type the following to remove the specified file from the target computer.

removefile(fsys, “data2.dat")

Getting a List of Open Files on the Target Computer

You can get a list of open files on the target computer file system by using
SimulinkRealTime.fileSystem object functions on the development computer. The
target computer file system limits the number of open files you can have to eight. Use
this list to identify files that you can close.

To run a SimulinkReal Time. FileSystem object function, use the
function_name(fs_object, argument_list) syntax. For example, to get a list of
open files for the file system object Fsys,

1 If you have not already done so, in the MATLAB window, type the following to assign
the Simul inkReal Time . FileSystem object to a variable.

fsys = SimulinkRealTime.fileSystem;
2 Type

filetable(fsys)
If the file system has open files, a list like the following is displayed:

ans =
Index Handle Flags FilePos Name
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0 00060000 R__ 8512 C:\DATA.DAT
1 00080001 R__ 0 C:\DATAL1.DAT
2 000A0002 R__ 8512 C:\DATA2.DAT
3 000C0003 R__ 8512 C:\DATA3.DAT
4 O001EO0001 R 0 C:\DATA4.DA

3 The table returns the open file handles in hexadecimal. To convert a handle to one
that other Simul inkReal Time. fileSystem functions, such as Fclose, can use,
use the hex2dec function. For example,

hl = hex2dec("001E0001")

hl =
1966081

4 To close that file, use the SimulinkRealTime.fileSystem fclose function. For
example,

fclose(fsys, hl)

Getting Information About a File on the Target Computer

You can display information for a file on the target computer file system by using
SimulinkReal Time. fileSystem object functions on the development computer.

To run a SimulinkRealTime.fileSystem object function, use the
function_name(fs_object, argument_list) syntax. For example, to display the
information for the file identifier fid1,

1 If you have not already done so, in the MATLAB window, type the following to assign
the SimulinkReal Time. fileSystem object to a variable.

fsys = SimulinkRealTime.fileSystem;
2 Type

fidl = fopen(fsys, “data.dat");

This command opens the file data.dat for reading and assigns the file identifier to
fidl.

3 Type
Ffileinfo(fsys, fidl)

This returns disk information like the following for the C:\ drive file system.
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ans =
FilePos: O
AllocatedSize: 12288
ClusterChains: 1
VolumeSerialNumber: 1.0450e+009
Ful IName: "C:\DATA.DAT*®

Getting Information About a Disk on the Target Computer

You can display information for a disk on the target computer file system by using
SimulinkReal Time. fileSystem object functions on the development computer.

To run a SimulinkReal Time.fileSystem object function, use the
function_name(fs_object, argument_list) syntax. For example, to display the
disk information for the C:\ drive,

1 If you have not already done so, in the MATLAB window, type the following to assign
the SimulinkReal Time.fileSystem object to a variable.

fsys = SimulinkRealTime.fileSystem;
2 Type

diskinfo(fsys, "C:\");
This returns disk information like the following for the C:\ drive file system.
ans =

struct with fields:

DrivelLetter: "C*
Label: "FREEDOS*
Reserved: * -
SerialNumber: -857442364
FirstPhysicalSector: 63
FATType: 32
FATCount: 2
MaxDirEntries: O
BytesPerSector: 512
SectorsPerCluster: 64
TotalClusters: 1831212
BadClusters: O
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FreeClusters: 1827614
Files: 938
FileChains: 942
FreeChains: 1
LargestFreeChain: 1827614
DriveType: DRIVE_FIXED
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MATLAB Runtime Setup

As part of developing and testing your model, you can write MATLAB applications for:

+  Parameter extreme value testing
*  Regression testing
+ Putting the model into a consistent state for testing another part of the system

To run an application on a Windows computer that does not have MATLAB installed, use
MATLAB Compiler to deploy the application as a standalone executable.

To deploy a MATLAB application, first set up MATLAB Runtime:

1 Open MATLAB.
2 To find the MCRInstal ler program, type:

mcrinstaller

The Command Window displays output similar to this output:

The WIN64 MATLAB Runtime Installer, version 9.0.1, is:
C:\Program Files\MATLAB\R2016a\toolbox\compiler\deploy...
\win64\MCRInstaller.exe

Note the version number of the installer program, here 9.0.1.

3 Copy and paste the full path to the MCRInstal ler program into the Windows Run
text box.

4 Press Enter, and then follow the prompts.

Place the MATLAB Runtime in the default location, for example:

C:\Program Files\MATLAB\MATLAB Runtime

For version 9.0.1, the installer places the MATLAB Runtime binary files in this
location:

C:\Program Files\MATLAB\MATLAB Runtime\v901\bin\win64
5 Close MATLAB and open a Windows command prompt window.
6 Type the following command:

set PATH=C:\Program Files\MATLAB\MATLAB Runtime\v90l1\bin\win64;%PATH%
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This command sets the MATLAB Runtime path only for the command prompt
window within which you typed it. To make this environment variable setting visible
throughout the operating system, see the Windows documentation.

More About
. “Deploy MATLAB Application to Control Real-Time Application” on page 12-4
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Deploy MATLAB Application to Control Real-Time Application

12-4

Required Products: Simulink, Simulink Real-Time, MATLAB Compiler, and MATLAB
Compiler SDK™

This example shows how to deploy a test script as a standalone executable by using
MATLAB Compiler. The test script performs a frequency-response test of the xpcosc
model. Using this information, in the design phase, you can modify the internal
parameters of the model to meet your frequency requirements. In the production phase,
you can bin manufactured parts based on frequency response.

The test script is slrt_freq_sweep_test.m (matlab:open(fullfile(matlabroot,
'help','toolbox','xpc','examples’,'slrt_freq_sweep_test.m"))).

In this section...

“Prerequisites” on page 12-4
“Package the MATLAB Application” on page 12-4
“Run the MATLAB Application” on page 12-6

Prerequisites

This procedure assumes that you have:

1 Completed the steps in “MATLAB Runtime Setup” on page 12-2.

2 Opened MATLAB from the Windows command prompt window within which you
performed MATLAB run-time setup.

3 Configured TCP/IP communication between the development and target computers,
recorded the required settings in the test script slrt_freq_sweep_test.m, and
saved the script in a working folder.

4  Built the xpcosc real-time application.

Package the MATLAB Application

1 Open Apps > Application Compiler.

2 Enter the name of the application as slrt_freq_sweep_test. Add summary
information as required.



Deploy MATLAB Application to Control Real-Time Application

3 To save the project, click Save. Save the project under a name such as
sirt_freq_sweep_ test.prj.

4 (lick the Add main file button %‘, and then navigate to the file
sirt_freqg_sweep_test.m.

5 Under PACKAGING OPTIONS, select the Runtime included in package check
box.

T B e s e s [E=N|ESR| =)

COMPILER

w0

!= Standalone Application

™ Runtime downloaded from web | MyApplnstaller_web |5 WMB @

O Runtime included in package | MyapplInstaller mer (9089 MB  Seftings  Package

fa slrt_freq_sweep_test.m —

Application information

‘ slrt_freq_sweep_test 1.0

Author Name
S Select custom sp M
Company

Set as default contact

Fraq uency sweep test

Description

P Additional installer options
Files required for your application to run

Files installed for your end user
@ readme.bd @ slrt_freq_sweep_t... @ splash.png

P Additional runtime settings

6 (Click the Package button 8.
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The compiler generates the application and opens the slrt_freq_sweep_ test
folder in Windows Explorer.

7 To save the project, click Save.

Run the MATLAB Application

1

In Windows Explorer, navigate to slrt_freq_sweep_test
\for_redistribution_Ffiles_only.

Copy the real-time application file (xpcosc.mldatx) into slrt_freq_sweep_test
\for_redistribution_Ffiles_only.

The application assumes that the model file is in the folder where you run the
application.

If you are connected to the target computer within MATLAB, close the connection.
Use the close(tg) command.

To run the application, click slrt_freq_sweep_test.exe.

The application runs and displays a plot for each frequency.
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% Fguret SIEI=]

File

Sde | ARO9E 0

10 ' ' ' ; ' ' '

N

—E 1 1 1 1 1 1 1
0 0.005 0.01 0015 0.02 0.025 0.03 0.035 0.04

After the run is complete, the application displays a text box containing the test
results.
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4] Rigure [ ] - )

File

=T LIECEE

Results
15 Hz Passed
16 Hz Passed
17 Hz Passed
18 Hz Passed
19 Hz Passed
20 Hz Passed
21 Hz Passed
22 Hz Passed
23 Hz Failed
24 Hz Failed
25 Hz Failed

More About
“Write Deployable MATLAB Code” (MATLAB Compiler)
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Test Real-Time Application

This example shows how to perform a frequency-response test of the model
ex_slrt_slt_osc (matlab:open_system(docpath(fullfile(docroot, 'toolbox', 'xpc',
'‘examples', 'ex_slrt_slt_osc'")))).
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SIMULINK REAL-TIME

SIMULINK TEST

Configuration Parameters

STEP 1
Set Model Configuration Parameters

STEP 3
Sat Test Hamess Configuration Parameters

Model Advisor

STEP &
Configure Simulink Parameters

STEP 2
Create Test Harness

Test Assessmeant Block

STEP 4
Configure Test Harness

STEP 6
Prepara Test Assessment Steps

Test Manager
STEPT
Initialize Test Suite

STEP &
Initialize System Under Test

STEPS
Initialize Parameter Overrides

STEP 10
Create Scripted Iterations

STEP 11
Run Test and Display R¥3ults
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Using this information, in the design phase, you can modify the internal parameters of

the model to meet your frequency requirements. In the production phase, you can bin

manufactured parts based on frequency response.

Gain
ffﬂs.
Gain
oooo 1
Gainz - Sum Integrator
: ; Integrator Integrator
S|gr|a| Gain2 Sum g g
Generator Dam
. pedlsc
Gain1
@

—(

Cutport

—

Gain‘ 4:I
SignalGenerator

Model xpcosc
SimulinkReal-Time example model

Copyright 1999-2013 The MathWorks, Inc.

The figure shows representative output from a real-time application running on a target

Scope

k

Target Scope
Id: 1

Scope

computer. At low frequencies, the output of the Integratorl block settles to the same

value as the output of the Signal Generator block. At high frequencies, the output of the

Integratorl block is still ringing at the end of each pulse.
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SignalGenerator: Signal Generator 8.0800008

Simulink Real-Time™
R2017a

4] Simulink Real-Time Target Screen = ===

6. 88825 2.94e-8687

6.22 x1873

7.942122

The test determines the highest frequency at which the output values of the Integrator

and Signal Generator blocks are within a specified criterion of each other. The test uses
the model itself as a signal source and uses a test harness to compare the outputs of the
Integrator and Signal Generator blocks.

Test Harness Constants

StartFreq = 15.0 % Start frequency of parameter sweep.
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EndFreq =25.0 % End frequency of parameter sweep.

Freqlncr = 1.0 % Frequency increment.

WOpen = 0.90 % Start of time window for evaluating |criterion].
WClose = 0.99 % End of time window for evaluating |criterion].
Criterion = 0.025 % Maximum normalized amplitude difference

% between Signhal Generator and Integratorl
% within the time window.

Test Harness Variables

freq % Frequency at each iteration.
w_open % Window opens once in each half-period.
w_close % Window closes once in each half-period.

Step 1. Set Model Configuration Parameters

Open ex_slrt_slt_osc in a writable folder.
Open the Configuration Parameters dialog box.

Open the Model Referencing node, and then set Total number of instances allowed
per top model to One.

Open the Data Import/Export node and make the following settings:

Set Format to Structure with time.
Set the Time and Output check boxes.

Clear the States, Final states, Signal logging, Data stores, and Log Dataset data to
file check boxes.

Step 2. Create Test Harness

1

N O 0 WO

In Analysis, select Test Harness > Create for Model. The software creates a test
harness with the default name ex_slrt_slt_osc_Harnessl.

In the Basic Properties pane, select the Save Test Harnesses Externally check box.
For the Input to Component under Test, select None.

For the Output from Component under Test, select Outport.

Select the Add separate assessment block check box.

Select the Open harness after creation check box.

Take the defaults in the remaining panes.



Test Real-Time Application

s

Create Test Harness @

Specify the properties of the test harmess. The component under test is the system for which the harness is
being created. After creation, use the block badge to find and open harnesses.

Component under test: ex_slrt_slt_osc

Basic Properties | Advanced Properties | Description |

-

Mame: ex_slrt_slt_osc_Harness1

Save test harnesses externally More information
Harness path: docl7a.j506749\matlab\doc\src\toolbox\xpciugiautomation

Sources and Sinks

[None v] —— | Component under Test |—— > [Dutport v]

Add separate assessment block

Open harness after creation

‘)' [ OK ][ Cancel ][ Help

9. Click OK.

The test harness looks like this figure.
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4 ex_siit_sit_osc N

Outport =

Outport

1
L »|Outport -2
3

Test Assessment
The example model ex_slrt_slt_osc stores the test harness within the model. To
access the test harness:

1 In Simulink Editor, click Analysis > Test Harness > List Test Harnesses.
2 Click ex_slrt_slt_osc_Harnessl.

3 To return to the example model, select it in the perspectives view in the lower right
corner of the test harness.

Step 3. Set Test Harness Configuration Parameters

1 Openex_slrt_slt_osc_Harnessl.
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N o 0 &~

Open the Configuration Parameters dialog box.

Open the Model Referencing node, and then set Total number of instances
allowed per top model to One.

Open the Data Import/Export node.
Set Format to Structure with time.
Set the Time and Output check boxes.

Clear the States, Final states, Signal logging, Data stores, and Log Dataset
data to file check boxes.

Step 4. Configure Test Harness

Open the Test Assessment block.

To simplify the test assessment configuration, in the Input symbol list, replace input
Outport with inputs Intl and SigGen.

In ex_slrt_slt _osc Harnessl, connect a Demux block to ex_slrt_slt_osc/
Outport.

In the Demux block dialog box, set Number of outputs to 2.

To make the Demux outputs visible to the Test Assessment block, connect unitary
Gain blocks to each of the Demux block outputs.

Connect the top Demux block output to Test Assessment/Intl and the bottom
output to Test Assessment/SigGen.
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4 ex st st osc N

Qutport .

Qutport

AN Z
» Int1 1
Int1 2
b SigGen 3
SigGen
= Test Assessment

Step 5. Configure Simulink Parameters

1  On the toolbar, click the Model Explorer button.

2 Click node ex_slrt_slt_osc_Harnessl > Model Workspace.
3 In the toolbar, click the Add Simulink Parameter button.
4  Add the following data object:

Name — Criterion
Value — 0
DataType — double

5. In a similar manner, add data objects w_open and w_close.
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Model Explorer
File Edit View Tools Add Help

= M- E- =
Search: by Name + Name: G4 Search
Mode! Hierarchy = =2 Contents of: Model Warkspace™ (anly) Filter Contents
4 P simulink Root ) —
E Base Workspace Column View: |Data Objects ~ | Show Details Jobjects) T
g ex_sirt_slt_osc Name  Value DataType Min Max Dimensions StorageClass Complexity
- +
%—sn';tjllt::sc-"'ame:“ [ criterion 0 double  [1 [1 [t1] Auto
odel Workspace
@ Confiouationt (actve) [l weese 0 double [1 [1 [ Auto
ol
E Code for ex_slrt_slt_osc_Harnes [°'°] w_open 0 double o a nq Auto
Simulink Design Verifier results
(;_/) Advice for ex_slrt_slt_osc_Harng
QOutput Conversion Subsystem
o Test Assessment
o ex_slrt_slt_osc (ex_slrt_slt_osc)
4| i
4 T | 3 Contents Search Results |

Step 6. Prepare Test Assessment Steps
1. Open the Test Assessment block

2. Add these parameters to the Parameter symbol list:

+  Criterion
*  w_open
+ w_close

Model Workspace
Workspace data

Data source: |Model File i

Model arguments (for referending this model):

4 1 | »

3. To add a step, in the Step column, move the cursor to the top row, click Add step

after, and type:
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CheckSetting
4. Right-click step CheckSetting and set the When decomposition check box.
5. To add a substep to CheckSetting, click Add sub-step, and type:
Hi when (SigGen > 0)
The when expression selects one half of the waveform.
6. Right-click substep Hi and set the When decomposition check box.

7. To substep Hi, add substep:

HiCheck when ((et >= w_open) && (et <= w_close))
verify((abs(Intl) >= abs(SigGen) * (1.0 - Criterion)) && ...
(abs(Intl) <= abs(SigGen) * (1.0 + Criterion)));

The when expression selects the time window for testing the acceptance criterion. The
verify command tests the acceptance criterion.

8. In a similar manner, to step CheckSetting, add substeps:

Lo when (SigGen < 0)
LoCheck when ((et >= w_open) && (et <= w_close))
verify((abs(Intl) >= abs(SigGen) * (1.0 - Criterion)) && ...
(abs(Intl) <= abs(SigGen) * (1.0 + Criterion)));

9. Insert Defaul tStep substeps at the end of each level of nesting to satisfy the

requirements of when decomposition. When decomposition requires at least two steps at
each level of nesting, and one nondecomposed step at the end of each list of steps.
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ex_slrt_slt_osc_Harnessl/Test Assessment - Test Sequence Editor EI@I
B o ¢t B @8 40P O & & @
Symbols Step Transition Next Step  Description =
AT BC CheckSettling
1. 5 Int1
2. | SigGen -
B Hiwhen (SigGen = 0) Selects half
Qutput of waveform
Local
HiCheck when ((et >= w_open) && (et <= w_close)) Selects time window.
Constant verify((abs{Int1) >= abs(SigGen) * (1.0 - Criterion)} && .. Tests acceptance
(abs(Int1) <= abs(SigGen) * (1.0 + Criterion))), criterion
Parameter
Criterion DefauliStep_1 Required for ‘when c
w_close decomposition'
w_open

Data Store Memory

B Lo when (SigGen < 0)

LoCheck when ((et == w_open) && (et == w_close))
verify((abs(Int1) >= abs(SigGen) * (1 0 - Criterion)) &&
(abs(Int1) == abs(SigGen) * (1.0 + Criterion)));

DefaultStep 2

DefaultStep

Step 7. Initialize Test Suite

(8] B W NN —

O ©© N o

Open ex_slrt_slt_osc.
Open Analysis > Test Manager.
Select New > Test File.

Right-click the default test file node, and then name the file node with a name such
as ex_slrt_slt_osc_slx_tests.

Right-click the default test suite node, and then name the suite node with a name
such as ex_slrt_slt_osc_stress_tests.

Right-click the default test case node, and then delete it.
Select New > Real-Time Test.
Accept the default test type, Simulation, and then click OK.

Right-click the test case node, and then name the case node with a name such as
FrequencySweep.
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Step 8. Initialize System Under Test

o O b W N —

In Test Manager, select node FrequencySweep.

Select tab System Under Test.

In the Load Application From box, select Model.

In the Model text box, enter ex_slrt_slt_osc.

In the Target text box, enter TargetPCL1.

In the Harness box, select ex_slrt_slt_osc_Harnessl.
Select the Stop Time check box.

Step 9. Initialize Parameter Overrides

In Test Manager, select tab Parameter Overrides.

Click the Add button. A dialog box opens containing a list of parameters. If
parameters are not visible, click the Refresh button. The refresh builds and
downloads the model and uploads the parameters from the model.

Open Parameter Set 1 and select the Frequency, w_close, w_open, and
Criterion check boxes.



Test Real-Time Application

4\ Test Manager

(=] me]

'ﬂﬂﬁﬁ;;:; B U e F

New Open Save Delte  Run  Stop  Paralel | Report Visualze  H Help
- - - [@Paste =4 - - in -
FILE I o | RUN | RESULTS |ResouRcEs |
RS Results and Artifacs |=| Frequency Sweep M Start Page
» 5 ex_sirt_sit_osc_slx_tests FrequenCySWeep
It sit osc s

@

+ [T ex_sirt_sit_osc_stress_tests &

[£) FrequencySweep

Load Application From | Model

Model: | ex_sirt_sit_osc

Target Computer: | TargetPC1

v +|Parameter Set 1

| w_close

e | w_open
Name |E] FrequencySweep | Criterion
Type Real-Time Test (Simulation T <] Frequancy
Model ex_sirt_sit_osc
Harness Name ex_sir_slt_osc_Hamess1
Simulation Mode [Model Settings]
Lacation Hworkdiriex_slrt_slt_osc_s!.
Enabled v
Hierarchy ex_sirt_slt_osc_six_tesis » e.

Prior Session Results Available
Would you like to importthem? Import Delete

Step 10. Create Scripted lterations

1 In Test Manager, select tab Iterations > Scripted Iterations.

20

real ime application
real ime application
real ime application
real time application

« Enabled

ERaAC

2 In the text box, enter the following code. To resize the Scripted Iterations text box,
click and drag the lower-right corner of the box.

% Initialize constants and variables

StartFreq = 15.0;
StopFreq = 25.0;
Freqlncr = 1.0;
WOpen = 0.90;
WClose = 0.99;
Criterion = 0.025;

% Loop through test frequencies
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for freq = StartFreq:Freqlncr:StopFreq

% Create a new iteration
testltr = sltest._testmanager.Testlteration();

% Calculate the time window
half_period = 0.5 * (1.0/freq);
w_open = half_period * WOpen;
w_close = half_period * WClose;

% Set the parameters for the iteration

testltr.setVariable("Name", "Frequency”, "Source®, ...
"ex_slrt_slt_osc/Signal Generator®, "Value~®,freq);

testltr.setVariable("Name®", "w_open®, "Source”, ...
"Test Assessment®,"Value®, w_open);

testltr.setVariable("Name®", "w_close”, "Source”™, ...
"Test Assessment”,"Value®, w_close);

testltr.setVariable("Name®, "Criterion®, "Source”, ...
"Test Assessment®,"Value®, Criterion);

% Name and add the iteration to the testcase

str = sprintf("%.0F Hz", freq);

addlteration(sltest_testCase, testltr, str);
end
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4\ Test Manager
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+ ITERATIONS
» TABLE ITERAT
~ SCRIPTED ITERATIONS
»  Help on creating test iterations
1% Initialize constants and variables
2 StartFreq = 15.0;
3 StopFreq = 25.0;
4 FregIncr 1.9;
5 Wopen = 0.90;
& WClose = 0.99;
7 Criterion = 0.025;
8
9% Loop through test freguencies
10 for freq = StartFreq:FregIncr:StopFreq
1
12 % Create a new iteration
13| testItr = sltest.testmanager.TestIteration();
14
15 % Calculate the time window
16 half_period = 0.5 * (1.0/freq);
17 w_open = half_period * Wopen;
18 w_close = nalf_period * WClose;
19
20 % Set the parameters for the iteration
E 21 testItr.setVariable('Name', 'Frequency','Source', ‘ex_slrt_slt_osc/Signal Generator','Value', freg);
Name [E] FrequencySweep 22 testItr.setVariable( Name', open','source', 'Test Assessment','Value', w_open);
Type Real-Time Test (Simulation T 23 testItr.setVariable('Name', 'w_close','Source', 'Test Assessment’,'Value', w_close);
Y 24 testItr.setVariable('Name', 'Criterion’','Source', 'Test Assessment', 'Value', Criterion);
Wodel ex_slrt_slt_osc 25
Hamess Name ex_sit_sit_osc_Hamess1 26 % Name and add the iteration to the testcase
Simulation Mode [Model Settings 27 str = sprintf('s.0f Hz', freq);
Location Hiworkdiriex_slrt_sit_osc_s! 28 addIteration(sliest_testCase, testItr, str);
Enabled % &3 end
Hierarchy ex_slrt_slt_osc_six_tests » e

Iteration Templates
‘Show Iterations.

Prior Session Results Available
Would you like to importthem? Import Delete

Step 11. Run Test and Display Results

In Test Manager, on the toolbar, click the Run button.

2 To view test results, in the left column, click Results and Artifacts. In this case,
the test failed at iteration 23 Hz.

3 To view the failing results, open nodes 23 Hz > Verify Statements and 23 Hz >
Sim Output (ex_slrt_slt_osc).
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] 3 Automated Test with Simulink Test

4 In the Simulation Data Inspector pane, select the two Test Assessment check boxes
and the two Out check boxes.

5 Click the Zoom in Time button and click near the first failure.

The first half-waveform succeeded, as shown by the rectangle on the left with its top near
0. The rest of the test failed, as shown by the rectangles with a spike at the top.
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4\ Test Manager
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Prior Session Results Available
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See Also
Test Assessment | Test Sequence

More About
. “Test Models in Real Time” (Simulink Test)

. matlab: open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples’,
'ex_slrt_slt_osc')))
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. “Real-Time Testing” (Simulink Test)
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Troubleshooting Basics

For questions or issues about your installation of the Simulink Real-Time product,
refer to these guidelines and tips. For more specific troubleshooting solutions, go to the

MathWorks® Support website:

www .mathworks.com/support/search_results._html?g=product:"Simulink
+Real-Time"


https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"

14 Troubleshooting Basics

Troubleshooting Process

14-2

A Simulink Real-Time installation can sometimes fail. Causes include development and
target computer failures, changes in underlying system software, I/O module failures,
and procedural errors. To address these issues, follow this process:

1

Run the confidence test (see “Run Confidence Test on Configuration”).
Run the confidence test as the first step in troubleshooting, and in validating your
initial product installation and configuration.

If one or more tests fail, see the following information about the specific failure:

+ “Test 1: Ping Target Computer with System Ping” on page 15-2
+ “Test 2: Ping Target Computer with slrtpingtarget” on page 15-4
+ “Test 3: Software Restart Target Computer” on page 15-5
* “Test 4: Build and Download slrttestmdl” on page 15-7
+ “Test 5: Check Communication with Target Computer” on page 15-9
+ “Test 6: Download Prebuilt Real-Time Application” on page 15-10
+ “Test 7: Execute Real-Time Application” on page 15-11
+ “Test 8: Upload Logged Data and Compare Results” on page 15-12
Investigate the categorized troubleshooting sections for clues to the root cause of the
issue.
To get information about the PCI boards in the target computer, call
SimulinkRealTime.target.getPClInfo.

+ To read the target computer console log, call
SimulinkRealTime.utils.getConsolelLog.

If the tests run, but task execution time is slow or the CPU becomes overloaded, see
the troubleshooting section “Real-Time Application Performance”.

For more information, refer to the following sources:
* MathWorks Tech Support: www.mathworks.com/support/
search_results_html?g=product:"Simul ink+Real-Time"

+ MATLAB Answers: ww.mathworks.com/matlabcentral/answers/?
term=Simul ink+Real-Time

+ MATLAB Central: www.mathworks.com/matlabcentral


https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/matlabcentral/answers/?term=Simulink+Real-Time
https://www.mathworks.com/matlabcentral/answers/?term=Simulink+Real-Time
https://www.mathworks.com/matlabcentral

Troubleshooting Process

For Speedgoat hardware issues, contact Speedgoat Tech Support:
www . speedgoat.com/support.

If these sources do not solve your issue, contact MathWorks Technical Support. See
“Find Simulink Real-Time Support” on page 25-2.
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Confidence Test Failures

For questions or issues that you have while using the Simulink Real-Time product, see
these guidelines and tips. For specific troubleshooting solutions, refer to the MathWorks
Support website:

www . mathworks .com/support/search_results._html?g=product:"Simulink
+Real-Time".

+ “Test 1: Ping Target Computer with System Ping” on page 15-2

* “Test 2: Ping Target Computer with slrtpingtarget” on page 15-4

* “Test 3: Software Restart Target Computer” on page 15-5

+ “Test 4: Build and Download slrttestmdl” on page 15-7

* “Test 5: Check Communication with Target Computer” on page 15-9

+ “Test 6: Download Prebuilt Real-Time Application” on page 15-10

* “Test 7: Execute Real-Time Application” on page 15-11

* “Test 8: Upload Logged Data and Compare Results” on page 15-12


https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
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Test 1: Ping Target Computer with System Ping

If you are using a network connection, this test is a standard system ping to your target
computer.

1 At a Windows command prompt, type the IP address of the target computer:

PENG XXX . XXX . XXX . XXX
Review the messages.

If the window displays a message similar to this message, system ping succeeds
even though test 1 fails.

PInging XXX.XXX.XXX.XxXX with 32 bytes of data:
Reply from XXX.XXX.XXX.XxXX: bytes-32 time<l0 ms TTL=59

If the window displays this message, the system ping command failed.

Pinging XXx.XxXX.xXxX.xxX with 32 byte of data:
Request timed out.

2 Ping succeeds — Ethernet addresses OK?
If ping succeeds, determine whether you entered the required IP and gateway
addresses in Simulink Real-Time Explorer:

a Inthe MATLAB Command Window, type slrtexplr.

b Inthe Targets pane, expand the target computer node.

€ On the toolbar, click the Target Properties button .
d Select Host-to-Target communication.

e Check that the IP address, Subnet mask, and Gateway text boxes contain
the required values.

f  Select Boot configuration.

g Click Create boot disk.

h Restart the target computer with the new kernel.
3 Ping fails — Cables OK?

15-2



Test 1: Ping Target Computer with System Ping

If ping fails, look for a faulty network cable or, if you are using a coaxial cable, a
missing terminator.

Ping fails — Simulink Real-Time properties OK?
Check that you entered the required properties in Simulink Real-Time Explorer:

In the MATLAB Command Window, type slrtexplr.

a
b Inthe Targets pane, expand the target computer node.

(o]

On the toolbar, click the Target Properties button .

o

Select Host-to-Target communication.

Check that the IP address, Subnet mask, and Gateway text boxes contain
the required values.

f  Check that Bus type is set to PCI or USB, depending on the Ethernet adapter
that you are using.

g Select Boot configuration.
h Click Create boot disk.
i  Restart the target computer with the new kernel.

Ping fails — Ethernet interface operating?

Check that your Ethernet protocol interface is operating. For example, when the
cable is connected to the Ethernet card, make sure that the green “ready” light goes
on.

Ping fails — Interference from firewall or antivirus software?
Check that the development computer is not running a firewall or antivirus software

sensitive to the Ethernet port that you are using. For more information, consult your
IT department.

Ping fails — Not a locally mounted folder?

Run slrttest from a locally mounted folder, such as Z:\work, rather than from a
UNC network folder, such as \\Server\user\work.

If this procedure does not solve your issue, see the troubleshooting section
“Communication Between Development and Target Computers”. If you still cannot solve
your issue, see “Find Simulink Real-Time Support” on page 25-2.

15-3



] 5 Confidence Test Failures

Test 2: Ping Target Computer with slrtpingtarget

15-4

This test is a Simulink Real-Time ping to your target computer.

1

In the MATLAB Command Window, type:

tg = SimulinkRealTime.target("argument-list")

argument-list is the connection information that indicates which target computer
you are working with. If you do not specify arguments, the software assumes that
you are communicating with the default target computer.

Review the messages in the Command Window.

If the communication link is functioning, you see a message that looks like this
message:

Target: TargetPCl
Connected
Application

Yes
loader

Not connected — Bad target boot kernel?

If you do not get the preceding message, it is possible that you have a bad target boot
kernel. Recreate the target boot kernel and restart the target computer with the new
kernel. See “Target Computer Boot Methods”.

Not connected — Target settings?

Use Simulink Real-Time Explorer to check the target settings. In particular, if test 1
passes but test 2 fails, check the IP address that you entered in the target settings.

If this procedure does not solve your issue, see the troubleshooting section
“Communication Between Development and Target Computers”. If you still cannot solve
your issue, see “Find Simulink Real-Time Support” on page 25-2.



Test 3: Software Restart Target Computer

Test 3: Software Restart Target Computer

This test is a Simulink Real-Time command that attempts to restart your target
computer. This error is not necessarily fatal because some otherwise functional target
computers do not support software restart.

You must have already configured the target settings with Simulink Real-Time Explorer.
See “PCI Bus Ethernet Setup” or “USB-to-Ethernet Setup”.

Note: Do not modify the files installed with the Simulink Real-Time software. If you
want to modify one of these files for your own purposes, copy the file and modify the copy.

1 In the MATLAB Command Window, type:

slrttest("-noreboot™)

This command reruns the test without using the reboot command, and then
displays the message:

### Test 3, Software reboot the target computer: ... SKIPPED
2 Build Succeeded — Software restart supported?

Review the results of Test 4, Build and download a Simulink Real-

Time application using model slrttestmdl performed without a software
restart. If slrttest builds and loads the real-time application without producing an
error message, it is possible that the target computer does not support the reboot
command. In this case, restart by using a physical reset button.

3 Build Failed — Example model modified?

To determine the cause of failure, in the Diagnostics Viewer and in the Command
Window, review the error messages. You can also open slrttestmdl and build and
download it manually.

If you directly or indirectly modify the slrttestmdl example model supplied with
the product, test 3 is likely to fail. Restore the slrttestmdl example model to its
original state by one of the following methods:

*  Recreate the original model by editing it in the following location:

matlabroot\toolbox\rtw\targets\xpc\xpcdemos
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* Reinstall the software.

If this procedure does not solve your issue, see the troubleshooting section “Target
Computer Boot Process”. If you still cannot solve your issue, see “Find Simulink Real-
Time Support” on page 25-2.
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Test 4: Build and Download slrttestmdl

This test attempts to build and download the model slrttestmdl.

1

To determine the cause of failure, in the Diagnostics Viewer and in the Command
Window, review the error messages. You can also open slrttestmdl and build and
download it manually.

Build Failed — Compiler not supported?

Using slrtgetCC, check that you are using a supported compiler and that you can
compile the blocks in the model with the given compiler and compiler version.

If you did not explicitly specify a compiler by using slrtsetCC, the build procedure
uses the compiler that you specified by using mex -setup. If the MEX compiler is
not a supported Microsoft Visual C++ compiler, the build procedure halts with an
error.

Build Failed — Compiler path?

After installation, all Microsoft Visual C++ compiler components must be in the
Microsoft Visual Studio folder. If you do not install the compiler at the required
location, you can get one of the following errors:

Error executing build command: Error using ==> make_rtw

Error using ==> rtw_c (SetupForVisual)
Invalid DEVSTUDIO path specified

or
Error executing build command: Error using ==> make_rtw

Error using ==> rtw_c
Errors encountered while building model "slrttestmdl™

along with this error:

NMAKE: fatal error U1064: MAKEFILE not found and no target
specified

Stop.

Check your compiler setup:

a Inthe Command Window, type:
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C

sirtsetCC("setup”)

This function queries the development computer for C compilers that Simulink
Real-Time supports. It returns output like the following:
Select your compiler for Simulink Real-Time.
[1] Microsoft Visual C++ Compilers 2010 Professional in
C:\Program Files (x86)\Microsoft Visual Studio 10.0
[2] Microsoft Visual C++ Compilers 2013 Team Explorer
Language Pack in C:\Program Files (x86)\Microsoft Visual Studio 12.0
[0] None

Compiler:

At the Compi ler prompt, enter the number for the compiler that you want to
use. For example, 1.

The function verifies your selection:
Verify your selection:

Compiler: Microsoft Visual C++ Compilers 2010 Professional
Location: C:\Program Files (x86)\Microsoft Visual Studio 10.0

Are these correct [y]/n?

Type y or press Enter.

If this procedure does not solve your issue, see the troubleshooting sections “Model
Compilation”, “Real-Time Application Download”, and “Communication Between
Development and Target Computers”. If you still cannot solve your issue, see “Find
Simulink Real-Time Support” on page 25-2.



Test 5: Check Communication with Target Computer

Test 5: Check Communication with Target Computer

This error occurs only when the target computer settings are out of date.

B W N —

(8]

In the MATLAB Command Window, type slrtexplr.

In the Targets pane, expand the target computer node.

On the toolbar, click the Target Properties button .

Select Host-to-Target communication and make the required changes to the
communication properties.

Select Boot configuration.

Set the required Boot mode.

For information on boot options, see “Target Computer Boot Methods”.
Click Create boot disk

Restart the target computer.

Rerun slrttest.

If these steps do not resolve the issue, recreate the target boot kernel using
SimulinkRealTime.createBootlmage, restart the target computer, and rerun
slrttest.

If this procedure does not solve your issue, see the troubleshooting section
“Communication Between Development and Target Computers”. If you still cannot solve
the issue, see “Find Simulink Real-Time Support” on page 25-2.
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Test 6: Download Prebuilt Real-Time Application

This test runs the basic target object constructor, slrt. This error rarely occurs unless
an earlier test has failed.

1 Check that tests 1-5 completed without producing an error message.

2 Configure, build, and download the tutorial model and record whatever error
messages appear (see “Build and Download Real-Time Application”).

If this procedure does not solve your issue, see the troubleshooting sections “Real-

Time Application Download” and “Communication Between Development and Target
Computers”. If you still cannot solve your issue, see “Find Simulink Real-Time Support”
on page 25-2.
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Test 7: Execute Real-Time Application

This test executes a real-time application (slrttestmdl) on the target computer. If

you change the slrttestmdl model start time to something other than O, such as
0.001, this test fails. This change causes the test, and the MATLAB interface, to halt. To
address this failure:

1  Set the slrttestmdl model start time back to O.

2 Rerun the test.

If this procedure does not solve your issue, see the troubleshooting sections “Real-Time
Application Execution”, “Real-Time Application Performance”, “Real-Time Application

Signals”, and “Real-Time Application Parameters”. If you still cannot solve your issue,
see “Find Simulink Real-Time Support” on page 25-2.
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Test 8: Upload Logged Data and Compare Results

15-12

This test executes a real-time application (slrttestmdl) on the target computer. If you
change the slrttestmdl model (for example, if you remove the Outport block), this test
can fail.

Note: Do not modify the files installed with the Simulink Real-Time software. If you
want to modify one of these files for your own purposes, copy the file and modify the copy.

1 Restore the slrttestmdl example model to its original state by one of the following
methods:

*  Recreate the original model by editing it in the following location:

matlabroot\toolbox\rtw\targets\xpc\xpcdemos
Reinstall the software.

2 If you are running a new Simulink Real-Time release, check that you have updated
the target boot kernel for this release. See “Install Simulink Real-Time Software
Updates” on page 25-3.

If this procedure does not solve your issue, see the troubleshooting sections “Real-Time
Application Execution”, “Real-Time Application Performance”, “Real-Time Application
Signals”, and “Real-Time Application Parameters”. If you still cannot solve your issue,
see “Find Simulink Real-Time Support” on page 25-2.
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Boot Drive Creation Halts

If your development computer MATLAB interface halts while creating a Simulink Real-
Time boot disk or network boot image:

* Use another drive to recreate the Simulink Real-Time boot drive or network boot
image.
* Log in on the development computer as administrator.

* Check that the development computer drive is accessible. If it is not accessible,
replace the drive.
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“Faulty BIOS Settings on Target Computer” on page 17-2
“Hard Drive Not Recognized” on page 17-3

“File System Disabled on Target Computer” on page 17-4
“Adjust the Target Computer Stack Size” on page 17-5
“PCI Board Information” on page 17-6

“Diagnose an I/O Board” on page 17-8



17 Target Computer Configuration

Faulty BIOS Settings on Target Computer

17-2

Note: If you are using a Speedgoat target machine, contact Speedgoat technical support:
www . speedgoat.com/support.

The BIOS settings of a target computer influence how the target computer works. If you
experience problems when using the Simulink Real-Time software, check the system
BIOS settings of the target computer.

Faulty BIOS settings can cause issues.

+  Why is my target not starting?

* Why can SimulinkReal Time.targetgetPCl Info detect PCI boards, but
autosearch -1 cannot?

* Why do my standalone real-time applications run on some target computers, but not
on others?

* Why is my target computer halting when downloading real-time applications?
+ Why is my start time slow?
*  Why is my real-time application not running in real time?

* Why are my USB ports not working?

The Simulink Real-Time product does not control these settings. See “BIOS Settings”.


http://www.speedgoat.com/support

Hard Drive Not Recognized

Hard Drive Not Recognized

Note: If you are using a Speedgoat target machine, contact Speedgoat technical support:
www . speedgoat.com/support.

Simulink Real-Time recognizes only a target computer hard drive formatted as
FAT-12, FAT-16, or FAT-32.

The hard drive must be an Integrated Device Electronics (IDE) or serial ATA (SATA)
drive.

When the target computer BIOS is set to AHCI or RAID mode, Simulink Real-Time
does not recognize a SATA hard drive. Change the BIOS to IDE mode.
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File System Disabled on Target Computer

Note: If you are using a Speedgoat target machine, contact Speedgoat technical support:
www . speedgoat.com/support.

If your target computer does not have a FAT hard disk, the monitor on the target
computer displays this error:

ERROR -4: drive not found
No accessible disk found: file system disabled

If you do not want to access the target computer file system, ignore this message. If
you want to access the target computer file system, add a FAT hard disk to the target
computer. Restart the target computer.

See Also

SimulinkRealTime.utils.getConsolelog
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Adjust the Target Computer Stack Size

To discover and adjust the stack size used by the real-time threads on the target
computer:

1 Add the following blocks to your model:
Current Available Stack Size — Outputs the number of bytes of stack memory
currently available to the real-time application thread.
*  Minimum Available Stack Size — Outputs the number of bytes that have not

been used in the stack since the thread was created.

The block traverses the entire stack at every time step to find and report unused
bytes. Use Minimum Available Stack Size only for diagnostic purposes.

2 Execute the real-time application, monitoring the stack size and minimal stack size.

3 Calculate a stack size that allows execution to proceed.

Target computer memory for the real-time application executable, the kernel, and
other uses is limited to a maximum of 4 GB.

4  Adjust the stack size of the real-time threads by using a TLCOptions setting.

For example, to set the stack size for real-time application xpcosc to 4096 kBytes,
in the MATLAB Command Window, type:

set_param("xpcosc”®, "TLCOptions”, "-axPCModel StackSizeKB=4096")

See Also

Current Available Stack Size | Minimum Available Stack Size | TLCOptions Properties
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PClI Board Information
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Note: If you are using a Speedgoat I/O module, contact Speedgoat technical support:
www . speedgoat.com/support.

If you want to determine what PCI boards are installed in your Simulink Real-Time
system, in the MATLAB Command Window, type:

tg = sirt;
getPClInfo(tg, "all™)

List of installed PCl devices:

Intel Unknown
Bus 0, Slot O, IRQ O
Host Bridge
VendorlID 0x8086, DevicelD 0x1130,
SubVendorID 0x8086, SubDevicelD 0x4532

Measurement Computing PCI-DI1024
Bus 1, Slot 11, IRQ 10
DI DO
VendorlID 0x1307, DevicelD 0x0028,
SubVendorID 0x1307, SubDevicelD 0x0028
A/D Chan: 0, D/A Chan: 0, DIO Chan: 24
Released iIn: R14SP2 or Earlier

If you want to use multiple boards of a particular type in your system, check that the
I/O driver supports multiple boards. In the documentation for this board type, see the
“Multiple board support” entry.

If the board type supports multiple boards, and you installed these boards in the
Simulink Real-Time system, select a particular board:

1 In the PCI devices display, record the contents of the Bus and S1ot columns of the
PCI device in which you are interested.


http://www.speedgoat.com/support

PCI Board Information

2 Enter the bus and slot numbers as vectors into the PCI Slot parameter of the PCI
device. For example:

[1 9]

1 is the bus number and 9 is the slot number.

See Also
SimulinkRealTime.target.getPClInfo

More About
. “PCI Bus I/0 Devices”
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Diagnose an 1/O Board
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Note: If you are using a Speedgoat I/O module, contact Speedgoat technical support:
www . speedgoat.com/support.

1 Display the input/output behavior of the board by using an external instrument,
such as an oscilloscope or logic analyzer.

2 Check that you have configured the I/0 board driver according to the manufacturer
data sheet.

3 Check that you are using the latest version of the I/O board driver and of the
Simulink Real-Time software. See “Install Simulink Real-Time Software Updates”
on page 25-3.

4 When you run the real-time application on a different target computer, check that
the behavior persists.

5 When you install another instance of the I/O board in the target computer, check
that the behavior persists.

6 From the manufacturer website, download the manufacturer I/O driver and
diagnostic software. Install the driver and software on your computer. Use the
manufacturer software to test the I/O board with the manufacturer driver.

7 Report the issue to MathWorks Support at www . mathworks . com/support/
contact_us.


http://www.speedgoat.com/support
https://www.mathworks.com/support/contact_us/index.html
https://www.mathworks.com/support/contact_us/index.html
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Link Between Development and Target Computers

Failed Communication Between Development and Target
Computers

18-2

To test the communication link between the development and target computers, use
these MATLAB commands from the development computer

sirtpingtarget — The slrtpingtarget command performs a basic
communication check between the development and target computers. This command
returns success only if the Simulink Real-Time kernel is loaded and running and
the development and target computers are linked. Use this command for a quick
check of the communication between the development and target computers.

sirttest — The slrttest command performs a series of tests on your Simulink
Real-Time system. These tests range from performing a basic link check to building
and running real-time applications. At the end of each test, the command returns

an OK or failure message. If the test is inappropriate for your setup, the command
returns a SKIPPED message. Use this command for a thorough check of your Simulink
Real-Time installation.

Link errors can also occur in the following instances:

The target computer is running an old Simulink Real-Time boot kernel that is not
synchronized with the Simulink Real-Time release installed on the development
computer. Recreate the target boot kernel for each new release.

If you have an active firewall in your system, you can experience communication
errors. To work around this issue, add the MATLAB interface to the firewall exception
list.

If multiple Ethernet cards or chips are installed in the target computer, see “Timeout
with Multiple Ethernet Cards” on page 18-5.



Communications Timeout

Communications Timeout

If the communication link between the development and target computers is broken or
misconfigured, the link times out after about 5 seconds. Before continuing, check that you
have followed the instructions outlined in “System Configuration”.

Diagnose Communication Settings

B WD —

(6]

9

In the MATLAB Command Window, type slrtexplr.

In the Targets pane, expand the target computer node.

On the toolbar, click the Target Properties button .

Select Host-to-Target communication and make the required changes to the
communication properties.

Select Boot configuration and click Create boot disk.

Restart the target computer and try downloading the real-time application again.
Sometimes, the download is complete even though you get a timeout error. To detect
this condition, wait until the target display shows:

System:initializing application finished.

In the MATLAB Command Window, type slrtpingtarget.

If slrtpingtarget finds a working connection between the development and target
computers, the response is something like:

ans =

success

Right-click the target computer and select Connect.

If the connection resumes, the connection is working. If the connection times out
consistently for a particular model, increase the amount of time allowed before time out.

Increase Communication Timeout

By default, the development computer times out after about 5 seconds if the target
computer does not respond after you establish a connection. You can increase the timeout
value in one of the following ways:
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+ At the model level, open the Simulink > Model Configuration Parameters dialog
box and navigate to the Simulink Real-Time Options node. Clear the Use default
communication timeout parameter and enter a new desired timeout value in the
Specify the communication timeout in seconds parameter. For example, to
increase the value to 20 s, enter 20, and then build and download the model.

+ At the real-time application level, set the CommunicationTimeOut property to the
timeout value that you want. For example, to increase the value to 20 seconds:

tg = slirt;
tg.CommunicationTimeOut = 20

For both methods, the development computer polls the target computer about once every
second, and if a response is returned, returns the success value. The development
computer waits the full 20 seconds only if a download actually fails.
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Timeout with Multiple Ethernet Cards

The Simulink Real-Time product supports multiple Ethernet cards and chips. If your
target computer has more than one of these cards or chips installed, it is possible to
experience timeout problems. For example, suppose that you are using the network boot
option to start target computer A. When the development computer starts the target
computer, it associates the target computer IP address with the Media Access Control
(MAC) address of Ethernet adapter A. Then, suppose that the target computer BIOS
connects the target computer to Ethernet adapter B. In this case, the Simulink Real-
Time software cannot connect the development and target computers because they are
connected to different Ethernet controllers.

Try to disable or remove the Ethernet controller that you do not intend to use. For
example, if you have an on-board Ethernet controller and a separate Ethernet card,
disable the on-board Ethernet controller through the target computer BIOS. If you must
have multiple Ethernet adapters of the same type, use one of the following procedures to
determine which Ethernet adapter the software found.

Network Boot

If you are using the network boot option to start the target computer, do the following:

Connect the network cable to Ethernet adapter B.
2 Inthe Command Window, type:

larp -d

This command removes the association between the target computer address and the
network address of Ethernet adapter A from the cache of the development computer.
You can now make a new connection (and association).

3 Change the Ethernet adapter card that the network boot option uses in one of the
following ways:
Change the target computer BIOS to change the Ethernet adapter to the adapter
that the network boot option is searching for.

Follow the procedure in “Ethernet Card Selection by Index” on page 4-13.
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Non-Network Boot

If you are not using the network boot option to start the target computer, do the
following:

1 Switch the network cable to the other Ethernet port and restart the target computer.
Try to communicate with the target computer from the development computer.

2 If you can communicate using this Ethernet port, use this port to connect the
development computer to the target computer.

18-6
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Target Computer Does Not Boot

19-2

Note: If you are using a Speedgoat target machine, contact Speedgoat technical support:
www . speedgoat.com/support.

If you cannot start your target computer with the Simulink Real-Time boot media or
network boot image:

Recreate the target boot kernel by using new media.

2 Call SimulinkRealTime.getTargetSettings. Check that the Simulink Real-
Time kernel properties correspond with the target settings displayed in the Simulink
Real-Time Explorer.

To display the current values of Simulink Real-Time target settings for the
default target computer, type Simul inkReal Time.getTargetSettings without
arguments. To display their allowed values, type:

tgs = SimulinkRealTime.getTargetSettings;
tgs.set

3 If the target computer does not start and shows only a blank screen, to display
messages that the kernel prints during startup, type:

tgs = SimulinkRealTime.getTargetSettings;
tgs.TargetScope = "Disabled”

Restart the target computer and check the console log for error messages. To read
the target computer console log, type:

console_log = SimulinkRealTime.utils.getConsolelLog;

When you have corrected the errors, set tgs.TargetScope = "Enabled®, and
then restart the target computer.

4 By default, tgs.LegacyMultiCoreConfig = "on".If
tgs.LegacyMultiCoreConfigis "off", the Simulink Real-Time kernel
cannot discover system resources that are not compliant with the Advanced
Configuration and Power Interface (ACPI) standard. To allow the kernel to
discover such devices by using the legacy MPFPS in the target computer BIOS, set
tgs.LegacyMultiCoreConfig = "on", and then restart the target computer.


http://www.speedgoat.com/support

Target Computer Does Not Boot

5 If you are doing a network boot and the procedure displays a message similar to
TFTP Timeout:

a Check that the xpctftpserver program is running. If it is not, recreate the
network boot image.

b Temporarily disable the internet security (firewall) software on the development
computer. Test if you can start the target computer. If you can, ask your IT
manager to configure the internet security software to allow the start procedure
to work in its presence.

If this procedure does not solve your issue, see “Target Medium Is Not Bootable” on page
19-4. If you still cannot solve your issue, see “Find Simulink Real-Time Support” on
page 25-2.

See Also

SimulinkRealTime.getTargetSettings |
SimulinkRealTime.utils.getConsolelLog | Target Settings Properties
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Target Medium Is Not Bootable

Note: If you are using a Speedgoat target machine, contact Speedgoat technical support:
www . speedgoat.com/support.

When starting the target computer, you can get a message similar to the following:

Not a bootable medium or NTLDR is missing

1  Configure your boot media by using the procedure in “Create a Bootable Partition”.

2 Recreate the target boot kernel with the new media. Restart the target computer
using the new kernel.

See Also

SimulinkRealTime.utils._getConsolelog
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Target Computer Halts

Target Computer Halts

If your target computer displays a System Halted message while starting:
1 In your target computer, install an Ethernet card compatible with Simulink Real-
Time.

2 Inthe Host-to-Target communication pane of Simulink Real-Time Explorer,
check that you configured the Target driver parameter to match the hardware
installed in your target computer.

See Also

SimulinkRealTime.utils._getConsolelog
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Target Computer Spontaneously Restarts

If your target computer spontaneously restarts, check that your target computer is an
Intel Core™ computer, or a model that supports the SSE2 instruction set. If your target
computer does not support the SSE2 instruction set, acquire a target computer that
meets that requirement.
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Microsoft Visual Studio 2015 C/C++ Compiler Not Installed

20-2

By default, the Microsoft Visual Studio 2015 installer does not install the C++ compiler
that Simulink Real-Time requires. To install the C++ compiler, perform a custom install
and select the C++ compiler. If you already installed Microsoft Visual Studio with the
default configuration, rerun the installer and choose the modify option.



Compiler Errors from Models Linked to DLLs

Compiler Errors from Models Linked to DLLs

When building real-time applications, the Simulink Real-Time software supports links to
static link libraries (.1ib) only, not links to dynamic link libraries (.dll), such as Windows
libraries. When you build your models, check that you link only to static link libraries.
When you compile with Simulink Real-Time S-functions, linking to static libraries is not
an issue.
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Polling Mode Not Supported on Single-Core Target Computers

You see the following message on the target computer screen when you download a real-
time application that is configured to run in polling mode:

Single-core kernel configuration found. To run a model in polling mode,
use a multicore target computer and set "Multicore CPU" in Simulink
Real-Time Explorer.

You are attempting to enable polling mode when your system does not meet all of the
requirements for polling mode. See “Execution Modes” on page 6-2.

See Also

SimulinkRealTime.utils._getConsolelog
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Error from Crash Info Function

Some target computers contain hardware that can retain information in memory from
before a software restart. If these computers also contain a hard drive, they can save
crash data after a fatal error.

Cavution: After a fatal error, do not restart the computer manually by using the boot or
power switch. A manual restart prevents the computer from saving the crash data.

Twenty seconds after a fatal error, the target computer restarts itself and saves the crash
data on the target computer hard drive. When the computer is running again, you can
call the Simul inkRealTime.crashlInfo function from the development computer to
retrieve the crash data.

When you call this function, you can see the error:

Error: -9:file not found

on the target computer screen and the error:

Could not open target file c:\SLRTCRB.bin

in the Command Window. If you see one of these messages, look for the following causes:

* You restarted the target computer manually by using the boot or power switch
instead of waiting for it to restart itself.

* The target computer restarted with a different kernel from the one that it was
running when it experienced the fatal error. For example, suppose that you install
DOS Loader on the target computer. If you start the computer with a USB drive
that you remove afterward, and the computer has a fatal error, the restart uses DOS
Loader.

* The target computer does not retain information in memory from before a software
restart. If the target restarts itself after a fatal error but does not print a message
referring to SimulinkRealTime.crashlinfo, it does not retain information in
memory.

* The target computer does not have a functioning hard drive.

+ The target computer wrote data into a crash file, but the file was unreadable.
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See Also

Crash Info | SimulinkRealTime.utils.getConsolelog
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Sample Time Deviates from Expected Value

22-4

Sometimes the sample time that you measure from your model is not equal to the sample
time that you requested. This difference depends on your target computer. Your model
sample time is as close to your requested time as the target computer CPU allows.

Digital processing does not allow infinite precision in setting the spacing between the
timer interrupts. This limitation can cause the divergent sample times.

For the supported target computers, the only timer that can generate interrupts is based
on a 1.193-MHz clock. For the Simulink Real-Time system, the timer is set to a fixed
number of ticks of this frequency between interrupts. If you request a sample time of
1/10000 seconds, or 100 microseconds, you do not get exactly 100 ticks. Instead, the
Simulink Real-Time software calculates that number as:

100 x 10°® s X 1.193 x 10° ticks/s = 119.3 ticks

The Simulink Real-Time software rounds this number to the nearest whole number, 119
ticks. The actual sample time is then:

119 ticks/(1.193 X 10° ticks/s) = 99.75 X 10° s
(99.75 microseconds)

Compared to the requested original sample time of 100 microseconds, this value is 0.25%
faster.

As an example of how you can use this value to derive the expected deviation for your
target computer, assume the following:

*  Output board that generates a 50 Hz sine wave (expected signal)

*  Sample time of 1/10000

* Measured signal of 50.145 Hz

The difference between the expected and measured signals is 0.145 Hz, which deviates

from the expected signal value by 0.29% (0.145 / 50). Compared to the previously
calculated value of 0.25%, there 1s a difference of 0.04% from the expected value.

If you want to refine the measured deviation for your target computer, assume the
following:

*  Output board that generates a 50 Hz sine wave (expected signal)



Sample Time Deviates from Expected Value

+  Sample time of 1/10200
*  Measured signal of 50.002 Hz:

1/10200 s X 1.193 x 10° ticks/s = 116.96 ticks

Round this number to the nearest whole number of 117 ticks. The resulting frequency is
then:

(116.96 ticks/117)(50) = 49.983 Hz

The difference between the expected and measured signal is 0.019, which deviates from
the expected signal value by 0.038% (0.019 / 50.002). When the sample time is
1/10000, the deviation is 0.04%.

Some amount of error is common for most computers. The margin of error varies from
machine to machine.

Most high-level operating systems, like Microsoft Windows or Linux®, occasionally
insert extra long intervals to compensate for errors in the timer. The Simulink Real-
Time software does not attempt to compensate for timer errors. For this product, close
repeatability is more important for most models than exact timing. However, sometimes
chips have inherent designs that produce residual jitters that can potentially change
your system behavior. For example, some Intel Pentium chips produce residual jitters on
the order of 0.5 microseconds from interrupt to interrupt.
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Cannot Change Sample Time at Run Time

Some blocks produce incorrect results when you change their sample time at run time. If
you include such blocks in your model, the software displays a warning message during
model build. To avoid incorrect results, change the sample time in the original model,
and then rebuild and download the model.

22-6



Change of Stop Time

Change of Stop Time

If you change the step size of a real-time application at run time, the real-time
application sometimes executes for fewer steps than you expect. The number of execution
steps is:

floor(stop time/step size)

When you compile code for a model, Simulink Coder calculates the number of steps based
on the current step size and stop time. If the stop time is not an integral multiple of the
step size, Simulink Coder adjusts the stop time to an integral multiple. If you change

the step size without rebuilding the model, Simulink Real-Time uses the new step size
and the previously adjusted stop time. The resulting model sometimes executes for fewer
steps than you expect.

Suppose that a model has a stop time of 2.4 and a step size of 1. At compilation time,
Simulink Coder adjusts the stop time of the model to 2. If you change the step size to 0.6
at run time but do not recompile the application, the expected number of steps is 4. The
actual number of steps is 3 because Simulink Real-Time uses the previously adjusted
stop time of 2.

To avoid this issue, check that the original stop time (as specified in the model) is an
integral multiple of the original step size.

22-7






Real-Time Application Signals

+  “Fix Invalid File IDs” on page 23-2
+ “Cannot View Mux Output” on page 23-3



23 Redl-Time Application Signals

Fix Invalid File IDs

23-2

If you are acquiring signal data with a file scope, you can get Error -10: Invalid
File ID on the target computer. This error occurs because the size of the signal data
file exceeds the available space on the disk. The signal data is most likely corrupt and
irretrievable. Delete the signal data file and restart the Simulink Real-Time system.

To prevent this occurrence, monitor the size of the signal data file as the scope acquires
data.

For additional information, refer to the MathWorks Support website:

www .mathworks.com/support/search_results._html?g=product:"Simulink
+Real-Time".

See Also

Gain

External Websites

. www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-
Time"


https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"

Cannot View Mux Output

Cannot View Mux Output

When you connect a real-time Scope block to the output of a Mux block, sometimes you
cannot view the output from the Mux block. This issue occurs because the Mux block
produces a virtual signal, which the code optimizer removes when it generates the real-
time executable.

To address this issue, insert a Gain block with the Gain parameter set to 1.0 at the
input to the Scope block.

See Also

Gain

More About
. “Virtual Signals” (Simulink)
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Improve Run-Time Performance

24-2

You can improve run-time performance and reduce the task execution time (TET) of a
model by using the following procedures.

Run Performance Tools

Use the following performance tools:

*  Run Performance Advisor from the Simulink Analysis > Performance Tools menu
and follow its guidance. See “Improve Performance of Multirate Model” on page 9-2.

+ Configure a real-time application for profiling, run it, and call profile_slrt to
retrieve the results. Evaluate the results for potential improvements in the task and
core distribution of the model. See “Execution Profiling for Real-Time Applications” on
page 9-20.

Use Multicore Target Computer

If you are using a single-core target computer, improve performance by configuring your
model to run on a multicore target computer:

1 Acquire a multicore target machine (see www.speedgoat.com/products/real-
timetargetmachines).

2 Partition the model into subsystems according to the physical requirements of the
system that you are modeling. Set the block sample rates within each subsystem to
the slowest rate that meets the physical requirements of the system.

3 In the Configuration Parameters dialog box, on the Solver pane, select the check box
for Treat each discrete rate as a separate task.

4 Select the Allow tasks to execute concurrently on target check box.

5 Click Configure Tasks, and then select the Enable explicit model partitioning
for concurrent behavior check box.

6 Create tasks and triggers, and then explicitly assign subsystem partitions to the
tasks (see “Partition Your Model Using Explicit Partitioning” (Simulink)).

7 In Simulink Real-Time Explorer, on the Target settings pane, check that you
selected the Multicore CPU check box.

8 Run the real-time application on the multicore target machine.


http://www.speedgoat.com/products/real-timetargetmachines
http://www.speedgoat.com/products/real-timetargetmachines

Improve Run-Time Performance

Minimize Model

1 If the model contains many states (for example, more than 20 states), clear the
States check box in the Configuration Parameters dialog box, on the Data Import/
Export pane. You have now disabled state logging, making more memory available
for the real-time application.

2 On the Data Import/Export pane, clear the Time, States, Output, Final states,
and Signal logging parameters. You have now turned off data logging, making
more CPU cycles available for calculating the model.

3 On the Simulink Real-Time Options pane, clear the Log Task Execution Time
check box. You have now disabled TET logging for the real-time application.

4 On the Solver pane, increase Fixed-step size (fundamental sample time).
Executing with a short sample time can overload the CPU.

5 Use polling mode (see “Polling Mode” on page 6-3).

6 In Simulink Real-Time Explorer, on the Target settings pane, clear the Graphics
mode check box to disable the target scope display.

7 Remove scopes from the model.
8 Eliminate or minimize target computer disk I/O in your model.

9 Reduce the number of I/O channels in the model.

Distribute Execution

Consider distributing subsystem execution across multiple target computers. This
optimization can require multitarget synchronization by using PTP, CAN, UDP, parallel
port, or reflective memory.

Contact Technical Support

For additional guidance, refer to the following sources:
* MathWorks Tech Support: www.mathworks.com/support/
search_results_html?g=product:"'Simul ink+Real-Time"

+ MATLAB Answers: wvw.mathworks.com/matlabcentral/answers/?
term=Simulink+Real-Time

+ MATLAB Central: www.mathworks.com/matlabcentral
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For Speedgoat hardware issues, contact Speedgoat Tech Support: www. speedgoat.com/
support.

If these sources do not solve your issue, contact MathWorks Technical Support. See “Find
Simulink Real-Time Support” on page 25-2.

More About

. “Improve Performance of Multirate Model” on page 9-2

. “Execution Profiling for Real-Time Applications” on page 9-20
. “Partition Your Model Using Explicit Partitioning” (Simulink)
. “Polling Mode” on page 6-3

. “Find Simulink Real-Time Support” on page 25-2

. “Multicore Programming with Simulink” (Simulink)

External Websites

. www.speedgoat.com/products/real-timetargetmachines
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Real-Time Application Execution Produces CPU Overloads

Real-Time Application Execution Produces CPU Overloads

A CPU overload indicates that the CPU is unable to complete processing a model time
step before restarting for the next time step. When this error occurs, the target object
property CPUover load changes from none to detected. One of the following can
happen:

The Simulink Real-Time kernel halts model execution.

If you allow the overload, model execution continues until a predefined event occurs
(see “Allow CPU Overloads” on page 24-7). If the model continues to run after a

CPU overload, the time step lasts as long as the time required to finish the execution.
This behavior delays the next time step.

For more information and test models, see wvw.mathworks.com/matlabcentral/
fileexchange/23507.

Your real-time application can experience real and spurious CPU overloads.

Real CPU Overloads

Model design or target computer resources cause real CPU overloads. Possible reasons
are:

The target computer is too slow or the model sample time is too small (see “Limits on
Sample Time” on page 9-14).

The model is too complex (algorithmic complexity).
The model does disk I/O on the target computer hard drive.
I/0 latency, where each I/0 channel used introduces latency into the system. I/O

latency can cause the execution time to exceed the model time step.

To find latency values for a board supported by the Simulink Real-Time block library,
consult the vendor data sheet. To find a link to the vendor website, see:

www . mathworks.com/products/simul ink-real-time/supported/hardware-
drivers._html.

To find latency values for Speedgoat boards, contact Speedgoat technical support.

24-5


https://www.mathworks.com/matlabcentral/fileexchange/23507
https://www.mathworks.com/matlabcentral/fileexchange/23507
https://www.mathworks.com/products/simulink-real-time/supported/hardware-drivers.html
https://www.mathworks.com/products/simulink-real-time/supported/hardware-drivers.html

24  Redal-Time Application Performance

24-6

For example, your real-time application includes the National Instruments® PCI-6713
board, which the Simulink Real-Time block library supports. Assuming that you want

to use four outputs:

1 From the vendor data sheet, the D/A latency is 1 + 2.4 X N.
2 To get the latency for four outputs, calculate the latency:

1+ (2.4 x 4) = 10.6 microseconds

3 Include this value in your sample time calculations.

Spurious CPU Overloads

Properties in the BIOS commonly cause spurious CPU overloads. Such properties
include:

*  Advanced Power Management
*  Plug-and-Play (PnP) operating system
+  System Management Interrupts (SMIs)

Enabling these properties can cause non-real-time behavior from the target computer.
To run the application as a real-time application, disable these BIOS properties for the
target computer. See “BIOS Settings”.

For some BIOS configurations, you cannot disable SMIs. However, for some chip sets,
you can programmatically prevent or disable SMIs. For a solution to disabling SMIs in
the Intel ICH5 family, see www . mathworks .com/matlabcentral/fileexchange/
loadFile.do?object1d=18832&objectType=File"".


https://www.mathworks.com/matlabcentral/fileexchange/loadFile.do?objectId=18832&objectType=file
https://www.mathworks.com/matlabcentral/fileexchange/loadFile.do?objectId=18832&objectType=file

Allow CPU Overloads

Allow CPU Overloads

The Simulink Real-Time kernel usually halts model execution when it encounters a CPU
overload. You can configure the Simulink Real-Time model to allow CPU overloads. Use
this capability to support long initializations and for overload diagnosis.

Long Initializations

For some real-time applications, normal initialization can extend beyond the first sample
time. For such an application, use the TLCOptions property xPCStartupFlag with the
smallest effective value, up to approximately 5.

Overload Diagnosis

During execution, hardware-specific factors can cause the real-time application to process
data beyond the sample time. Use the TLCOptions properties XPCMaxOver loads and
XPCMaxOverloadLen to diagnose and address this issue.

Note: Allowing the target computer CPU to overload can cause incorrect results,
especially for multirate models. Use these options only for diagnosis. When your
diagnosis is complete, turn off these options.

See Also

SimulinkRealTime.utils._getConsolelog

More About
. “CPU Overload Options” on page 9-15
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Task Execution Time Definition

Task execution time (TET) measures how long it takes the kernel to run for one base-rate
time step. For a multirate model, use the profiler to find out what the execution time is
for each rate.
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Failure to Read Profiling Data

Failure to Read Profiling Data

Calling profile_slIrt produces an error. The error can state that the file does not exist
in the expected location, or that attempting to read the file causes an error.

To address this issue, try the following procedure:

Check that you have set the profiling options in Code Generation > Verification.
Build, download, and run the real-time application.

Create a profilelnfo structure with the required mode I name value.

B W N —

Call profile_slrt with the profilelnfo structure as argument.

Related Examples
. “Execution Profiling for Real-Time Applications” on page 9-20
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Find Simulink Real-Time Support
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For support with Speedgoat target machines or I/O modules, contact Speedgoat support:

www . speedgoat.com/support.

For support on general MATLAB or Simulink issues, see MathWorks Support:

www . mathworks.com/support.

For support on Simulink Real-Time issues, see:

Simulink Real-Time Support:

www . mathworks.com/support/search_results_html?g=product:"Simul ink
+Real-Time"

Simulink Real-Time Answers:
www . mathworks.com/matlabcentral/answers/?term=Simul ink+Real-Time

www .mathworks.com/matlabcentral/answers/?term=xPC+Target

Simulink Real-Time Central File Exchange:

www .mathworks.com/matlabcentral/fileexchange/?term=Simul ink+Real -
Time

www .mathworks.com/matlabcentral/fileexchange/?term=xPC+Target

After searching these resources, if you still cannot solve your issue:

1

Call function Simul inkReal Time.getSupportinfo to retrieve diagnostic
information for your Simulink Real-Time configuration.

SimulinkRealTime.getSupportlnfo can record information that is sensitive to
your organization. Review this information before disclosing it to MathWorks.

For online or phone support, contact the Simulink Real-Time Technical Team
directly:

www . mathworks.com/products/simul ink-real-time/expert-
contact.html.


http://www.speedgoat.com/support
https://www.mathworks.com/support
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
https://www.mathworks.com/matlabcentral/answers/?term=Simulink+Real-Time
https://www.mathworks.com/matlabcentral/answers/?term=xPC+Target
https://www.mathworks.com/matlabcentral/fileexchange/?term=Simulink+Real-Time
https://www.mathworks.com/matlabcentral/fileexchange/?term=Simulink+Real-Time
https://www.mathworks.com/matlabcentral/fileexchange/?term=xPC+Target
https://www.mathworks.com/products/simulink-real-time/expert-contact.html
https://www.mathworks.com/products/simulink-real-time/expert-contact.html

Install Simulink Real-Time Software Updates

Install Simulink Real-Time Software Updates

The general procedure for updating Simulink Real-Time is:

1

3

Navigate to the MathWorks download page:

www . mathworks.com/downloads.

Navigate to the page for the Simulink Real-Time software version that you want.
Download it to your development computer.

Install and integrate the new release software.

After updating Simulink Real-Time, to recreate your Simulink Real-Time target settings:
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In the MATLAB Command Window, type slrtexplr.

On the Targets pane, expand the target computer node.

On the toolbar, click the Target Properties button .

Select Host-to-Target communication and select the required communication
method between your development and target computers (“PCI Bus Ethernet Setup”
or “USB-to-Ethernet Setup”).

Select Boot configuration and click Create boot disk.
Restart the target computer.

For each model that you want to execute, in Simulink Editor, from the Code menu,
click C/C++ Code > Build Model.
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